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Questa sezione illustra un esempio di configurazione di un sistema videocamera.

Panoramica

Configurazione del sistema

ECM-MS2
Microfono

SELP28135G
SEL1635Z
SELP18200
Obiettivo

UWP-D11, 
UWP-D12
Pacchetto 
microfono 
wireless

HVL-LBPC
Luce video

PXW-FS7

RMT-845
Telecomando ad 
infrarossi (fornito)

LA-EA3, 
LA-EA4
Adattatore 
per innesto 
A-mount

IFU-WLM3
Modulo LAN wireless USB 
(fornito)

VCT-FS7
Adattatore da spalla

Serie S/N/H/G
Scheda di memoria XQD

MRW-E80
Lettore schede XQD

HXR-IFR5
Unità di 
interfaccia

BC-U1, BC-U2
Caricabatterie
(BC-U1 fornito)

BP-U30, BP-U60, 
BP-U60T, BP-U90
Pacco batteria 
(BP-U30 fornito)

Adattatore CA (in 
dotazione)1)

XDCA-FS7
Unità di 
estensione

BP-L80S, BP-FL75
Pacco batteria

Adattatore wireless
CBK-WA100

AXS-R5
Registratore 
portatile con 
scheda di 
memoria

1) MPA-AC1 (solo modello USA e Canada)
AC-NB12A (eccetto modello USA e Canada)

Telecomando impugnatura 
(fornito)

SMAD-P3
Adattatore a 
slitta Multi-
interface

XLR-K2M
Kit adattatore 
XLR



Per informazioni dettagliate sull’utilizzo e la funzione di ogni parte, fare riferimento alla pagina indicata.

1. Maniglia (pagina 8)

2. Connettore mirino (pagina 21)

3. Connettore REMOTE (pagina 24)

4. Selettore INPUT1 (LINE/MIC/MIC+48V) 
(pagina 43)

5. Selettore INPUT2 (LINE/MIC/MIC+48V) 
(pagina 43)

6. Attacco impugnatura (pagina 24)

7. Connettore modulo LAN wireless USB

8. Indicatore registrazione (pagina 95)
Lampeggia quando la capacità rimanente del 
supporto di registrazione o della batteria è bassa.

9. Gancio per metro a nastro
Il gancio del metro a nastro si trova sullo stesso 
piano del sensore immagine. Per misurare con 
precisione la distanza tra il camcorder e il 
soggetto, utilizzare questo gancio come punto di 
riferimento. Fissare l’estremità di un metro a 
nastro a questo gancio per misurare la distanza 
del soggetto.

10. Pulsante WB SET (impostazione 
bilanciamento del bianco) (pagina 43)

11. Perno di blocco obiettivo (pagina 23)

12. Pulsante di sblocco obiettivo (pagina 23)

13. Slitta accessori

14. Pulsante START/STOP registrazione 
della maniglia
Il pulsante di registrazione non può essere 
azionato quando la levetta di blocco si trova in 
posizione di blocco.

15. Levetta dello zoom sulla maniglia 
(pagina 66)

16. Slitta Multi-interface

Per informazioni dettagliate sulla gamma di 
accessori utilizzabili con la slitta Multi-
interface, rivolgersi al proprio rappresentante di 
vendita.

Posizione e funzione delle parti

WB
 SE
T
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Montaggio della slitta accessori
1 Sollevare il bordo anteriore della molla della slitta e 

tirare la molla nella direzione opposta a quella indicata 
dalla freccia incisa sulla slitta stessa.

2 Posizionare la slitta accessori sulla sua sede di 
montaggio, allineando le sporgenze della slitta con il 
punti corrispondenti della sede di montaggio, quindi 
serrare le quattro viti.

3 Inserire la molla della slitta nella direzione della 
freccia in modo che la porzione a forma di U si 
inserisca in fondo alla slitta.

Rimozione della slitta accessori
Rimuovere la molla della slitta come descritto al 
passo 1 del paragrafo “Montaggio della slitta 
accessori”, svitare le quattro viti e rimuovere la 
slitta acessori.

Montaggio della piastra di protezione del 
modulo LAN wireless USB
1 Rimuovere la vite di montaggio della maniglia.
2 Montare la piastra di protezione, quindi stringere la 

vite.
 

Rimozione della maniglia
Per rimuovere la maniglia dal camcorder, svitare 
le sue quattro viti di fissaggio.

Montaggio del coperchietto di protezione del 
connettore della maniglia (in dotazione)
Quando si usa il camcorder senza la maniglia, 
proteggere il connettore con il coperchietto di 
protezione in dotazione.

Protezione dei terminali del connettore
Montare il coperchietto sui connettori non 
utilizzati per proteggere i terminali del 
connettore.

Molla della slitta

Slitta accessori

Molla della slitta

Slitta accessori

1 2
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1. Pulsante START/STOP

2. Manopola ND FILTER (pagina 42)

3. Pulsanti programmabili ASSIGN. da 1 a 3 
(pagina 45)

4. Pulsante PUSH AUTO IRIS (pagina 41)

5. Pulsante PUSH AUTO FOCUS 
(pagina 39)

6. Selettore FOCUS (pagina 39)

7. Pulsante DISPLAY (pagina 13)

8. Pulsante FULL AUTO (pagina 37)

9. Interruttore POWER (pagina 18)

10. Manopola IRIS (pagina 45)

11. Pulsante STATUS CHECK (pagina 15)

12. Selettore HOLD (pagina 95)

13. Selettore CH1 LEVEL CONTROL 
(pagina 43)

14. Manopola CH1 INPUT LEVEL 
(pagina 43)

15. Selettore CH2 LEVEL CONTROL 
(pagina 43)

16. Manopola CH2 INPUT LEVEL 
(pagina 43)

17. Pulsante SLOT SELECT (selezione della 
scheda di memoria XQD) (pagina 29)

18. Pulsante CANCEL/BACK (pagina 56)

19. Pulsante MENU (pagina 58)

20. Pulsante THUMBNAIL (pagina 55)

21. Pulsante destro
Consente di impostare valori numerici e 
spostare il cursore a destra nelle schermate delle 
miniature e nei menu. 

22. Manopola SEL/SET (seleziona/imposta)
Ruotare la manopola per spostare il cursore 
verso l’alto o il basso e selezionare voci di menu 
o impostazioni. Premere per applicare la voce 
selezionata.

23. Pulsante sinistro
Consente di impostare valori numerici e 
spostare il cursore a sinistra nelle schermate 
delle miniature e nei menu.

24. Pulsante SHUTTER (pagina 42)

25. Selettore WHT BAL (selezione memoria 
bilanciamento del bianco) (pagina 42)

26. Pulsante WHT BAL (bilanciamento del 
bianco) (pagina 42)

27. Selettore GAIN (selezione guadagno) 
(pagina 41)

28. Pulsante ISO/Gain (pagina 41)
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1. Connettore cuffie (pagina 40)

2. Slot scheda XQD A (pagina 29)

3. Slot scheda UTILITY SD (pagina 30)

4. Indicatore di accesso XQD (A) (pagina 29)

5. Indicatore di accesso scheda SD 
(pagina 30)

6. Indicatore di accesso XQD (B (pagina 29)

7. Connettore USB
Consente il collegamento a un computer 
mediante un cavo USB per accedere ai supporti 
di registrazione inseriti in uno slot per schede 
XQD del camcorder.

8. Slot scheda XQD B (pagina 29)

9. Altoparlante incorporato (pagina 40)

10. Pulsante rilascio coperchio schede 
(pagina 29)

11. Connettore unità di estensione (pagina 31)

12. Indicatore registrazione posteriore 
(pagina 37)

13. Connettore DC IN (pagina 19)

14. Pulsante BATT RELEASE (rilascio 
batteria) (pagina 18)

15. Batteria (pagina 18)

16. Attacco pacco batteria (pagina 18)

17. Sensore ricevitore telecomando 
infrarossi(pagina 34)

18. Microfono interno (pagina 43)
Microfono di narrazione per la registrazione 
dell’audio ambientale.

19. Connettore INPUT1 (ingresso audio 1) 
(pagina 43)

20. Connettore INPUT2 (ingresso audio 2) 
(pagina 43)

21. Connettore SDI OUT 1 (pagina 99)

22. Connettore SDI OUT 2 (pagina 99)

23. Connettore HDMI OUT (pagina 99)

Lato inferiore
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1. Attacco filettato di montaggio del 
treppiede (1/4 pollici, 3/8 pollici)
Compatibile con viti 1/4-20UNC e 3/8-16UNC.
Consente il montaggio di un treppiede 
(opzionale, vite di lunghezza max. 5,5 mm).

Per informazioni dettagliate sul montaggio di 
mirino (in dotazione) e oculare, vedere 
pagina 21.

1. Manopola CONTRAST

2. Pulsante PEAKING

3. Pulsante ZEBRA

4. Selettore MIRROR

5. Ganci di montaggio oculare

Per informazioni dettagliate sul montaggio 
dell’oculare (in dotazione), vedere pagina 22.

1. Manopola di regolazione diottrica

2. Coppa dell’oculare

Per informazioni dettagliate, fare riferimento al 
manuale operativo dell’obiettivo.

Per informazioni dettagliate sul montaggio del 
telecomando dell’impugnatura (in dotazione), 
vedere pagina 24.

1. Levetta dello zoom

2. Pulsante programmabile ASSIGN 4

3. Manopola programmabile

4. Pulsante programmabile ASSIGN 6

5. Pulsante START/STOP registrazione

6. Multiselettore

7. Pulsante di rotazione impugnatura

8. Pulsante programmabile ASSIGN 5

Mirino

Oculare

Obiettivo (solo PXW-FS7K)

Telecomando impugnatura
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1. Pulsante DATA CODE
Non utilizzato in questa versione.

2. Pulsante TC RESET

3. Pulsante SCAN/SLOW

4. Pulsante ./> (PREV/NEXT)

5. Pulsante PLAY

6. Pulsante STOP

7. Pulsante DISPLAY

8. Trasmettitore del telecomando

9. Pulsante START/STOP

10. Levetta dello zoom

11. Pulsante PAUSE

12. Pulsante MODE
Non utilizzato in questa versione.

13. Pulsante b/B/v/V/ENTER

Per informazioni dettagliate sul montaggio 
dell’unità di estensione (opzione), vedere 
pagina 31.

1. Pulsante BATT RELEASE

2. Connettore della batteria

3. GENLOCK IN

4. DC IN

5. DC OUT

6. Indicatore di registrazione

7. REF OUT

8. TC IN/OUT

9. Selettore TC IN/OUT

10. RAW OUT

Telecomando ad infrarossi Unità di estensione (opzione)
12



Durante la ripresa (registrazione/standby) e la riproduzione, le informazioni sullo stato del camcorder e le 
sue impostazioni sono sovraimposte all’immagine visualizzata nel mirino.
È possibile visualizzare o nascondere queste informazioni premendo il pulsante DISPLAY.
È inoltre possibile scegliere quali voci devono essere visualizzate indipendentemente dalle altre (pagina 81).
L’immagine con rapporto di formato 17:9 acquisita dal sensore immagine è visualizzata nel mirino. Nei 
formati di registrazione 16:9, le porzioni scure sui bordi destro e sinistro non vengono registrate.

Informazioni visualizzate a schermo durante le riprese

1. Indicatore modalità otturatore / velocità 
otturatore (pagina 42)

2. Indicatore filtro ND (pagina 42)

3. Indicatore guadagno (pagina 41)
Visualizzato come valore EI quando Base 
Setting (pagina 91) >Shooting Mode nel menu 
System è impostato su “Cine EI”.

4. Indicazione posizione di messa a fuoco
Visualizza la posizione di messa a fuoco (se è 
montato un obiettivo che supporta questa 
funzione). 

5. Indicatori di modalità di registrazione, 
icona slot A/B e stato

Visualizzazione a schermo

Schermo del mirino

S&Q / zRec Registrazione Slow & 
Quick Motion, modalità 
High Frame Rate

S&Q / Stby Slow & Quick Motion, 
modalità High Frame 
Rate standby

/ zRec Registrazione

/ Stby Standby

/ z
Registrazione cache 
immagine

/ zCache
Cache immagine 
standby
13



6. Icona Slot B e indicatori di stato

7. Indicatore registrazione RAW esterna 
(pagina 50)

8. Indicatore di profondità di campo

9. Indicatore temperatura di colore 
(pagina 42)

10. Indicatore frequenza fotogrammi S&Q 
Motion (pagina 86)

11. Indicatore carica residua della batteria/
tensione DC IN (pagina 19)

12. Indicatore formato di registrazione 
(dimensioni immagine) (pagina 92)
Visualizza le dimensioni immagine per la 
registrazione su schede di memoria XQD.

13. Indicatore formato di registrazione 
(frequenza fotogrammi e metodo di 
scansione)

14. Indicatore formato di registrazione 
(codec) (pagina 41)
Visualizza il nome del formato di 
registrazione su schede di memoria XQD.

15. Indicatore LUT monitor/gamma 
(pagina 70, pagina 79)
Visualizza le impostazioni di gamma. 
Quando Shooting Mode (pagina 91) è 
impostato su “Cine EI”, visualizza le 
impostazioni LUT monitor o gamma per la 
registrazione di video su schede di memoria 
XQD.

16. Indicatore formato uscita esterna 
(pagina 78)

17. Indicatore di blocco esterno codice 
temporale
Visualizza “EXT-LK” quando l’apparecchio 
è sincronizzato sul codice temporale di un 
dispositivo esterno.

18. Indicatore di stato della connessione Wi-Fi 
(pagina 52)
Visualizzato quando la funzione Wi-Fi è 
impostata su “Enable”. Se non è montato un 
modulo IFU-WLM3 sul camcorder,  non 
viene visualizzato.

19. Indicatore stato GPS (pagina 50)
Visualizza lo stato della funzione GPS.

20. Indicatore Focus Assist di assistenza alla 
messa a fuoco (pagina 39)
Visualizza un riquadro di rilevazione 
(indicatore zona di messa a fuoco) che indica 
la zona in cui viene rilevata la messa a fuoco 
e una barra di livelli (indicatore Focus Assist) 
che segnala il grado di messa a fuoco 
all’interno della zona indicata.

21. Indicatore segnale video (pagina 16)
Visualizza forma d’onda, vettorscopio e 
istogramma.

22. Indicatore stato/capacità rimanente 
supporto in slot A/B (pagina 29)
Supporto di registrazione quando il lato 
sinistro dell’icona è di colore arancione.
Supporto di riproduzione quando l’indicatore 
verde in alto a destra dell’icona è illuminato.

23. Indicatore di livellamento
Visualizza l’orizzontalità trasversale e 
longitudinale in incrementi di ±1° fino a un 
massimo di ±20°.

24. Indicatore di livello audio

25. Indicatore nome clip (pagina 55)

26. Indicatore di messa a fuoco

27. Indicatore dati temporali (pagina 45)

28. Indicatore scheda SD

29. Indicatore di stato controllo uscita SDI 
(pagina 99)

30. Indicazione modalità bilanciamento del 
bianco (pagina 42)

31. Indicatore della modalità AE (pagina 41)

32. Indicatore diaframma automatico (Auto 
Iris) (pagina 41)

33. Indicatore AGC (pagina 41)

34. Indicatore otturatore automatico 
(pagina 42)

35. Indicatore della modalità di messa a fuoco

36. Indicatore della modalità di 
stabilizzazione dell’immagine 

37. Indicazione posizione di zoom
Visualizza il valore di zoom nel campo da 0 
(grandangolo) a 99 (teleobiettivo) (se è montato 
un obiettivo che supporta questa funzione)

zRec Registrazione

Stby Standby

W:P Modalità predefinita

W:A Modalità memoria A

W:B Modalità memoria B
14



38. Indicazione valore di diaframma
Visualizza il valore di diaframma (se è montato 
un obiettivo che supporta questa funzione).

Informazioni visualizzate a schermo durante la 
riproduzione
Le seguenti informazioni vengono sovraimposte 
sull’immagine riprodotta.

1. Numero clip / Numero totale dei clip

2. Modalità di riproduzione

3. Indicatore della carica residua della 
batteria

4. Indicatore formato di riproduzione 
(dimensioni immagine)

5. Indicatore formato di riproduzione 
(frequenza fotogrammi)

6. Indicatore formato di riproduzione 
(codec)

7. Indicatore di stato della connessione Wi-Fi 
(pagina 52)
Visualizzato quando la funzione Wi-Fi è 
impostata su “Enable”. Se non è montato un 
modulo IFU-WLM3 sul camcorder,  non 
viene visualizzato.

8. Indicatore supporto

9. Indicatore del livello audio
Visualizza l’indicatore di livello audio durante 
la registrazione.

10. Indicatore dati temporali
Quando Display On/Off >Timecode nel menu 
VF è impostato su “On”, visualizza i dati 
temporali quando si preme il pulsante 
DISPLAY.

Per visualizzare la schermata di stato:
• Premere il pulsante STATUS CHECK.

Per cambiare schermata di stato:
• Ruotare la manopola SEL/SET.
• Spostare il multiselettore verso l’alto o verso il 

basso.

Per nascondere la schermata di stato:
• Premere il pulsante STATUS CHECK.

Schermata Camera Status
Visualizza le impostazioni dell’otturatore 
elettronico del camcorder e lo stato dell’obiettivo.

Schermata di stato

ISO/Gain/EI<H> Impostazione ISO/Gain/EI<H>

ISO/Gain/EI<M> Impostazione ISO/Gain/EI<M>

ISO/Gain/EI<L> Impostazione ISO/Gain/EI<L>

Shutter Impostazioni otturatore (Speed/
Angle/ECS/Off)

Iris Valore di F-stop ottenuto 
dall’obiettivo

Zebra1 Impostazione Zebra1 On/Off e 
livello

Zebra2 Impostazione Zebra2 On/Off e 
livello

Gamma Impostazione Gamma Select

White Modalità e impostazioni di 
bilanciamento del bianco

Focal Length Valore di lunghezza focale 
ottenuto dall’obiettivo

AE Level Impostazione livello AE

AE Speed Impostazione velocità di controllo 
AE

AGC Limit Valore di guadagno massimo della 
funzione AGC

A.SHT Limit Velocità otturatore massima della 
funzione auto shutter

AE Mode Impostazione modalità AE 
(Backlight/Standard/Spotlight)
15



Schermata Audio Status
Visualizza le impostazioni di ingresso, 
l’indicatore di livello audio e le impostazioni del 
filtro di riduzione del rumore del vento per 
ciascun canale.

Schermata System Status
Visualizza le impostazioni del segnale video.

Schermata Video Output Status
Visualizza le impostazioni di uscita SDI, HDMI e 
video.

Schermata di stato dei pulsanti programmabili
Visualizza le funzioni assegnate ai pulsanti 
programmabili.

CH1 level meter Indicatore di livello audio del 
canale 1

CH1 Source Sorgente di ingresso del canale 1

CH1 Ref./Sens. Livello di riferimento di ingresso 
del canale 1

CH1 Wind Filter Valore di riduzione del filtro 
antivento del microfono del canale 
1

CH2 level meter Indicatore di livello audio del 
canale 2

CH2 Source Sorgente di ingresso del canale 2

CH2 Ref./Sens. Livello di riferimento di ingresso 
del canale 2

CH2 Wind Filter Valore di riduzione del filtro 
antivento del microfono del canale 
2

CH3 level meter Indicatore di livello audio del 
canale 3

CH3 Source Sorgente di ingresso del canale 3

CH3 Wind Filter Valore di riduzione del filtro 
antivento del microfono del canale 
3

CH4 level meter Indicatore di livello audio del 
canale 4

CH4 Source Sorgente di ingresso del canale 4

CH4 Wind Filter Valore di riduzione del filtro 
antivento del microfono del 
canale 4

Audio Input Level Impostazioni di ingresso audio

Monitor CH Impostazione di monitoraggio del 
canale

HDMI Output CH Impostazione combinazione 
canali audio HDMI di uscita.

Headphone Out Impostazione del tipo di uscita 
cuffie

Country Impostazioni regionali NTSC o 
PAL

Rec Format Formato di registrazione su schede 
di memoria XQD

Picture Size Dimensioni immagine per la 
registrazione su schede di 
memoria XQD

Frame Rate Frequenza fotogrammi per la 
registrazione su schede di 
memoria XQD

Rec Function Impostazioni e formato di 
registrazione speciale attivo

Simul Rec Stato Simul Rec On/Off 

Picture Cache Rec Stato Picture Cache Rec On/Off 

Video Light Set Indicatore luce video HVL-LBPC 
on/off

SDI1 Dimensioni immagine di uscita
Spazio colore
Uscita visualizzazione a schermo
Gamma

SDI2 Dimensioni immagine di uscita
Spazio colore
Uscita visualizzazione a schermo
Gamma

HDMI Dimensioni immagine di uscita
Spazio colore
Uscita visualizzazione a schermo
Gamma

REF Dimensioni immagine di uscita

RAW Dimensioni immagine di uscita

1 Funzione assegnata al pulsante 
ASSIGN 1

2 Funzione assegnata al pulsante 
ASSIGN 2

3 Funzione assegnata al pulsante 
ASSIGN 3

4 Funzione assegnata al pulsante 
ASSIGN 4

5 Funzione assegnata al pulsante 
ASSIGN 5

6 Funzione assegnata al pulsante 
ASSIGN 6
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Schermata Battery Status
Visualizza informazioni sulla batteria e la 
sorgente di alimentazione collegata al connettore 
DC IN.

Schermata Media Status
Visualizza la capacità rimanente e il tempo di 
registrazione rimanente dei supporti di 
registrazione (schede di memoria XQD A e B).

Schermata delle impostazioni del pulsante di 
registrazione
Visualizza le impostazioni dei pulsanti di 
START/STOP registrazione sul corpo e sulla 
maniglia (pagina 38).

IRIS Dial Funzione assegnata alla manopola 
IRIS

Assignable Dial Funzione assegnata alla manopola 
programmabile

Detected Battery Tipo di batteria

Remaining Capacità rimanente (%)

Charge Count Numero di ricariche

Capacity Capacità rimanente (Ah)

Voltage Tensione (V)

Manufacture Date Data di fabbricazione della 
batteria

Video Light 
Remaining

Visualizza la capacità rimanente 
della batteria della luce video.

Power Source Sorgente di alimentazione

Supplied Voltage Tensione fornita dalla sorgente di 
alimentazione.

Informazioni 
scheda A

Visualizza l’icona della scheda 
quando è inserito un supporto di 
registrazione nello slot A. 

Protezione scheda 
A

Visualizza l’icona di blocco 
quando il supporto di 
registrazione inserito nello slot A 
è protetto. 

Nota

Non è possibile proteggere schede 
di memoria XQD con il 
camcorder.

Indicatore 
capacità rimanente 
scheda A 

Visualizza la capacità rimanente 
del supporto di registrazione 
inserito nello slot A come 
percentuale su una barra.

Tempo di 
registrazione 
rimanente scheda 
A

Visualizza il tempo stimato di 
registrazione rimanente sul 
supporto di registrazione inserito 
nello slot A in minuti nelle 
condizioni di registrazione attuali.

Informazioni 
scheda B

Visualizza l’icona della scheda 
quando è inserito un supporto di 
registrazione nello slot B. 

Protezione scheda 
B

Visualizza l’icona di blocco 
quando il supporto di 
registrazione inserito nello slot B 
è protetto. 

Nota

Non è possibile proteggere schede 
di memoria XQD con il 
camcorder.

Indicatore 
capacità rimanente 
scheda B

Visualizza la capacità rimanente 
del supporto di registrazione 
inserito nello slot B come 
percentuale su una barra.

Tempo di 
registrazione 
rimanente scheda 
B

Visualizza il tempo stimato di 
registrazione rimanente sul 
supporto di registrazione inserito 
nello slot B in minuti nelle 
condizioni di registrazione attuali.

Informazioni 
scheda SD

Visualizza l’icona della scheda 
quando è inserito un supporto di 
memoria nello slot per schede 
UTILITY SD. 

Protezione della 
scheda SD

Visualizza l’icona di blocco 
quando il supporto di memoria 
inserito nello slot per schede 
UTILITY SD è protetto. 

Indicatore 
capacità rimanente 
scheda SD

Visualizza la capacità rimanente 
del supporto di memoria inserito 
nello slot per schede UTILITY SD 
come percentuale su una barra.

Capacità 
rimanente scheda 
SD

Visualizza la capacità rimanente 
del supporto di memoria inserito 
nello slot per schede UTILITY SD 
in GB.

Vita scheda SD Visualizza la vita utile del 
supporto di memoria inserito nello 
slot per schede UTILITY SD 
come percentuale.

Rec Button Visualizza gli slot per la 
registrazione comandata mediante 
il pulsante di START/STOP 
registrazione.

Handle Rec 
Button

Visualizza gli slot per la 
registrazione comandata mediante 
il pulsante di START/STOP 
registrazione della maniglia.
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È possibile utilizzare un pacco batteria o 
un’alimentazione CA da un adattatore CA.
Per sicurezza, utilizzare esclusivamente i 
seguenti pacchi batterie e adattatori CA Sony.

Pacchi batteria agli ioni di litio
BP-U30 (in dotazione)
BP-U60
BP-U60T
BP-U90

Caricabatterie
BC-U1 (in dotazione)
BC-U2

Adattatore CA (in dotazione)
MPA-AC1 (solo modello USA e Canada)
AC-NB12A (eccetto modello USA e Canada)

Non conservare i pacchi batteria in luoghi esposti 
alla luce solare diretta o a fiamme libere, oppure 
in cui siano presenti elevate temperature.

Note

• Questo camcorder non può essere alimentato dal 
caricabatterie BC-U1/BC-U2 come fonte di 
alimentazione esterna.

• Per l’alimentazione da una presa di corrente, utilizzare 
l’adattatore CA fornito.

• Impostare sempre l’interruttore POWER su Off prima 
di rimuovere o montare un pacco batteria o un 
adattatore CA. Se viene rimosso o montato con 
l’interruttore POWER su On, in alcuni casi il 
camcorder potrebbe non avviarsi.
Se non si riesce ad avviare il camcorder, impostare 
l’interruttore POWER su Off e rimuovere 
temporaneamente il pacco batteria o l’adattatore CA, 
quindi attendere circa 30 secondi prima di tentare un 
nuovo montaggio. (Se si rimuove o si monta 
l’adattatore CA mentre il camcorder è alimentato dal 
pacco batteria, o viceversa, è possibile effettuare la 
rimozione o il montaggio con l’interruttore POWER su 
On senza problemi.)

Per montare un pacco batteria, inserirlo fino in 
fondo nell’apposita sede (pagina 10), quindi 
spingerlo verso il basso per bloccarlo in 
posizione.

Per rimuovere un pacco batteria, premere e 
mantenere premuto il pulsante BATT RELEASE 
(pagina 10), fare scorrere la batteria verso l’alto e 
quindi estrarla dalla sede.

Note

• Prima di montare un pacco batteria, ricaricarlo con il 
caricabatterie specifico BC-U1 o BC-U2.

• Se la batteria viene ricaricata immediatamente dopo 
l’uso mentre è ancora calda, è possibile che non si 
ricarichi completamente.

Operazioni preliminari 

Alimentazione

Attenzione

Utilizzo del pacco batteria 

Pulsante BATT 
RELEASE
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Controllo della capacità rimanente
Durante la ripresa o la riproduzione con un pacco 
batteria, la capacità rimanente della batteria viene 
visualizzata nel mirino (pagina 13).

Il camcorder indica la capacità rimanente 
calcolando il tempo disponibile con il pacco 
batteria sulla base del consumo attuale.

Quando si utilizza un’unità di estensione 
Quando si utilizza l’unità di estensione XDCA-
FS7, viene visualizzata la tensione della batteria o 
la carica residua della batteria, a seconda della 
batteria utilizzata.

Nota

Non è possibile utilizzare il pacco batteria del camcorder 
quando è montata un’unità di estensione XDCA-FS7. È 
necessario montare un pacco batteria sull’unità XDCA-
FS7 oppure collegare un alimentatore esterno.

Se il livello di carica della batteria 
diventa insufficiente
Se il livello di carica rimanente della batteria 
scende al di sotto di un determinato valore 
durante l’utilizzo (stato Low BATT), viene 
visualizzato il messaggio di batteria prossima 
all’esaurimento, l’indicatore di registrazione 
comincia a lampeggiare e viene emesso un 
segnale acustico.
Se il livello di carica rimanente si abbassa oltre 
fino a raggiungere un livello al quale è 
impossibile continuare l’utilizzo dell’apparecchio 
(stato BATT Empty), viene visualizzato il 
messaggio di batteria esaurita.
Sostituire il pacco batteria esaurito con uno 
carico.

Modifica dei livelli di avviso
Per impostazione predefinita, il livello Low 
BATT è impostato al 10% della carica completa 
della batteria, mentre il livello BATT Empty è 
impostato sul 3%. È possibile modificare le 
percentuali dei livelli di avviso con l’opzione 

Camera Battery Alarm (pagina 97) del menu 
System.

Collegando il camcorder a una presa di corrente 
elettrica, è possibile utilizzarlo senza doversi 
preoccupare di ricaricare il pacco batteria.

Collegare l’adattatore CA al connettore DC IN 
del camcorder, quindi inserire la spina del cavo di 
alimentazione (in dotazione) in una presa 
elettrica.

Se la tensione fornita dall’alimentatore 
CA si abbassa
Se durante l’utilizzo la tensione fornita 
dall’alimentatore CA scende al di sotto di un 
determinato valore (stato DC Low Voltage1), 
viene visualizzato un messaggio che segnala 
l’abbassamento della tensione dell’alimentatore, 
l’indicatore di registrazione comincia a 
lampeggiare e viene emesso un segnale acustico.
Se la tensione di uscita dell’adattatore CA scende 
al di sotto di un valore che impedisce il 
funzionamento corretto (stato DC Low 
Voltage2), viene visualizzato un messaggio che 
segnala che la tensione di uscita dell’adattatore 
CA è insufficiente.
In questo caso, l’adattatore CA può essere 
difettoso. Controllare l’adattatore CA secondo il 
caso.

    Icona Capacità residua

91%-100%

71%-90%

51%-70%

31%-50%

11%-30%

0%-10%

Alimentazione CA 

Connettore DC IN 

Adattatore CA

Cavo di alimentazione

Alla presa di corrente
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Modifica dei livelli di avviso
Per impostazione predefinita, il livello DC Low 
Voltage1 è impostato su 11,5 V e il livello DC 
Low Voltage2 è impostato su 11,0 V. È possibile 
modificare i valori dei livelli di avviso con 
l’opzione Camera DC IN Alarm (pagina 97) del 
menu System.

Adattatori CA
• Non collegare né utilizzare un adattatore CA in 

uno spazio ristretto, ad esempio fra una parete e 
un mobile.

• Collegare l’adattatore CA alla presa di corrente 
più vicina. In caso di problemi durante l’uso, 
estrarre immediatamente la spina dalla presa 
elettrica.

• Non cortocircuitare le parti metalliche dello 
spinotto dell’adattatore CA. Questo ne 
causerebbe il guasto.

• La batteria non può essere ricaricata mentre è 
montata sul camcorder, anche se è connesso 
l’adattatore CA.

Note

• Il portamicrofono è già montato alla spedizione dalla 
fabbrica.

• Montare e smontare il portamicrofono solo mentre il 
camcorder è spento.

• Montare e rimuovere sempre il portamicrofono con il 
coperchietto di protezione dell’attacco montato per 
evitare possibili danni al sensore immagine.

1 Inserire il portamicrofono nella 
maniglia.

2 Inserire il blocchetto nella sua sede e 
stringere la vite per fissare il 
portamicrofono.

Montaggio degli 
accessori

Montaggio del portamicrofono

Blocchetto
20



Rimozione del portamicrofono
Rimuovere il blocchetto ed eseguire la procedura 
di montaggio in ordine inverso.

Nota

Montare e smontare il mirino solo mentre il camcorder è 
spento.

1 Allentare il morsetto di bloccaggio del 
mirino ed inserire il mirino nella 
sporgenza sulla parte anteriore della 
maniglia.

2 Regolare l’orientamento laterale del 
mirino, stringere la ghiera di bloccaggio 
e quindi connettere il mirino al 
connettore del mirino del camcorder.

Nota

Controllare che il mirino sia saldamente fissato. Se il 
morsetto non è stato correttamente serrato, è possibile 
che il mirino possa cadere durante le riprese.

Regolazione dell’orientamento del 
mirino.
Inclinare il mirino verso l’alto o il basso fino ad 
ottenere l’angolazione desiderata.

È possibile orientare il mirino in modo che sia 
rivolto verso il soggetto. Se si sposta il selettore 
MIRROR (pagina 48) su B/T, lo schermo LCD 
visualizza un’immagine speculare. L’immagine 
viene tuttavia registrata con l’orientamento 
corretto. 

Regolazione del contrasto del mirino
Ruotare la manopola CONTRAST per regolare il 
contrasto.

È possibile regolare la luminosità utilizzando 
l’opzione VF Setting >Brightness (pagina 81) del 
menu VF.

Rimozione del mirino
Allentare il morsetto di bloccaggio del mirino e 
ripetere la procedura di montaggio in senso 
inverso. 

Montaggio del mirino

Morsetto
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Nota

Montare e smontare l’oculare solo mentre il camcorder è 
spento.

1 Agganciare i ganci di metallo 
dell’oculare ai ganci di montaggio 
dell’oculare sul mirino.

2 Spingere la piastrina di bloccaggio 
situata nella parte inferiore dell’oculare 
in direzione della freccia per bloccare 
l’oculare in posizione.

Apertura dell’oculare

Premere il pulsante indicato dalla freccia.

Al rilascio del blocco, aprire l’oculare verso 
l’alto. Quando l’oculare è aperto, il mirino rimane 
visibile.

Rimozione dell’oculare
Sganciare il blocco dell’oculare e rimuovere 
l’oculare del mirino.

Montaggio dell’oculare

Ganci di montaggio oculare

Piastrina di bloccaggio
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Obiettivi consigliati
SELP28135G
SEL1635Z
SELP18200

Per informazioni dettagliate sugli obiettivi 
supportati dal camcorder, contattare il 
rappresentante dell’assistenza tecnica Sony.

Non lasciare l’obiettivo rivolto verso il sole. La 
luce solare diretta condotta dalle ottiche 
dell’obiettivo può mettersi a fuoco all’interno del 
camcorder e causare incendi.

Note

• Montare e smontare l’obiettivo solo mentre il 
camcorder è spento.

• Gli obiettivi sono componenti di elevata precisione. 
Non appoggiare mai un obiettivo su una superficie con 
il suo innesto rivolto verso il basso. Montare sempre il 
coperchietto di protezione fornito.

Montaggio di un treppiede
Usare gli attacchi filettati di montaggio del 
treppiede sul camcorder quando si monta un 
treppiede. L’utilizzo dell’attacco treppiede 
sull’obiettivo potrebbe causare danni.

Montaggio di un obiettivo con innesto E-
mount

1 Rimuovere i coperchietti di protezione 
dal corpo del camcorder e 
dall’obiettivo.

2 Per montare l’obiettivo, allineare con il 
camcorder l’indicatore (bianco) 
sull’innesto dell’obiettivo, inserire con 
attenzione l’obiettivo nell’innesto, 
quindi ruotare l’obiettivo in senso 
orario.

Quando l’obiettivo raggiunge la posizione 
corretta, si percepirà il clic di blocco.

Montaggio di un obiettivo con innesto A-
mount
Per poter montare un obiettivo con innesto A-
mount, è necessario montare prima l’apposito 
adattatore (opzionale).

Note

• Quando si utilizza un obiettivo con innesto A-mount, il 
diaframma è impostato su manuale.

• Quando la messa a fuoco è impostata su AF con un 
obiettivo LA-EA2 o LA-EA4, il diaframma è 
impostato su F3.5 o completamente aperto.

Rimozione dell’obiettivo
Per rimuovere l’obiettivo, procedere come 
descritto di seguito.

1 Mantenendo premuto il pulsante di 
rilascio obiettivo, ruotare l’obiettivo in 
senso antiorario.

2 Estrarre l’obiettivo dal corpo 
dell’apparecchio.

Nota

Se non viene montato immediatamente un altro 
obiettivo, montare il coperchietto di protezione attacco 
obiettivo sul lato concavo, ruotandolo in senso orario.

Montaggio dell’obiettivo

Attenzione

Indicatore di allineamento (bianco)
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Regolazioni del diaframma con obiettivi 
con selettore Auto Iris
• Quando il selettore Auto Iris dell’obiettivo è 

impostato su AUTO, il diaframma viene 
regolato automaticamente ma può essere anche 
regolato manualmente dal camcorder.

• Quando il selettore Auto Iris è impostato su 
MANUAL, il diaframma può essere regolato 
solo usando la ghiera dell’obiettivo. Le 
eventuali regolazioni dal camcorder non hanno 
alcun effetto.

Regolazioni della messa a fuoco con 
obiettivi con selettore di messa a fuoco
• Quando il selettore della messa a fuoco 

dell’obiettivo è impostato su AF/MF o AF, la 
messa a fuoco viene regolata automaticamente 
ma può essere anche regolata manualmente dal 
camcorder.

• Quando il selettore della messa a fuoco 
dell’obiettivo è impostato su Full MF o MF, la 
messa a fuoco può essere eseguita solo usando 
la ghiera dell’obiettivo. Le eventuali 
regolazioni dal camcorder non hanno alcun 
effetto.

Nota

Montare e smontare il telecomando dell’impugnatura 
solo mentre il camcorder è spento.

1 Montare il braccetto nell’attacco 
dell’impugnatura e stringere la vite.

2 Collegare il cavo del telecomando 
dell’impugnatura al connettore 
REMOTE del camcorder.

Montaggio del telecomando 
dell’impugnatura
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Note

• Controllare che il braccetto e il telecomando 
impugnatura siano saldamente fissati. Se le viti non 
sono correttamente serrate, è possibile che possano 
cadere durante le riprese.

• Non sostenere mai l’intero peso del camcorder 
afferrandolo solo dal telecomando dell’impugnatura.

Regolazione della posizione del 
telecomando dell’impugnatura.
Regolare l’angolazione del braccio (1).
Allentare le due viti sulla parte posteriore del 
braccio usando una moneta o un oggetto simile, 
regolare la lunghezza del braccio (2), quindi 
stringere le due viti.
Premere il pulsante di rotazione dell’impugnatura 
(pagina 11) per regolare l’angolazione del 
telecomando dell’impugnatura (3).

Smontaggio del telecomando 
dell’impugnatura

1 Scollegare il cavo del telecomando 
dell’impugnatura dal connettore 
REMOTE del camcorder.

2 Rimuovere il braccio dal camcorder.

Quando il camcorder viene acceso per la prima 
volta o se la batteria di backup si è scaricata 
completamente, nel mirino viene visualizzata la 
schermata delle impostazioni iniziali.
Impostare la data e l’ora dell’orologio interno in 
questa schermata.

Time Zone
Time Zone imposta il fuso orario, ovvero la 
differenza con l’ora UTC (Coordinated Universal 
Time). Impostare questo valore secondo il caso.

Impostazione di data e ora
Ruotare la manopola SEL/SET (pagina 9) per 
selezionare voci e impostazioni, quindi premere 
la manopola SEL/SET per applicare il valore 
specificato ed avviare l’orologio.
In seguito, dopo la chiusura della schermata di 
impostazione, è possibile modificare data, ora e 
fuso orario servendosi dell’opzione Clock Set 
(pagina 96) del menu System.

Note

• Se le impostazioni di data e ora sono andate perse 
perché la batteria di backup si è scaricata 
completamente a seguito di un lungo periodo di tempo 
in cui il camcorder è rimasto senza alimentazione 
(senza pacco batteria o alimentazione DC IN), verrà 
nuovamente visualizzata la schermata delle 
impostazioni iniziali quando si riaccende nuovamente 
il camcorder.

• Mentre è visualizzata la schermata delle impostazioni 
iniziali non è possibile eseguire alcuna operazione (ad 
eccezione dello spegnimento) fino a quando non si 
siano completate tutte le impostazioni di questa 
schermata.

• Il camcorder è dotato di una batteria ricaricabile 
interna che consente la memorizzazione di data, ora e 
altre impostazioni anche quando è spento. Per 
informazioni dettagliate sulla batteria ricaricabile 
interna, vedere pagina 103.

Impostazione 
dell’orologio
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Prima di iniziare le riprese, è necessario 
configurare il funzionamento di base del 
camcorder secondo l’applicazione specifica.

Sono disponibili due modalità di ripresa: la 
modalità “Custom”, che consente la creazione 
dell’immagine in sito con la massima flessibilità, 
e la modalità “Cine EI”, in cui il camcorder viene 
utilizzato in maniera analoga a una macchina 
cinematografica, sviluppando poi le riprese in 
sede di post produzione.
È possibile selezionare la modalità tramite Base 
Setting (pagina 91) >Shooting Mode nel menu 
System.

Color Space seleziona lo spazio colore, ovvero la 
gamma di colore di base dei segnali registrati e 
dei segnali in uscita.
Quando la modalità di ripresa è impostata su 
Custom, Color Space è impostato su “Matrix”.

Matrix: seleziona la gamma di colore con 
l’impostazione Matrix, simile alle 
videocamere convenzionali.

Quando la modalità di ripresa è impostata su Cine 
EI, Color Space seleziona la gamma colore 
dell’uscita video con MLUT impostato su Off.

S-Gamut3.Cine/SLog3: gamme di colore per il 
cinema digitale di facile regolazione 
(DCIP3).

S-Gamut3/SLog3: gamma colore allargata, 
compatibile con le gamme standard future, 
ottimizzata con la tecnologia di correzione 
delle distorsioni dell’immagine Sony.

È possibile selezionare la gamma colore tramite 
Base Setting (pagina 91) >Color Space nel menu 
System.

Il camcorder registra audio e video su schede di 
memoria XQD (vendute separatamente) inserite 
negli appositi slot.

Utilizzare con il camcorder le schede di memoria 
XQD Sony elencate di seguito.
Per informazioni dettagliate sull’utilizzo 
disupporti di memoria di altri fabbricanti, fare 
riferimento alle relative istruzioni per l’uso o 
consultare le informazioni del fabbricante.

Schede di memoria XQD serie S

Schede di memoria XQD serie H

Schede di memoria XQD serie N

Schede di memoria XQD serie G

Non è possibile garantire il corretto 
funzionamento con schede di memoria diverse 
dalle schede di memoria XQD Sony.

Per informazioni dettagliate sull’utilizzo e sulle 
precauzioni per l’uso delle schede di memoria XQD, 
fare riferimento alle istruzioni per l’uso fornite con 
le schede di memoria XQD stesse.

Configurazione delle 
operazioni di base del 
camcorder

Modalità di ripresa

Color Space

Utilizzo di schede di 
memoria XQD

Informazioni sulle schede di 
memoria XQD
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I supporti di memorizzazione consigliati potranno variare a seconda delle impostazioni di Rec Format e 
Recording.
Sì: supporto di memoria consigliato, di cui è stato verificato il corretto funzionamento.
No: il funzionamento corretto non è garantito.

Supporti di memoria consigliati

Formato XQD G
XQD S
(EB Stream)

XQD N Non più in 
vendita
XQD H
XQD S
(non EB Stream)

32/64/128 GB 32/64 GB 16/32/64 GB

XAVC Intra 
422

4096×2160P – 59.94P Sì No No

50P Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No

3840×2160 – 59.94P Sì No No

50P Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No

1920×1080 Modalità normale o 
S&Q (eccetto HFR)

59.94P Sì No No

59.94i Sì Sì No

50P Sì No No

50i Sì Sì No

29.97P Sì Sì No

25P Sì Sì No

23.98P Sì Sì No

S&Q (modalità 
HFR)

59.94P Sì No No

50P Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No
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* HFR: High Frame Rate

XAVC-L 3840×2160 – 59.94P Sì Sì No

50P Sì Sì No

29.97P Sì Sì No

25P Sì Sì No

23.98P Sì Sì No

1920×1080 Modalità normale o 
S&Q (eccetto HFR)

59.94P Sì Sì Sì

50P Sì Sì Sì

59.94i Sì Sì Sì

50i Sì Sì Sì

29.97P Sì Sì Sì

25P Sì Sì Sì

23.98P Sì Sì Sì

1920×1080 S&Q (modalità 
HFR)

59.94P Sì Sì No

50P Sì Sì No

29.97P
Sì

50 Mbps: No
30 Mbps: Sì

No

25P
Sì

50 Mbps: No
30 Mbps: Sì

No

23.98P
Sì

50 Mbps: No
30 Mbps: Sì

No

MPEG2 HD 
422

1920×1080 – 59.94i Sì Sì Sì

50i Sì Sì Sì

29.97P Sì Sì Sì

25P Sì Sì Sì

23.98P Sì Sì Sì

1280×720 – 59.94P Sì Sì Sì

50P Sì Sì Sì

29.97P Sì Sì Sì

25P Sì Sì Sì

23.98P Sì Sì Sì

ProRes 422 
HQ

1920×1080 – 59.94i Sì No No

50i Sì No No

29.97P Sì No No

25P Sì No No

23.98P Sì No No

ProRes 422 1920×1080 – 59.94i Sì Sì No

50i Sì Sì No

29.97P Sì Sì No

25P Sì Sì No

23.98P Sì Sì No

Formato XQD G
XQD S
(EB Stream)

XQD N Non più in 
vendita
XQD H
XQD S
(non EB Stream)

32/64/128 GB 32/64 GB 16/32/64 GB
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1 Premere il pulsante di rilascio del 
coperchietto degli slot (pagina 10) per 
aprirlo.

2 Inserire una scheda di memoria XQD 
con l’etichetta XQD rivolta a sinistra.

L’indicatore di accesso (pagina 10) si 
illumina di rosso, quindi diventa verde se la 
scheda è utilizzabile.

3 Chiudere il coperchietto.

Note

• La scheda di memoria, lo slot e i dati di immagine 
contenuti sulla scheda potrebbero subire danni se la 
scheda venisse forzata nello slot con l’orientamento 
errato.

• Quando si registra su un supporto in entrambi gli slot 
della scheda XQD A e B, inserire in entrambi gli slot il 
supporto consigliato per l’uso con il formato da 
registrare.

Premere il pulsante di rilascio del coperchietto 
degli slot (pagina 10) per aprirlo, quindi 
esercitare una leggera pressione sulla scheda 
stessa per espellerla.

Note

• Se il camcorder viene spento o la scheda viene rimossa 
durante l’accesso alla scheda, non è possibile garantire 
l’integrità dei dati contenuti sulla scheda. Tutti i dati 
registrati sulla scheda potrebbero essere danneggiati. 
Assicurarsi sempre che l’indicatore di accesso sia 
illuminato in verde o spento prima di spegnere il 
camcorder o rimuovere la scheda di memoria.

• Se si rimuove una scheda di memoria XQD 
immediatamente dopo la registrazione, è possibile che 
sia calda. Questo tuttavia non indica un problema.

Se sono presenti schede di memoria XQD in 
entrambi gli slot A e B, è possibile passare da una 
all’altra per la registrazione premendo il pulsante 
SLOT SELECT (pagina 9).

Se una scheda si riempie durante la registrazione, 
il camcorder passa automaticamente all’altra 
scheda.

Nota

Il pulsante SLOT SELECT è disabilitato durante la 
riproduzione. Non è possibile alternare fra le schede 
premendo il pulsante. Il pulsante è abilitato mentre è 
visualizzata la schermata delle miniature (pagina 55).

Se viene inserita una scheda di memoria XQD 
non formattata o formattata con altre specifiche, il 
mirino visualizza il messaggio “Media Needs to 
be Formatted”.
Formattare la scheda come descritto di seguito.

Selezionare Format Media (pagina 88) 
>Media(A) o Media(B) nel menu Media, 
quindi selezionare Execute. Quando viene 
visualizzato un messaggio di conferma, 
selezionare nuovamente Execute.

Durante la formattazione è visualizzato un 
messaggio e l’indicatore di accesso si illumina di 
rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare che 
l’operazione è stata completata. Premere la 
manopola SEL/SET per chiudere il messaggio.

Se la formattazione non riesce
Non è possibile formattare schede di memoria 
XQD protette o schede di memoria non 
supportate dal camcorder.
Viene visualizzato un messaggio di avvertimento. 
Seguire le istruzioni e sostituire la scheda con una 
scheda di memoria XQD supportata.

Nota

La formattazione di una scheda di memoria elimina tutti 
i dati che contiene, comprese le registrazioni video e i file 
di setup.

Durante la ripresa (registrazione/standby), è 
possibile monitorare la capacità rimanente sulla 
scheda di memoria XQD di ciascuno slot 
mediante gli indicatori di capacità degli slot A e 
B visualizzati nel mirino (pagina 13).

Inserimento di una scheda di 
memoria XQD

Espulsione delle schede di 
memoria XQD

Passaggio da una scheda di 
memoria XQD all’altra

Formattazione (inizializzazione) di 
schede di memoria XQD

Controllo del tempo di 
registrazione rimanente
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Il tempo di registrazione rimanente è calcolato 
sulla base della capacità rimanente della scheda di 
ciascuno slot e del formato video corrente (bit rate 
di registrazione) ed è indicato in minuti.

Nota

Se la scheda è protetta viene visualizzata l’icona .

Tempi di sostituzione delle schede di 
memoria XQD
• Quando il tempo di registrazione rimanente 

totale sulle due schede scende al di sotto di 5 
minuti, viene visualizzato il messaggio “Media 
Near Full”, l’indicatore di registrazione 
comincia a lampeggiare e viene emesso un 
segnale acustico di avvertimento sull’uscita 
cuffie. Sostituire con una scheda con spazio 
libero sufficiente.

• Se si prosegue con la registrazione fino a 
esaurire completamente lo spazio disponibile, 
appare il messaggio “Media Full” e la 
registrazione si arresta.

Nota

Su una scheda di memoria XQD può essere registrato un 
massimo di 600 clip circa.
Se il numero di clip registrati raggiunge il limite 
massimo, l’indicatore del tempo di registrazione 
rimanente segnalerà “0” e verrà visualizzato il 
messaggio “Media Full”.

I dati di configurazione videocamera del 
camcorder possono essere salvati su una scheda 
SD (disponibile separatamente). È possibile 
anche importare da una scheda SD i file di dati 
precedentemente salvati in essa.

Schede di memoria SDHC*
Schede di memoria SD*
* Indicate collettivamente come “schede SD” in questo 

manuale.

1 Premere il pulsante di rilascio del 
coperchietto degli slot (pagina 10) per 
aprirlo.

2 Inserire la scheda di memoria SD con 
l’etichetta SD rivolta a sinistra.

L’indicatore di accesso (pagina 10) si 
illumina di rosso e quindi si spegne se la 
scheda è utilizzabile.

3 Chiudere il coperchietto.

Premere il pulsante di rilascio del 
coperchietto degli slot (pagina 10) per 
aprirlo, quindi esercitare una leggera 
pressione sulla scheda SD per espellerla.

Note

• Se il camcorder viene spento o la scheda SD viene 
rimossa durante l’accesso, non è possibile garantire 
l’integrità dei dati contenuti su di essa. Tutti i dati 
registrati sulla scheda potrebbero essere danneggiati. 
Assicurarsi sempre che l’indicatore di accesso non sia 
illuminato prima di spegnere il camcorder o rimuovere 
la scheda SD.

• Prestare attenzione per evitare che la scheda SD salti 
fuori dal camcorder durante l’inserimento o 
l’espulsione.

Utilizzo di una scheda 
UTILITY SD

Schede SD supportate

Inserimento di una scheda SD

Espulsione della scheda SD
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È necessario formattare le schede SD la prima 
volta che vengono utilizzate nel camcorder.
Le schede SD da utilizzare con questo camcorder 
dovrebbero essere formattate con la funzione di 
formattazione di questo camcorder. Se viene 
visualizzato un messaggio quando la scheda SD 
viene inserita nel camcorder, formattare la scheda 
SD.

Selezionare Format Media (pagina 88) >SD 
Card nel menu Media, quindi selezionare 
Execute. Quando viene visualizzato un 
messaggio di conferma, selezionare 
nuovamente Execute.

Durante la formattazione sono visualizzati un 
messaggio e l’indicatore di avanzamento 
dell’operazione. L’indicatore di accesso è inoltre 
illuminato in rosso.
Al termine della formattazione, viene 
visualizzato un messaggio per confermare che 
l’operazione è stata completata. Premere la 
manopola SEL/SET per chiudere il messaggio.

Nota

La formattazione di una scheda SD elimina tutti i dati 
presenti su di essa. La scheda non può essere ripristinata.

È possibile controllare la capacità rimanente su 
una scheda SD nella schermata Media Status 
(pagina 17).

Nota

Se la scheda SD è protetta viene visualizzata l’icona .

Per utilizzare con un altro dispositivo una scheda 
SD formattata con questo camcorder
Eseguire il backup di tutti i dati registrati sulla 
scheda, quindi riformattare la scheda nel 
dispositivo in cui deve essere utilizzata.

Montando un’unità di estensione XDCA-FS7 
(opzione), è possibile aggiungere al camcorder 
ulteriori funzionalità, ad esempio una batteria V-
shoe o un segnale di sync esterno.

Note

• Non è possibile utilizzare il pacco batteria del 
camcorder quando è montata un’unità di estensione 
XDCA-FS7. È necessario montare un pacco batteria 
sull’unità XDCA-FS7 oppure collegare un 
alimentatore esterno.

• Montare e smontare l’unità di estensione XDCA-FS7 
solo mentre il camcorder è spento.

1 Rimuovere il pacco batteria (pagina 18) 
montato sul camcorder.

2 Rimuovere il coperchio della sezione 
connettore dell’unità di estensione.

Formattazione (inizializzazione) di 
schede SD

Controllo della capacità 
rimanente

Utilizzo dell’unità di 
estensione XDCA-FS7

Montaggio dell’unità di 
estensione XDCA-FS7
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3 Allineare le sporgenze dell’unità di 
estensione XDCA-FS7 con le scanalature 
di sinistra e destra del camcorder, quindi 
inserire completamente. Infine spingere 
l’unità XDCA-FS7 verso il basso nella 
sezione di connessione.

4 Assicurare in posizione l’unità XDCA-
FS7 stringendo le due viti presenti sulla 
parte superiore dell’unità stessa.

Il coperchietto della sezione di connessione 
dell’unità di estensione può essere inserito 
nella parte superiore dell’unità di estensione.

Allentare le due viti sulla parte superiore 
dell’unità XDCA-FS7 per rimuoverla dal 
camcorder.

Inserire il pacco batteria nell’apposito 
alloggiamento sull’unità XDCA-FS7.
Sono supportati i seguenti modelli di pacchi 
batterie originali Sony.

Pacchi batteria agli ioni di litio
BP-L80S
BP-FL75

Scanalature Sporgenze
Rimozione dell’unità XDCA-FS7

Montaggio del pacco batteria
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Estrarre il pacco batteria dal suo alloggiamento 
sull’unità XDCA-FS7 mantenendo premuto allo 
stesso tempo il pulsante BATT RELEASE.

Il selettore TC IN/OUT (pagina 12) consente di 
commutare l’entrata/uscita del codice temporale.

Per informazioni dettagliate, vedere pagina 101.

È possibile registrare video RAW (pagina 50) su 
un registratore RAW AXS-R5 (opzione) 
utilizzando un’unità di interfaccia HXR-IFR5 
(opzione) e un’unità di estensione XDCA-FS7 
(opzione).
Per informazioni dettagliate su come configurare 
le unità HXR-IFR5 e AXS-R5, fare riferimento al 
manuale di istruzioni dell’unità di interfaccia 
HXR-IFR5.

1 Montare l’unità di estensione 
XDCA-FS7 sul camcorder (pagina 31).

2 Collegare il connettore RAW OUT 
dell’unità XDCA-FS7 al connettore SDI 
IN (RAW) dell’unità HXR-IFR5 
mediante un cavetto SDI.

Scollegare il cavo SDI dal connettore RAW 
OUT dell’unità XDCA-FS7.

Rimozione del pacco batteria

Commutazione entrata/uscita del 
codice temporale

Utilizzo di un’unità di 
interfaccia HXR-IFR5 e di 
un registratore AXS-R5

Connessione dell’unità di 
interfaccia HXR-IFR5 al 
camcorder

Rimozione dell’unità di 
interfaccia HXR-IFR5

Cavetto SDI

HXR-IFR5

AXS-R5
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Utilizzo per la prima volta
Estrarre la pellicola di isolamento dal vano 
batteria la prima volta che si utilizza il 
telecomando ad infrarossi fornito. 

Al momento della spedizione, il vano batteria 
contiene una batteria al litio CR2025.

Utilizzo del camcorder con il 
telecomando
Per utilizzare il telecomando, accendere il 
camcorder e quindi abilitare il funzionamento con 
telecomando.
Abilitare/disabilitare la funzione di comando a 
distanza mediante il menu di configurazione.

Abilitazione mediante il menu
Premere il pulsante MENU per attivare la 
modalità menu del camcorder, quindi impostare 
IR Remote (pagina 97) nel menu System su On.

Note

• Dirigere il telecomando verso il sensore di ricezione 
del telecomando del camcorder.

• Collocare il camcorder in modo che il sensore di 
ricezione del telecomando non sia esposto alla luce 
diretta proveniente dal sole o da altre intense sorgenti 
di illuminazione. L’esposizione a luci intense può 
impedire il funzionamento corretto tramite 
telecomando.

• Durante l’uso con il camcorder, il telecomando fornito 
in dotazione potrebbe azionare erroneamente anche 
altri deck video. In tal caso, spostare il selettore di 
modalità telecomando del deck video su DVD2 oppure 
coprirne il sensore di ricezione con carta nera.

Sostituzione della batteria del 
telecomando
Il telecomando utilizza una normale batteria 
CR2025.
Utilizzare esclusivamente batterie tipo CR2025.

1 Spingere la linguetta e rimuovere il 
portabatteria inserendo un’unghia 
nella scanalatura.

2 Inserire la nuova batteria con il lato + 
rivolto verso l’alto.

3 Reinserire il portabatteria fino allo 
scatto in posizione.

Non conservare i pacchi batteria in luoghi esposti 
alla luce solare diretta o a fiamme libere, oppure 
in cui siano presenti elevate temperature

Nota

La sostituzione della batteria con un’altra di tipo non 
raccomandato potrebbe causare il guasto del dispositivo. 
Sostituire sempre con il tipo di batteria specificato.
Smaltire le batterie usate in conformità con le normative 
nazionali e locali.

Utilizzo del telecomando 
a infrarossi

Pellicola di isolamento

Attenzione

Linguetta
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È possibile azionare il camcorder da un browser 
web collegando al camcorder tramite una rete 
LAN wireless uno smartphone, un tablet o un 
altro dispositivo che consente l’utilizzo di un 
browser web. Questa funzione è denominata 
telecomando Wi-Fi.
Questa funzione è utile nelle applicazioni in cui il 
camcorder è fissato in una posizione difficile da 
raggiungere, ad esempio se è montato su un 
braccio aereo.
Per informazioni dettagliate sulla procedura di 
configurazione della funzione di telecomando 
Wi-Fi, vedere pagina 54.

Schermata di Wi-Fi Remote (smartphone)

Schermata Main

Schermata Playback

Schermata Cursor

Schermata Assign

Utilizzo del telecomando 
Wi-Fi

• Impostazioni
S&Q FPS, Shutter, 
White, Sensitivity/
Gain/Exposure Index, 
Gamma, MLUT, Color 
Bars, Auto Black, 
Auto White, Rec Start/
Stop, Lock, Iris, Focus, 
Zoom, Auto Iris, Auto 
Shutter, AGC, ATW

• Stato
• Pulsanti di comando 

riproduzione
Play/Pause, Stop, F 
Fwd, F Rev, Next, Prev

• Stato
• Pulsanti cursore

Su, Giù, Sinistra, 
Destra, Set, Cancel/
Back, Menu, Status, 
Thumbnail, User 
Menu

• Stato
• Pulsanti 

programmabili
Pulsanti 
programmabili da 1 a 6
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Schermata di Wi-Fi Remote (tablet)

Schermata Main

• Impostazioni
S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure 
Index, Gamma, MLUT, Color Bars, Auto Black, Auto 
White, Rec Start/Stop, Lock, Iris, Focus, Zoom, Auto 
Iris, Auto Shutter, AGC, ATW

Schermata Playback

• Stato
• Pulsanti di comando riproduzione

Play/Pause, Stop, F Fwd, F Rev, Next, Prev

Schermata Cursor

• Stato
• Pulsanti cursore 

Up, Down, Left, Right, Set, Cancel/Back, Menu, 
Status, Thumbnail, User Menu

Schermata Assign

• Stato
• Pulsanti programmabili

Pulsanti programmabili da 1 a 6
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Di seguito si descrive la procedura per eseguire 
una semplice ripresa di base.

1 Montare i dispositivi necessari e 
controllare che l’alimentazione sia 
presente.

2 Inserire almeno una scheda di 
memoria.

3 Spostare l’interruttore POWER su ON.

L’immagine della videocamera appare nel 
mirino.

4 Premere il pulsante di registrazione 
(pagina 7).

L’indicatore di registrazione si illumina e il 
camcorder inizia la registrazione.

5 Per arrestare la registrazione premere 
nuovamente il pulsante di registrazione.

La registrazione si arresta e il camcorder 
entra in modalità STBY (standby).

Nota

Se si preme il pulsante di registrazione entro pochi 
secondi successivi all’accensione del camcorder, 
l’indicatore di registrazione si illumina per indicare che 
l’unità è in stato di registrazione, ma, a seconda del 
formato di registrazione selezionato, potrebbe non 
avvenire alcuna registrazione sul supporto durante i 
primi secondi.

Ripresa (modalità Full Auto)
Premere il pulsante FULL AUTO. L’indicatore 
del pulsante si illumina.
Le funzioni di diaframma automatico (per gli 
obiettivi compatibili), AGC, otturatore 
automatico, ATW (tracciamento automatico del 
bilanciamento del bianco) sono attivate per 
controllare automaticamente luminosità e 
bilanciamento del bianco (modalità 
completamente automatica).
Per regolare manualmente ciascuna funzione, 
disattivare la modalità Full Auto.

Registrazione continua durante la 
sostituzione di schede di memoria 
(Relay Rec)
Quando sono presenti schede di memoria in 
entrambi gli slot A e B, la registrazione passa 
automaticamente alla seconda scheda di memoria 
poco prima che la capacità rimanente sulla prima 
scheda si esaurisca.

Note

• Non espellere una scheda di memoria mentre è in corso 
la registrazione su di essa. Sostituire schede di 
memoria solo negli slot il cui indicatore di accesso non 
è illuminato.

• Quando la capacità rimanente sulla scheda di memoria 
su cui viene eseguita la registrazione diventa inferiore 
a un minuto ed è presente una scheda di memoria 
registrabile nell’altro slot, viene visualizzato il 
messaggio “Will Switch Slots Soon”. Il messaggio 
scompare dopo il passaggio all’altro slot.

• La registrazione relay può non essere possibile se la 
registrazione viene avviata quando la capacità 
rimanente della scheda di memoria è inferiore a un 
minuto. Per consentire il funzionamento corretto della 
registrazione relay, controllare che la capacità 
rimanente sulla scheda di memoria sia superiore a un 
minuto prima di iniziare la registrazione.

• I video creati con la funzione di registrazione relay del 
camcorder non possono essere riprodotti senza 
interruzione sul camcorder.

• Per unire insieme video creato con la funzione di 
registrazione relay del camcorder, utilizzare il 
software Content Browser.

Registrazione simultanea sulle schede 
di memoria A e B (Simul Rec)
È possibile registrare simultaneamente su 
entrambe le schede memoria A e B.

Configurare Simul Rec >Setting nel menu 
Recording su “On”.

Nota

La registrazione simultanea non è supportata nella 
modalità Slow & Quick Motion (pagina 86) né nella 
modalità di registrazione Picture Cache (pagina 86).
Inoltre, la registrazione simultanea non è supportata per 
i formati di registrazione elencati di seguito (pagina 92).

Ripresa

Operazioni di base
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NTSC Area
XAVC-I
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 3840 × 2160 59.94P, 
3840 × 2160 29.97P, 3840 × 2160 23.98P, 
1920 × 1080 59.94P
XAVC-L
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P
RAW (quando sono connessi unità di estensione 
XDCA-FS7, unità di interfaccia HXR-IFR5 e 
registratore AXS-R5)
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 2048 × 1080 59.94P, 
2048 × 1080 29.97P, 2048 × 1080 23.98P
RAW & XAVC-I (quando sono connessi unità di 
estensione XDCA-FS7, unità di interfaccia 
HXR-IFR5 e registratore AXS-R5)
4096 × 2160 59.94P, 2048 × 1080 59.94P
ProRes 422 HQ, ProRes 422 (quando è connessa 
l’unità di estensione XDCA-FS7)
1920 × 1080 59.94i, 1920 × 1080 29.97P, 
1920 × 1080 23.98P

PAL Area
XAVC-I
4096 × 2160 50P, 4096 × 2160 25P, 
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P
XAVC-L
3840 × 2160 50P, 3840 × 2160 25P
RAW (quando sono connessi unità di estensione 
XDCA-FS7, unità di interfaccia HXR-IFR5 e 
registratore AXS-R5)
4096 × 2160 50P, 4096 × 2160 25P, 
2048 × 1080 50P, 2048 × 1080 25P
RAW & XAVC-I (quando sono connessi unità di 
estensione XDCA-FS7, unità di interfaccia 
HXR-IFR5 e registratore AXS-R5)
4096 × 2160 50P, 2048 × 1080 50P
ProRes 422 HQ, ProRes 422 (quando è connessa 
l’unità di estensione XDCA-FS7)
1920 × 1080 50i, 1920 × 1080 25P

Modifica delle impostazioni dei pulsanti 
START/STOP di registrazione del 
camcorder e della maniglia
Quando la funzione di registrazione simultanea 
(Simul Rec) è abilitata, è possibile avviare ed 
arrestare la registrazione su ciascuna scheda di 
memoria indipendentemente utilizzando i 
pulsanti di START/STOP registrazione del 
camcorder e della maniglia.
Per impostazione predefinita, entrambi i pulsanti 
sono impostati per avviare/arrestare la 
registrazione simultaneamente su entrambe le 
schede memoria A e B.
• “Rec Button [SlotA SlotB] Handle Rec Button 

[SlotA SlotB]”

Quando i pulsanti sono impostati per comandare 
la registrazione su schede di memoria diverse, 
SDI/HDMI Rec Control e RAW Rec Control 
seguono lo stato di registrazione dello slot A.

Per modificare l’impostazione

Selezionare Simul Rec >Rec Button Set nel 
menu Recording.

È necessario che sia montato un obiettivo che 
supporta la funzione di messa a fuoco automatica. 
Spostare il selettore FOCUS (pagina 9) del 
camcorder sulla posizione “AUTO”. Se 
l’obiettivo è dotato di un selettore di messa a 
fuoco, spostarlo nella posizione “AF/MF” o 
“AF”. Se il selettore si trova nelle posizioni “Full 
MF” o “MF” non è possibile eseguire la messa a 
fuoco dal camcorder (pagina 24).

Sospensione momentanea della messa a 
fuoco automatica (Focus Hold)
Premere il pulsante PUSH AUTO FOCUS 
(pagina 9) mentre il camcorder si trova in 
modalità di messa a fuoco automatica per 
sospendere la messa a fuoco automatica.
Questa capacità è utile, ad esempio, quando 
qualcosa attraversa la zona di ripresa fra il 
soggetto e il camcorder e non si desidera che sia 

Rec Button Set Pulsanti e schede di 
memoria

“Rec Button 
[SlotA SlotB] 
Handle Rec 
Button [SlotA 
SlotB]”

Avvia/arresta la registrazione 
simultanea su entrambe le schede 
di memoria A e B premendo uno 
qualsiasi dei pulsanti.

“Rec Button 
[SlotA] Handle 
Rec Button 
[SlotB]”

Il pulsante START/STOP avvia/
arresta la registrazione sulla 
scheda di memoria A mentre il 
pulsante START/STOP della 
maniglia avvia/arresta la 
registrazione sulla scheda di 
memoria B.

“Rec Button 
[SlotB] Handle 
Rec Button 
[SlotA]”

Il pulsante START/STOP avvia/
arresta la registrazione sulla 
scheda di memoria B mentre il 
pulsante START/STOP della 
maniglia avvia/arresta la 
registrazione sulla scheda di 
memoria A.

Regolazione automatica della 
messa a fuoco
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messo a fuoco, oppure quando la messa a fuoco 
automatica viene perduta.

Per regolare manualmente la messa a fuoco, 
spostare il selettore FOCUS (pagina 9) su 
“MAN”.
Questo consente di regolare la messa a fuoco 
manualmente secondo le condizioni di ripresa.
La messa a fuoco manuale è utile per le seguenti 
tipologie di soggetti:

- Soggetti sull’altro lato di una finestra coperta 
di goccioline d’acqua

- Soggetti con un basso contrasto rispetto allo 
sfondo

- Soggetti più lontani in presenza di soggetti 
vicini

Regolazione rapida della messa a fuoco 
in modalità manuale (Push Auto Focus)
Posizionare il soggetto da mettere a fuoco al 
centro dell’immagine, quindi premere il pulsante 
PUSH AUTO FOCUS (pagina 9).
La messa a fuoco ritorna all’impostazione 
precedente non appena si rilascia il pulsante.
Questa capacità è utile quando si desidera mettere 
a fuoco rapidamente il soggetto prima di avviare 
la ripresa.

Note

• La funzione Push Auto Focus non è attiva se 
l’obiettivo è impostato per la messa a fuoco manuale.

• Durante l’utilizzo della funzione Push Auto Focus con 
un obiettivo LA-EA2/4, la modalità Full Auto è On.

Indicatore di messa a fuoco
Indica lo stato della messa a fuoco
• (Illuminato): Soggetto a fuoco.
• (Lampeggiante): Soggetto non a fuoco. Dato 

che la messa a fuoco non è automatica, 
cambiare la composizione e le impostazioni di 
messa a fuoco per mettere a fuoco il soggetto.

Messa a fuoco con vista ingrandita 
(Focus Magnifier)
Per impostazione predefinita, la funzione Focus 
Magnifier x4/x8 è assegnata al pulsante 
ASSIGN4 del telecomando dell’impugnatura 
(pagina 45).

Premere il pulsante ASSIGN4.

Viene visualizzata la schermata Focus Magnifier, 
con il centro ingrandito di circa quattro volte. 
Premere nuovamente il pulsante per aumentare 
l’ingrandimento a circa otto volte. Questa 
funzione è utile per controllare la messa a fuoco.
Premere nuovamente il pulsante per tornare alla 
schermata normale.

Note

• L’ingrandimento della messa a fuoco non ingrandisce 
l’immagine registrata né l’immagine fornita sull’uscita 
SDI/HDMI.

• Durante l’ingrandimento della messa a fuoco, il 
pulsante STATUS CHECK e i pulsanti di menu non 
sono attivi.

Regolazione della messa a fuoco con 
l’ausilio dell’indicatore focus assist

La posizione di messa a fuoco corretta è indicata 
dalla massima lunghezza della barra. Regolare la 
messa a fuoco fino a raggiungere la massima 
lunghezza della barra.

Regolazione manuale della 
messa a fuoco

Riquadro del campo di rilevamento della 
messa a fuoco
(Indicatore della zona di messa a fuoco)

Indicatore Focus Assist di 
assistenza alla messa a fuoco 

A fuoco: massima 
lunghezza raggiunta 
dalla barra
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Nota

Nelle riprese di soggetti con superfici uniformi e senza 
variazioni oppure nelle riprese in condizioni di scarsa 
illuminazione, la lunghezza dell’indicatore di messa a 
fuoco può non variare o variare molto poco.

L’audio registrato può essere monitorato tramite 
le cuffie.
Collegando delle cuffie al relativo connettore 
(pagina 10) è possibile monitorare l’audio 
durante la registrazione. L’audio di riproduzione 
(pagina 56) può essere monitorato sia tramite 
l’altoparlante incorporato (pagina 10) che le 
cuffie.
È possibile selezionare il canale audio da 
monitorare e regolare il volume con l’opzione 
Audio Output (pagina 77) del menu Audio.

Quando sono inserite due schede di memoria 
XQD, premere il pulsante SLOT SELECT 
(pagina 9) per passare da una scheda all’altra.

Nota

Non è possibile passare da una scheda all’altra durante la 
riproduzione. Non è inoltre possibile la riproduzione 
continuata di un clip che si estende su entrambe le schede 
di memoria dei due slot A e B.

Monitoraggio audio

Passaggio da una scheda di 
memoria XQD all’altra

Clip (dati registrati)
Quando si arresta la registrazione, il video, 
l’audio e i dati accessori dall’inizio alla fine 
della registrazione vengono salvati come un 
unico “clip” sulla scheda di memoria XQD.

Nome dei clip
Ai clip registrati dal camcorder viene 
automaticamente assegnato un nome composto 
dalla parola “Clip” e da un numero di 4 cifre. Il 
numero di 4 cifre è incrementato 
automaticamente ad ogni registrazione.
Per modificare il prefisso “Clip”, utilizzare la 
voce Clip del menu Media. 

Durata massima dei clip
Fino a 6 ore per clip.
Nella funzione di registrazione relay, vengono 
registrati più clip in successione l’uno dopo 
l’altro. Tuttavia la registrazione si arresta 
automaticamente dopo circo 13 ore.
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È possibile modificare le impostazioni in base 
all’applicazione o alle condizioni di 
registrazione.

I formati disponibili e selezionabili variano a 
seconda del paese di utilizzo e del codec 
specificato.
Selezionare un formato tramite l’opzione Rec 
Format >Video Format nel menu System.

È possibile regolare la luminosità variando 
opportunamente i valori di diaframma, guadagno, 
velocità dell’otturatore, nonché regolando il 
livello di luce mediante i filtri ND.
Per regolare la luminosità senza utilizzare filtri 
ND, disattivare la modalità Full Auto 
(pagina 37).
È possibile regolare il livello di controllo della 
luminosità servendosi del menu di 
configurazione.

Regolazione del livello di controllo
Impostare il livello mediante l’opzione Auto 
Exposure (pagina 63) >Level del menu Camera.

Nota

Non è possibile regolare automaticamente la luminosità 
nella modalità Cine EI.

Regolazione automatica del diaframma
Questa funzione regola la luminosità in base al 
soggetto. È necessario che sia montato un 
obiettivo che supporta la funzione di regolazione 
automatica del diaframma.

1 Se è montato un obiettivo con selettore 
Auto Iris, impostarlo su AUTO.

2 Premere il pulsante IRIS (pagina 45) 
per attivare la modalità Auto Iris. 

La funzione viene attivata o disattivata ad 
ogni pressione del pulsante IRIS.

Nota

Il diaframma non può essere regolato 
automaticamente su un obiettivo con innesto A-
mount.

Regolazione manuale del diaframma

Premere il pulsante IRIS per disattivare la 
funzione Auto Iris, quindi regolare 
utilizzando la manopola IRIS.

È possibile anche assegnare la funzione IRIS a 
una manopola programmabile (pagina 45).

Regolazione automatica temporanea del 
diaframma
Mantenere premuto il pulsante PUSH AUTO 
IRIS per attivare momentaneamente la funzione 
di regolazione automatica del diaframma.
Il diaframma ritorna all’impostazione precedente 
non appena si rilascia il pulsante.

Nota

Se il selettore Auto Iris dell’obiettivo è impostato su 
“MANUAL”, le funzioni Auto Iris e Push Auto Iris del 
camcorder non hanno effetto. Non hanno effetto 
nemmeno le regolazioni manuali del diaframma sul 
camcorder.

Regolazione automatica del guadagno 
Premere il pulsante ISO/Gain (pagina 9) per 
attivare la funzione AGC.
Oppure, selezionare Auto Exposure (pagina 63) 
>AGC nel menu Camera e impostare su “On”.

Regolazione manuale del guadagno 
La regolazione del guadagno è utile per regolare 
l’esposizione mentre si utilizza un valore di 
diaframma fisso oppure se si desidera evitare 
l’aumento del guadagno generato dalla funzione 
AGC.

1 Premere il pulsante ISO/Gain 
(pagina 9) per disattivare la funzione 
AGC.

2 Spostare il selettore GAIN (pagina 9) su 
H, M o L.

Modifica delle 
impostazioni di base

Selezione della modalità di 
registrazione

Regolazione della luminosità
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Regolazione fine del guadagno
Ruotare la manopola IRIS o la manopola 
programmabile a cui è assegnata la funzione ISO/
Gain/EI per regolare il valore di guadagno 
impostato dal selettore GAIN.
Questa funzione è utile se si desidera correggere 
l’esposizione di un passo senza tuttavia 
modificare la profondità di campo.
Per annullare il valore di guadagno modificato, 
spostare il selettore GAIN o riattivare la funzione 
AGC.

Riprese con otturatore automatico
Questa funzione regola la velocità dell’otturatore 
automaticamente in risposta alla luminosità 
dell’immagine.

Premere il pulsante SHUTTER (pagina 9).

Se era visualizzata la schermata delle 
impostazioni, premere nuovamente il pulsante.
Oppure impostare Auto Exposure (pagina 63) 
>Auto Shutter nel menu Camera su On.

Riprese con otturatore fisso
È possibile eseguire riprese con una velocità di 
otturatore fissa.
Premere il pulsante SHUTTER per visualizzare 
una schermata con i valori di otturatore 
disponibili, quindi selezionare ed impostare il 
valore desiderato mediante la manopola SEL/
SET. Se si preme nuovamente il pulsante 
SHUTTER invece della manopola SEL/SET, 
viene attivata la funzione di otturatore 
automatico.

Impostazione nel menu Camera
Selezionare Shutter (pagina 65) nel menu 
Camera e scegliere la modalità e la velocità 
otturatore desiderate.

Regolazione del livello di luce (filtro ND)
In condizioni di illuminazione troppo intensa, è 
possibile ottenere la luminosità corretta 
utilizzando un filtro ND. 
Ruotare la manopola ND FILTER (pagina 9) per 
selezionare in sequenza Clear t 1/4 t 1/16 t 
1/64 t Clear.

È possibile selezionare la modalità di regolazione 
più adatta per le condizioni di ripresa.

Modalità ATW (bilanciamento 
automatico del bianco)
Questa funzione regola automaticamente il 
bilanciamento del bianco a un livello ottimale.
Il valore di bilanciamento del bianco viene 
automaticamente regolato quando cambia la 
temperatura di colore della sorgente luminosa.
Premere il pulsante WHT BAL (pagina 9) per 
attivare o disattivare la funzione ATW.
È possibile selezionare la velocità di regolazione 
(cinque livelli) con l’opzione White >ATW 
Speed (pagina 68) del menu Paint.
È possibile “congelare” il valore di bilanciamento 
del bianco corrente assegnando la funzione ATW 
Hold a un pulsante programmabile (pagina 45) e 
premendo tale pulsante per sospendere 
temporaneamente la modalità ATW.

Note

• La funzione ATW non è utilizzabile in modalità Cine 
EI.

• A seconda delle condizioni di illuminazione e del 
soggetto, la funzione ATW può non essere in grado di 
ottimizzare sempre il colore.
Esempi:
- Quando il soggetto è dominato da un unico colore, 

ad esempio cielo, mare, prati o fiori.
- Quando la temperatura di colore è estremamente 

alta o bassa.
Se non è possibile ottenere l’effetto opportuno 
perché la velocità di regolazione automatica ATW 
è insufficiente o per altri motivi, eseguire la 
funzione di bilanciamento automatico del bianco.

Regolazione manuale del bilanciamento 
del bianco

1 Disattivare la modalità Full Auto 
(pagina 37).

2 Quando il bilanciamento del bianco è 
impostato sulla modalità ATW, 
premere il pulsante WHT BAL 
(pagina 9) per impostare la modalità 
manuale.

Come ottenere colori naturali 
(bilanciamento del bianco)
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3 Selezionare B, A o PRESET con il 
selettore WHT BAL (pagina 9).

B: Modalità memoria B *
A: modalità memoria A
PRESET: modalità predefinita
* B può essere assegnato a ATW ON.

Modalità predefinita
Questa modalità regola la temperatura di colore 
su un valore preimpostato (valore predefinito: 
3200K).

Modalità memoria A / memoria B
Questa modalità imposta il bilanciamento del 
bianco sul valore salvato rispettivamente nella 
memoria A o B.

Nota

Le impostazioni del selettore WHT BAL in modalità 
Cine EI sono fissate come indicato di seguito.

B: 5500K
A: 4300K
PRESET: 3200K

Esecuzione del bilanciamento 
automatico del bianco

1 Premere il pulsante ISO/Gain 
(pagina 9) per attivare la funzione 
AGC.

Oppure, selezionare Auto Exposure 
(pagina 63) >AGC nel menu Camera e 
impostare su “On”.

2 Per salvare un valore di regolazione in 
memoria, selezionare la modalità 
memoria A o la modalità memoria B.

3 Collocare un foglio o un altro oggetto 
bianco in una posizione con la stessa 
sorgente di luce e le stesse condizioni di 
illuminazione del soggetto, quindi 
zoomare sul foglio fino a riempire lo 
schermo di bianco.

4 Regolare la luminosità.

Regolare il diaframma servendosi della 
procedura descritta in “Regolazione manuale 
del diaframma” (pagina 41).

5 Premere il pulsante WB SET (pagina 7).

Se il valore di bilanciamento automatico del 
bianco è impostato sulla modalità di 
memoria, il valore di regolazione viene 

salvato nella memoria A o B selezionata al 
punto 2.
Se il valore di bilanciamento automatico del 
bianco è impostato sulla modalità ATW, la 
regolazione del bilanciamento del bianco 
torna alla modalità di bilanciamento del 
bianco ATW al termine della regolazione.

Note

• Il bilanciamento automatico del bianco non può essere 
eseguito in modalità Cine EI.

• Se la regolazione non può essere eseguita 
correttamente, viene visualizzato un messaggio di 
errore sullo schermo per circa tre secondi. Se il 
messaggio di errore persiste anche dopo ripetuti 
tentativi di impostazione del bilanciamento del bianco, 
rivolgersi al servizio di assistenza tecnica Sony. 

È possibile specificare l’audio da registrare 
scegliendo opportunamente i connettori di 
ingresso e utilizzando i selettori e le manopole del 
camcorder.

Connettori e selettori di ingresso audio esterno
Connettore INPUT1 (pagina 10)
Connettore INPUT2 (pagina 10)
Selettore INPUT1 (LINE/MIC/MIC+48V) 
(pagina 7)
Selettore INPUT2 (LINE/MIC/MIC+48V) 
(pagina 7)

Selettori per l’impostazione del livello audio
Selettore CH1 LEVEL CONTROL (pagina 9)
Selettore CH2 LEVEL CONTROL (pagina 9)
Manopola CH1 INPUT LEVEL (pagina 9)
Manopola CH2 INPUT LEVEL (pagina 9)

Selezione del dispositivo di ingresso 
audio

1 Selezionare il connettore di ingresso 
audio

Selezionare l’ingresso audio mediante le voci 
Audio Input >CH1 Input Select o CH2 Input 
Select del menu Audio.
Impostare su INPUT1 o INPUT2 a seconda 
del connettore a cui è connesso il dispositivo. 
Se si utilizza un microfono con connessione 
a slitta o adattatore XLR, specificare Shoe 1 
o Shoe 2 in maniera analoga. Per 
informazioni dettagliate sull’adattatore XLR, 

Impostazione dell’audio da 
registrare



vedere “Aggiunta di connettori di ingresso 
audio” (pagina 51).

Nota

Il camcorder è dotato di un microfono interno. Pur 
non essendo adeguato per la produzione dell’audio 
finale, può essere utilizzato per la sincronizzazione 
con altre apparecchiature. In tal caso, specificare 
Internal MIC.

2 Selezionare la sorgente di ingresso 
audio

Impostare i selettori INPUT1/INPUT2 
(LINE/MIC/MIC+48V) in base ai dispositivi 
connessi rispettivamente ai connettori 
INPUT1/INPUT2.

• Se si seleziona “MIC+48V”, assicurarsi 
che il microfono connesso sia compatibile 
con una sorgente a +48 V per evitare di 
danneggiarlo. Controllare questa 
impostazione prima di procedere con il 
collegamento.

• In caso di problemi di rumore sui 
connettori ai quali non è connesso nessun 
dispositivo, impostare su “LINE” il 
selettore INPUT1/INPUT2 (LINE/MIC/
MIC+48V) corrispondente.

Regolazione automatica del livello di 
registrazione audio
Spostare i selettori CH1/CH2 LEVEL 
CONTROL dei canali da regolare 
automaticamente su “AUTO”.
Per CH3/CH4, impostare Audio Input > CH3 
Level Control e CH4 Level Control nel menu 
Audio su “Auto” (pagina 75).

Regolazione manuale del livello di 
registrazione audio
La seguente procedura consente di regolare il 
livello di registrazione audio per i canali CH1/
CH2.

1 Impostare i connettori CH1/CH2 
LEVEL CONTROL dei canali da 
regolare manualmente su “MAN”.

2 Durante la ripresa o lo standby, ruotare 
le manopole INPUT LEVEL (CH1)/
(CH2) per regolare il livello audio del 
canale corrispondente.

È possibile regolare il livello di registrazione 
tramite la manopola programmabile 
(pagina 45) (se precedentemente assegnata 
alla funzione Audio Input Level) oppure 
mediante il menu di configurazione.
Per CH3/CH4, impostare Audio Input > CH3 
Level Control e CH4 Level Control nel menu 
Audio su “Manual”, quindi impostare il 
livello di registrazione audio in CH3 Input 
Level e CH4 Input Level (pagina 75).

Note

• Quando Audio Input nel menu Audio è 
configurato con le impostazioni descritte di 
seguito, Audio Input Level verrà disabilitato in 
quanto non vi è alcuna destinazione per il livello 
di ingresso audio. Non sarà inoltre possibile 
neanche la regolazione del livello di 
registrazione audio tramite la manopola 
programmabile a cui è assegnato Audio Input 
Level.
- Quando CH1 Level e CH2 Level sono 

entrambi impostati su “Side”
- Quando CH3 Input Select è impostato su 

“Off” o CH3 Level è impostato su “CH3 
Input Level”

- Quando CH4 Input Select è impostato su 
“Off” o CH4 Level è impostato su “CH4 
Input Level”

• Se le voci Audio Input >CH1 Level o CH2 Level 
del menu Audio sono impostate su “Level + 
Side”, il valore di regolazione è il prodotto del 
valore impostato in Audio Input Level e il livello 
impostato con la manopola INPUT LEVEL. Se 
uno dei due livelli è impostato sul valore minimo, 
l’audio è disattivato. Se entrambi i livelli sono 
impostati al valore massimo, è selezionato il 
valore massimo.
Analogamente per CH3/CH4, se CH3 Level o 
CH4 Level sono impostati su “Level+CH3 Input 
Level” o “Level+CH4 Input Level”, la 
regolazione del livello di registrazione avverrà 
come descritto sopra.

Dispositivo collegato Posizione 
selettore

Sorgente audio esterna (ad 
es. mixer)

LINE

Microfono dinamico, 
microfono a batteria

MIC

Microfono con 
alimentazione phantom 
+48 V

MIC+48V
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• Se Audio Input >CH1 Input Select oppure CH2 
Input Select nel menu Audio sono impostati su 
“Internal MIC”, CH2 viene commutato su 
automatico/manuale seguendo il selettore CH1 
LEVEL CONTROL. Inoltre, il livello di 
registrazione audio di CH2 è impostato sulla 
base dell’impostazione della manopola CH1 
INPUT LEVEL (pagina 75).

Impostazione del codice temporale
Specificare il codice temporale da registrare con 
l’opzione Timecode (pagina 85) del menu TC/
UB.

Visualizzazione dei dati temporali
Premere il tasto DISPLAY per visualizzare i dati 
temporali sullo schermo (pagina 14).
Specificare il codice temporale da visualizzare 
mediante l’opzione TC Display (pagina 85) 
>Display Select del menu TC/UB.
Premendo un pulsante programmabile 
(pagina 45) a cui è assegnata la funzione 
DURATION/TC/U-BIT, è possibile visualizzare 
in sequenza il codice temporale, i bit utente e la 
durata.

Il camcorder è dotato di sei pulsanti 
programmabili (pagina 9, pagina 11) a cui 
possono essere assegnate varie funzioni.
È possibile assegnare funzioni anche alla 
manopola IRIS (pagina 9) del camcorder e alla 
manopola programmabile (pagina 11) del 
telecomando dell’impugnatura.

Modifica della funzione assegnata al 
pulsante
Utilizzare Assignable Button (pagina 93) nel 
menu System.
Le funzioni assegnate sono visualizzate nella 
schermata Assignable Button Status (pagina 16).

Funzioni predefinite assegnate ai vari pulsanti 
programmabili al momento dell’acquisto:

Funzioni assegnabili
• Off
• Marker
• Zebra
• Peaking
• Video Signal Monitor
• DURATION/TC/U-BIT
• Focus Magnifier x4/x8
• Focus Magnifier x4
• Focus Magnifier x8
• Push AF/Focus Hold
• VF Mode
• IRIS
• AGC
• SHUTTER
• Auto Exposure Level
• Push Auto Iris
• Push AGC
• Spotlight

Specifica dei dati temporali

Funzioni utili

Pulsanti e manopole 
programmabili

Pulsante 1 S&Q Motion
Pulsante 2 IRIS
Pulsante 3 User Menu
Pulsante 4 Focus Magnifier x4/x8
Pulsante 5 User Menu
Pulsante 6 Off
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• Backlight
• ATW
• ATW Hold
• SteadyShot
• Color Bars
• User Menu
• Rec Lamp
• S&Q Motion
• Picture Cache Rec
• Rec Review
• Thumbnail
• Shot Mark1
• Shot Mark2
• Clip Flag OK
• Clip Flag NG
• Clip Flag Keep
• High/Low Key

Modifica della funzione assegnata alla 
manopola
Utilizzare Assignable Dial (pagina 95) nel menu 
System.
Le funzioni assegnate sono visualizzate nella 
schermata Assignable Button Status (pagina 16).
La funzione IRIS è assegnata per impostazione 
predefinita.

Funzioni assegnabili
• Off
• IRIS
• ISO/GAIN/EI
• Focus
• Audio Input Level

Quando il formato video (pagina 91) è impostato 
su uno dei valori elencati di seguito, è possibile 
specificare valori diversi per le frequenze 
fotogrammi di registrazione e di riproduzione.

NTSC Area
XAVC-I
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 3840 × 2160 59.94P, 
3840 × 2160 29.97P, 3840 × 2160 23.98P, 
1920 × 1080 59.94P, 1920 × 1080 29.97P, 
1920 × 1080 23.98P
XAVC-L
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P, 1920 × 1080 59.94P 50, 
1920 × 1080 59.94P 35, 1920 × 1080 29.97P 
50, 1920 × 1080 29.97P 35, 1920 × 1080 
23.98P 50, 1920 × 1080 23.98P 35

PAL Area
XAVC-I
4096 × 2160 50P, 4096 × 2160 25P, 
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P, 1920 × 1080 25P
XAVC-L
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P 50, 1920 × 1080 50P 35, 
1920 × 1080 25P 50, 1920 × 1080 25P 35

Note

• La funzione Slow & Quick Motion non può essere 
impostata durante la registrazione, la riproduzione o 
mentre è visualizzata la schermata delle miniature.

• La modalità Slow & Quick Motion non consente la 
registrazione di audio.

• In modalità Quick & Slow Motion, la funzione di 
messa a fuoco automatica è disabilitata.

• Per la ripresa con frequenze fotogrammi superiore a 60 
fps si applicano le seguenti condizioni:
- Gli indicatori di assistenza alla messa a fuoco, 

profondità di campo, posizione di messa a fuoco, 
posizione diaframma e posizione di zoom non sono 
visibili.

Slow & Quick Motion
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NTSC Area

PAL Area

Mantenendo una memoria cache interna di una 
durata specificata durante le riprese, la funzione 
di registrazione cache immagine consente di 
catturare video “retroattivamente” all’avvio della 
registrazione e registrarlo sulle schede di 
memoria XQD. Il tempo di registrazione cache 
immagine viene impostato con la voce Picture 

Cache Rec >Cache Rec Time (pagina 86) nel menu 
Recording.

Formati di registrazione supportati

*1: XAVC-I 59.94P e 50P non supportati.

Note

• La funzione Picture Cache Rec non può essere attiva 
mentre sono attive le modalità Frame Rec, Interval Rec 
o Slow & Quick Motion. Quando viene attivata la 
funzione Picture Cache Rec, queste altre modalità di 
registrazione vengono disattivate automaticamente.

• Non è possibile selezionare la modalità Picture Cache 
Rec durante la registrazione o Rec Review.

• Mentre Picture Cache Rec è attiva, il codice temporale 
viene sempre registrato in modalità Free Run 
indipendentemente dall’impostazione nel menu TC/
UB. (pagina 85)

• Le funzioni Zebra e Peaking non possono essere 
utilizzate quando Picture Cache Rec è attiva (On).

Configurazione prima della ripresa
Configurare Picture Cache Rec (pagina 86) nel 
menu Recording prima della ripresa.
È possibile anche assegnare la funzione Picture 
Cache Rec a un pulsante programmabile 
(pagina 45) ed attivarla o disattivarla utilizzando 
tale pulsante.
Quando è configurata, l’indicatore z (verde) è 
visualizzato nel mirino (pagina 13).

Registrazione cache immagine
Quando viene premuto il pulsante di 
registrazione, la registrazione si avvia e il video 
viene registrato sulle schede di memoria XQD a 
partire dal video contenuto nella memoria cache.

Per annullare Picture Cache Rec
Disattivare Picture Cache Rec >Setting nel menu 
Recording, oppure premere il pulsante 
programmabile a cui è assegnata la funzione 
Picture Cache Rec.

Formato Risoluzione Fre-
quenza 
foto-
grammi

Valori di High 
Frame Rate

XAVC-I 2160 Da 1 a 
60 fps

Non supportato

(59.94P, 29.97P, 23.98P)

1080 Da 1 a 
60 fps

72/75/80/90/96/
100/110/120/125/
135/144/150/160/
168/175/180 fps

(59.94P, 29.97P, 23.98P)

XAVC-L 2160 Da 1 a 
60 fps

Non supportato

(59.94P, 29.97P, 23.98P)

1080 Da 1 a 
60 fps

72/75/80/90/96/
100/110/120 fps

(59.94P 50, 59.94P 35, 29.97P 
50, 29.97P 35, 23.98P 50, 
23.98P 35)

Formato Risoluzione Fre-
quenza 
foto-
grammi

Valori di High 
Frame Rate

XAVC-I 2160 Da 1 a 
60 fps

Non supportato

(59P, 25P)

1080 Da 1 a 
60 fps

72/75/80/90/96/
100/110/120/125/
135/144/150 fps

(59P, 25P)

XAVC-L 2160 Da 1 a 
60 fps

Non supportato

(59P, 25P)

1080 Da 1 a 
60 fps

72/75/80/90/96/
100/110/120 fps

(50P 50, 50P 35, 25P 50, 
25P 35)

Registrazione cache immagine 
(Picture Cache Rec)

Formato di 
registrazione

Risoluzione Tempo cache [s]

RAW 4096×2160
2048×1080

Non supportato

XAVC *1 3840×2160 Da 0 a 2

1920×1080 Da 0 a 2/da 2 a 4/da 
4 a 6/da 6 a 8

MPEG-2 1920×1080 Da 0 a 2/da 2 a 4/da 
4 a 6/da 6 a 8/da 8 a 
10/da 13 a 15

ProRes422 1920×1080 Non supportato
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Note

• Se si cambia il formato di registrazione, il video già 
esistente nella memoria cache viene eliminato e la 
memoria cache inizia a registrare nuovo video. Di 
conseguenza, non è possibile registrare le immagini 
presenti nella cache prima del cambiamento del 
formato anche se la registrazione viene avviata 
immediatamente dopo il cambiamento del formato.

• Se Picture Cache Rec viene attivata o disattivata 
immediatamente dopo l’inserimento di una scheda di 
memoria XQD è possibile che i dati della cache non 
vengano registrati sulla scheda.

• Il video viene memorizzato nella cache a partire dal 
momento in cui la funzione di registrazione cache è 
attivata. Prima dell’attivazione della funzione il video 
non viene memorizzato.

• Durante l’accesso a una scheda di memoria XQD, ad 
esempio durante riproduzione, Rec Review o 
visualizzazione delle miniature, nella memoria cache 
non viene memorizzato video. Durante tale periodo 
non è possibile registrare immagini di cache.

• È possibile modificare il tempo di registrazione della 
cache tramite il menu anche durante la registrazione, 
ma il nuovo valore entrerà in effetto solo al termine 
della registrazione corrente.

È possibile controllare il video dell’ultimo clip 
registrato sullo schermo.

Mentre la registrazione è arrestata, 
premere il pulsante programmabile 
(pagina 45) a cui è assegnata la funzione Rec 
Review.

Il clip viene riprodotto fino alla fine e il 
camcorder esce dalla funzione Rec Review e 
torna alla modalità di STBY (standby). 
Premere e mantenere premuto il pulsante per 
avviare la riproduzione nella direzione opposta. 
Rilasciando il pulsante, il clip viene riprodotto 
fino alla fine.

Per arrestare Rec Review
Premere il pulsante programmabile a cui è 
assegnata la funzione Rec Review.

Nota

La funzione Rec Review non è supportata se il formato 
video è stato modificato dopo la registrazione del clip.

È possibile ruotare l’immagine visualizzata nel 
mirino (pagina 11) verticalmente oppure 
orizzontalmente e verticalmente mediante il 
selettore MIRROR.
Questa funzione consente di ruotare il mirino di 
180° verso l’obiettivo.

OFF
L’immagine non è invertita.

Rivedere una registrazione (Rec 
Review)

Modalità autoritratto
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B/T
L’immagine è capovolta verticalmente.
La visualizzazione delle informazioni viene 
ruotata verticalmente ed orizzontalmente. 

ROT
L’immagine è capovolta verticalmente ed 
orizzontalmente.
Anche la visualizzazione delle informazioni 
viene capovolta verticalmente ed 
orizzontalmente.

Nota

Le viste B/T e ROT sono visualizzate solo nel mirino. Il 
video in uscita e il video registrato rimangono inalterati.

È possibile visualizzare o nascondere i dati di 
peaking premendo il pulsante PEAKING sul 
mirino (pagina 11).
Per attivare o disattivare il peaking ed impostarne 
il tipo e la frequenza, utilizzare la voce Peaking 
(pagina 81) del menu VF.

Nota

Non è utilizzabile quando Picture Cache Rec è attiva 
(On).

È possibile visualizzare o nascondere il motivo 
zebra premendo il pulsante ZEBRA sul mirino 
(pagina 11).
Per attivare o disattivare la visualizzazione del 
motivo zebra e impostarne il tipo e il livello di 
visualizzazione utilizzare la voce Zebra 
(pagina 81) del menu VF.

Nota

Non è utilizzabile quando Picture Cache Rec è attiva 
(On).

Visualizzazione del Peaking

Visualizzazione del motivo zebra
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Impostare GPS su “On” nel menu System.

Durante la ricerca dei satelliti GPS, il camcorder 
mostra l’icona . Una volta acquisito il 
posizionamento, le informazioni di posizione 
sono registrate con il video ripreso.

Note

• L’opzione GPS del menu System non può essere 
impostata su “On” quando la maniglia non è montata. 
Il ricevitore GPS si trova infatti all’interno della 
maniglia stessa.

• L’icona visualizzata nel mirino varia a seconda della 
qualità di ricezione del segnale proveniente dai satelliti 
GPS.

• Per impostazione predefinita, la funzione GPS è 
impostata su “On”. Mentre la funzione di 
posizionamento è attiva, il camcorder registra le 
informazioni di posizione, data e ora del video ripreso.

• Se tuttavia l’icona di posizionamento non appare entro 
alcuni minuti, è possibile che vi siano problemi con la 
ricezione del segnale. Avviare la ripresa senza 
informazioni di posizione o spostarsi in un luogo che 
permetta una visione del cielo senza impedimenti. Se 
l’icona di posizionamento non è visualizzata, le 

informazioni di posizione non saranno registrate con le 
riprese.

• Il segnale GPS può non essere ricevibile durante le 
riprese in interni o in prossimità di edifici di una certa 
altezza. Spostarsi in un luogo che permetta una visione 
del cielo senza impedimenti.

• A seconda dell’intensità del segnale ricevuto, la 
registrazione delle informazioni di posizione potrebbe 
interrompersi anche se l’icona di posizionamento 
rimane visualizzata.

Questa modalità imita il funzionamento di una 
macchina da presa cinematografica e presuppone 
lo “sviluppo” in post-produzione.

Limitazioni della modalità Cine EI
• Funzioni che non possono essere regolate 

automaticamente
- Bilanciamento del bianco
- Guadagno
- Shutter
- Iris
- Auto Exposure

• Funzioni che non possono essere configurate
- Guadagno
- Noise Suppression
- Impostazioni del menu Paint
- Scene File
- Lens File

Funzioni disponibili solo in modalità 
Cine EI
• Exposure Index
• Monitor LUT
• Registrazione di video RAW

È possibile registrare video RAW su un 
registratore AXS-R5 (opzione) convertendo il 
segnale in uscita dal connettore RAW OUT di 
un’unità di estensione XDCA-FS7 (opzione) 
connessa al camcorder tramite un’unità di 
interfaccia HXR-IFR5 (opzione) (pagina 33).

1 Configurare il registratore RAW 
esterno (pagina 33).

2 Impostare Base Setting >Shooting 
Mode nel menu System su Cine EI.

Acquisizione delle informazioni di 
posizione (GPS)

Stato di 
posiziona-
mento

Visualiz-
zazione

Stato della ricezione 
GPS

Off Nessuna 
visualizza-
zione 

GPS impostato su “Off” 
o si è verificato un errore.

Posiziona-
mento non 
disponibile

Non è possibile acquisire 
informazioni di 
posizione perché non è 
possibile ricevere il 
segnale GPS. Spostarsi 
in un luogo che permetta 
una visione del cielo 
senza impedimenti.

Ricerca di 
satelliti in 
corso

Ricerca dei satelliti GPS 
L’acquisizione dei 
satelliti può richiedere 
alcuni minuti.

Posiziona-
mento

Il segnale GPS ricevuto è 
molto debole.

Il segnale GPS ricevuto è 
adeguato. È possibile 
acquisire informazioni 
geografiche.

Il segnale GPS ricevuto è 
buono. È possibile 
acquisire informazioni di 
posizione.

Riprese in modalità Cine EI

Registrazione di video RAW
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3 Impostare Codec >Select nel menu 
System su RAW. 

Selezionando RAW & XAVC-I è possibile 
registrare contemporaneamente video RAW 
sul registratore RAW esterno e video HD sulle 
schede di memoria XQD del camcorder.

4 Impostare Rec Format nel menu 
System su RAW Output Format.

5 Controllare che il registratore esterno 
sia acceso, quindi premere il pulsante di 
registrazione del camcorder.

Di seguito si elencano i formati di uscita RAW.

NTSC Area

PAL Area

Indicazione dello stato di registrazione
Se Display On/Off (pagina 83) >HXR-IFR5 Rec 
Control del menu VF è impostato su “On”, lo 
stato della registrazione RAW è visualizzato nel 
mirino con un’icona.

Registrazione Slow & Quick Motion
Se S&Q Motion >Setting del menu Recording è 
impostata su “On”, il video RAW viene registrato 
in modalità Slow & Quick.
L’uscita RAW in Slow & Quick Motion è 
supportata solo per la risoluzione 2K a 120/240 
fps (NTSC) e 100/200 fps (PAL).

Nota

Il connettore RAW OUT del camcorder controlla la 
registrazione solo inviando un segnale Rec Control al 
registratore esterno. Per questa ragione, è possibile che il 
camcorder indichi che è in corso una registrazione RAW 
anche se il registratore esterno in realtà non sta 
registrando. Controllare l’effettivo stato operativo 
servendosi sempre dell’indicatore del registratore esterno.

È possibile collegare contemporaneamente al 
camcorder fino a quattro canali di dispositivi 
audio XLR utilizzando un adattatore XLR-K2M 
XLR (non in dotazione).
Montare l’adattatore XLR sulla slitta MI e, nel 
menu Audio, impostare Audio Input >CH3 Input 
Select su “Shoe 1” e CH4 Input Select su “Shoe 
2”.
Le funzioni del camcorder che si sovrappongono 
verranno disabilitate per i canali per i quali è 
selezionato come ingresso l’adattatore XLR. 
Eseguire le regolazioni necessarie servendosi dei 
pulsanti e delle manopole dell’adattatore XLR.

Note

• Se Audio Input >CH3 Level e CH4 Level nel menu 
Audio sono impostati su “Audio Input Level”, il valore 
di Audio Input Level del camcorder verrà regolato in 
modo da corrispondere al valore impostato 
sull’adattatore XLR. Audio Input Level viene abilitato 
anche quando il selettore dell’adattatore XLR è 
impostato su AUTO. Se è specificato “Through”, 
l’audio verrà registrato al livello impostato con 
l’adattatore XLR.

• È possibile impostare anche su CH1 e CH2 montando 
un adattatore XLR e impostando Audio Input >CH1 
Input Select e CH2 Input Select nel menu Audio 
rispettivamente su “Shoe 1” e “Shoe 2”. Tuttavia, se si 
assegna l’ingresso dall’adattatore XLR a entrambi i 
canali CH1 e CH2, non sarà possibile assegnare a tali 
canali l’ingresso dai connettori INPUT1/INPUT2 del 
camcorder.

Impostazione 
Codec >Select

Formati di uscita RAW

RAW / RAW & 
XAVC-I / RAW &
XAVC-L / RAW &
MPEG HD422

4096 × 2160 59.94P
4096 × 2160 29.97P
4096 × 2160 23.98P
2048 × 1080 59.94P
2048 × 1080 29.97P
2048 × 1080 23.98P

Impostazione 
Codec >Select

Formati di uscita RAW

RAW / RAW &
XAVC-I / RAW &
XAVC-L / RAW &
MPEG HD422

4096 × 2160 50P
4096 × 2160 25P
2048 × 1080 50P
2048 × 1080 25P

Aggiunta di connettori di ingresso 
audio
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Montando il modulo LAN wireless USB IFU-
WLM3 (fornito) oppure un adattatore wireless 
CBK-WA100 (opzione), il camcorder è in grado 
di connettersi a smartphone, tablet e altri 
dispositivi mediante una connessione LAN 
wireless.

Nota

Non è supportato l’utilizzo di moduli wireless USB 
diversi dal modello IFU-WLM3.

I dispositivi connessi tramite una rete LAN wireless 
consentono di eseguire le funzioni elencate di seguito.
• Telecomando

Consente il comando a distanza del 
camcorder.

• Monitoraggio video (solo con adattatore CBK-
WA100)

Consente il monitoraggio del video del 
camcorder.
È necessario utilizzare l’adattatore CBK-
WA100 (opzione) e l’applicazione Content 
Browser Mobile.

Per informazioni dettagliate sull’applicazione 
Content Browser Mobile rivolgersi al proprio 
rappresentante commerciale o di assistenza tecnica 
Sony.

Dispositivi compatibili
È possibile utilizzare smartphone, tablet o 
computer per configurare e azionare il camcorder. 
La seguente tabella indica i dispositivi, i sistemi 
operativi e i browser supportati.

Inserire il modulo LAN wireless USB IFU-
WML3 nell’apposito connettore (pagina 7).
Dopo averlo montato, impostare Wi-Fi >Wi-Fi 
(pagina 96) nel menu System su “Enable” per 
abilitare la LAN wireless.

Nota

Connettere e disconnettere il modulo IFU-WLM3 solo 
mentre il camcorder è spento.

Nota

Connettere e disconnettere l’adattatore CBK-WA100 
solo mentre il camcorder è spento.

1 Montare l’adattatore CBK-WA100 
sulla staffa di montaggio e stringere le 
due viti.

Connessione a 
dispositivi esterni 
tramite una LAN 
wireless

Dispositivo Sistema operativo Browser
Smartphone Android 4.3 Chrome

iOS7 Safari

Tablet Android 4.3 Chrome

iOS7 Safari

Computer Microsoft Windows 7/
Microsoft Windows 8.1

Chrome

Mac OS 10.8/10.9 Safari

Collegamento del modulo IFU-
WLM3

Montaggio dell’adattatore CBK-
WA100
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2 Montare la staffa di montaggio 
dell’adattatore CBK-WA100 sul 
camcorder e stringere le viti.

3 Collegare il cavo USB dell’adattatore 
CBK-WA100 al connettore del modulo 
LAN wireless USB (1) e il cavo SDI al 
connettore SDI OUT (2).

4 Accendere l’adattatore CBK-WA100 e 
quindi accendere il camcorder.

5 Dopo aver eseguito le connessioni, 
abilitare la funzione LAN wireless 
impostando Wi-Fi >Wi-Fi (pagina 96) 
nel menu System su Enable.

Nota

Per poter utilizzare l’adattatore CBK-WA100 con il 
camcorder è necessario configurare opportunamente le 
impostazioni di uscita SDI OUT. Tuttavia, il camcorder 
non può emettere un segnale compatibile con l’adattatore 
CBK-WA100 quando si utilizza ProRes 23.98P 
(pagina 78).

Informazioni sull’adattatore CBK-WA100
L’adattatore CBK-WA100 è dotato di funzioni 
per la registrazione di file proxy a bassa 
risoluzione su una scheda SD e per il 
trasferimento dei file a un server tramite una rete 
LAN wireless. Per ulteriori informazioni, 
consultare le istruzioni per l’uso fornite con 
l’adattatore CBK-WA100.

I dispositivi che supportano la funzione NFC 
possono essere collegati tramite tale funzione 
(connessione “One-Touch”).

1 Montare un modulo IFU-WLM3 sul 
camcorder (pagina 52) ed impostare 
Wi-Fi >Wi-Fi (pagina 96) nel menu 
System su “Enable” per abilitare la 
funzione LAN wireless.

 appare sullo schermo.

Connessione “One-Touch” dei 
dispositivi NFC (solo con modulo 
IFU-WLM3)
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2 Aprire “Settings” sul dispositivo, 
selezionare “More” e contrassegnare 
con un segno di spunta la casella di 
controllo NFC.

Le opzioni di impostazione disponibili 
variano a seconda del dispositivo. Per 
informazioni dettagliate, fare riferimento al 
manuale di istruzioni del dispositivo.

3 Toccare il camcorder con il dispositivo.

Il dispositivo si connette al camcorder, apre 
un browser Web e visualizza il telecomando 
Wi-Fi. Alla prima connessione del 
dispositivo è necessario eseguire la 
procedura di autenticazione.

Note

• La funzione NFC è supportata da alcuni dispositivi 
muniti del marchio . Per ulteriori informazioni, 
consultare il manuale operativo del dispositivo.

• Disabilitare in anticipo le modalità sleep e di blocco 
schermo.

• Toccare e mantenere fermo il dispositivo fino a quando 
non si avvia l’applicazione “Content Browser Mobile” 
(1 o 2 secondi).

La schermata dell’applicazione di telecomando 
Wi-Fi Remote viene automaticamente 
ridimensionata a seconda delle dimensioni dello 
schermo del dispositivo collegato.

1 Collegare il camcorder e il dispositivo 
tramite una connessione LAN wireless 
(pagina 53).

2 Avviare un browser sul dispositivo ed 
immettere “http://<indirizzo IP del 
camcorder (Wi-Fi >IP Address nel menu 
System>/rm.html” nella barra dell’URL.

Ad esempio, se l’indirizzo IP è 192.168.1.1, 
immettere “http://192.168.1.1/rm.html” nella 
barra dell’URL.

3 Immettere nome utente e password 
(Basic Authentication >User Name e 
Password nel menu System).

Quando la connessione è stabilita, la schermata 
di Wi-Fi Remote apparirà sul dispositivo.
Azionare il camcorder dalla schermata di Wi-
Fi Remote.
È possibile disabilitare il pulsante di 
registrazione spostando il selettore Lock 
verso destra.

Note

• Se si utilizza uno smartphone, visualizzare la pagina 
sostituendo “rm.html” con “rms.html” nell’URL. Se si 
utilizza un tablet, visualizzare la pagina sostituendo 
“rm.html” con “rmt.html” nell’URL. Se si immette 
“rm.html” la pagina dovrebbe cambiare 
automaticamente in base al dispositivo connesso. 
Ciononostante, è possibile che in certi dispositivi non 
venga visualizzata la pagina corretta.

• Nelle circostanze elencate di seguito, è possibile che la 
schermata di Wi-Fi Remote non corrisponda alle 
impostazioni del camcorder. In tal caso, ricaricare la 
finestra del browser.
- Se il camcorder viene riavviato mentre è connesso.
- Se il camcorder viene azionato direttamente mentre 

è connesso.
- Se il dispositivo si è riconnesso.
- Se sono stati utilizzati i pulsanti avanti/indietro del 

browser.
• La funzione di telecomando Wi-Fi Remote potrebbe 

non funzionare correttamente se l’intensità del segnale 
wireless è insufficiente.

Visualizzazione del 
telecomando Wi-Fi 
Remote
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La schermata delle miniature viene visualizzata premendo il pulsante THUMBNAIL (pagina 9). Questa 
schermata mostra miniature (immagini di indice) dei clip contenuti nelle schede di memoria XQD.
La schermata delle miniature consente di selezionare un clip e avviarne la riproduzione. La riproduzione 
può essere visualizzata nel mirino e su un monitor esterno.
Premere di nuovo il pulsante THUMBNAIL per chiudere la schermata delle miniature e tornare 
all’immagine della videocamera.

Note

• La schermata delle miniature mostra solo i clip registrati nel formato di registrazione correntemente selezionato. Se un 
clip registrato che avrebbe dovuto essere presente non è visualizzato, controllare il formato di registrazione. Prestare 
attenzione a questo fatto prima di procedere con la formattazione (inizializzazione) dei supporti di memoria.

• Quando l’opzione Codec >Select del menu System è impostata su uno dei valori seguenti, non sarà possibile avviare 
la registrazione durante la riproduzione o mentre è visualizzata la schermata delle miniature. 
RAW & XAVC-I, RAW & XAVC-L, RAW & MPEG HD422

Nella parte inferiore dello schermo vengono visualizzate le informazioni relative al clip su cui è 
posizionato il cursore.

1. Miniatura (immagine indice)
Visualizza l’immagine indice del clip. Quando 
si registra un clip, il primo fotogramma viene 
impostato automaticamente come immagine 
indice.
Sotto la miniatura vengono visualizzate 
informazioni sul clip e sul fotogramma. È 
possibile scegliere le informazioni visualizzate 

con la voce Customize View (pagina 87) 
>Thumbnail Caption del menu Thumbnail.

2. Nome del clip
Visualizza il nome del clip selezionato.

3. Formato di registrazione video
Visualizza il formato del file del clip 
selezionato.

Schermata delle miniature

Schermata delle miniature

Elementi dello schermo

Numero del clip/Numero dei clip

Cursore 
(giallo)

Indicatore della scheda di memoria XQD correntemente selezionata
(se la scheda è protetta, viene visualizzata l’icona del lucchetto).
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4. Informazioni sulla registrazione speciale
Se il clip è stato registrato con una modalità di 
registrazione speciale, ne indica la modalità.
Se il clip è registrato in modalità Slow & Quick 
Motion, ne viene indicata la frequenza 
fotogrammi sulla destra.

5. Durata del clip

6. Data di creazione
È possibile riprodurre i clip registrati mentre il 
camcorder si trova in modalità standby (Stby) di 
registrazione.

1 Inserire la scheda di memoria XQD da 
riprodurre.

2 Premere il pulsante THUMBNAIL.

3 Ruotando la manopola SEL/SET 
(pagina 9), spostare il cursore sul clip da 
riprodurre.

4 Premere la manopola SEL/SET.
La riproduzione si avvia dall’inizio del clip 
selezionato.

È possibile comandare la riproduzione con i 
seguenti pulsanti:
Manopola SEL/SET:

Mette in pausa la riproduzione 
Premere una seconda volta per tornare alla 
riproduzione normale.

Pressione dei pulsanti sinistro/destro:
Salta all’inizio del clip corrente o all’inizio 
del clip successivo.

Pressione continua dei pulsanti sinistro/
destro:

Ritorno e avanzamento veloce. 
Torna alla riproduzione normale quando si 
rilascia il pulsante.

Pulsante CANCEL/BACK:
Arresta la riproduzione e torna alla modalità 
standby di registrazione.

Note

• Nel passaggio da un clip a un altro la visualizzazione 
dell’immagine potrebbe momentaneamente 
frazionarsi o arrestarsi. Durante questo periodo non è 
possibile azionare il camcorder.

• Quando si seleziona un clip nella schermata delle 
miniature e ha inizio la riproduzione, potrebbero 
verificarsi temporanei frazionamenti dell’immagine 
all’inizio del clip. Per visualizzare l’inizio del clip 
senza frazionamenti, avviare la modalità di 
riproduzione, mettere in pausa, quindi utilizzare il 
pulsante sinistro della manopola SEL/SET per tornare 
all’inizio del clip e riavviare la riproduzione.

• È possibile comandare la riproduzione anche con il 
telecomando fornito in dotazione.

Riproduzione di clip

Riproduzione dei clip registrati



Nella schermata delle miniature è possibile 
eseguire operazioni di gestione dei clip e 
controllarne le proprietà tramite il menu delle 
miniature.
Il menu delle miniature (pagina 87) viene 
visualizzato quando si preme il pulsante MENU e 
si seleziona una miniatura.

Ruotare la manopola SEL/SET (pagina 9) per 
selezionare una funzione, quindi premere la 
manopola SEL/SET.
Premere il pulsante CANCEL/BACK (pagina 9) 
per ritornare alla schermata precedente.

Nota

A seconda dello stato operativo del camcorder quando 
viene visualizzato il menu, alcune voci potrebbero non 
essere selezionabili.

Display Clip Properties
Set Index Picture
Thumbnail View
Set Shot Mark
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Filter Clips
Customize View
Per informazioni dettagliate sull’utilizzo del 
menu delle miniature, vedere “Menu 
Thumbnail” (pagina  87).

Displaying clip properties
Selezionare Display Clip Properties (pagina 87) 
nel menu Thumbnail per visualizzare la 
schermata delle proprietà dei clip.

Visualizzazione della schermata delle 
miniature con indicatori di 
identificazione. 
Selezionare Thumbnail View (pagina 87) 
>Essence Mark Thumbnail nel menu Thumbnail, 
quindi selezionare il tipo di indicatore di 
identificazione (Essence Mark) desiderato per 
visualizzare le miniature dei fotogrammi che lo 
contengono.

Visualizzazione della schermata delle 
miniature filtrata
Selezionare Filter Clips (pagina 87) nel menu 
Thumbnail, quindi selezionare il tipo di flag dei 
clip desiderato per visualizzare solo i clip che lo 
contengono.
Per visualizzare tutti i clip, impostare Thumbnail 
View >Essence Mark Thumbnail nel menu 
Thumbnail su All.

Eliminazione di clip
È possibile eliminare clip dalle schede di 
memoria XQD.
Selezionare Delete Clip >Select Clip o All Clips 
nel menu Thumbnail.
Select Clip:

Elimina il clip selezionato. È possibile 
selezionare più clip contemporaneamente.

All Clips:
Elimina tutti i clip visualizzati.

Scelta delle informazioni visualizzate 
nella schermata delle miniature
È possibile scegliere le informazioni sui clip o sui 
fotogrammi visualizzate sotto la miniatura.
Selezionare Customize View >Thumbnail 
Caption nel menu Thumbnail, quindi selezionare 
le informazioni da visualizzare.
Date Time:

Visualizza la data e l’ora di creazione e 
dell’ultima modifica del clip.

Time Code:
Visualizza il codice temporale.

Duration:
Visualizza la durata del clip.

Sequential Number:
Visualizza un numero sequenziale su ogni 
miniatura.

Operazioni con i clip

Utilizzo del menu delle miniature

Voci del menu delle miniature
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Premere il pulsante MENU per visualizzare nel 
mirino il menu di configurazione in cui 
specificare le opzioni necessarie per la ripresa, la 
registrazione e la riproduzione (il menu può 
essere visualizzato anche su un monitor esterno). 
Il menu di configurazione comprende i menu 
elencati di seguito:
Menu User:

Contiene voci di menu configurate 
dall’utente tramite il menu Edit User.

Menu Edit User:
Contiene comandi per la modifica del menu 
User.

Menu Camera:
Contiene opzioni relative alla ripresa.

Menu Paint:
Contiene opzioni relative alla qualità 
dell’immagine.

Menu Audio:
Contiene opzioni relative all’audio.

Menu Video:
Contiene opzioni relative all’uscita video.

Menu VF:
Contiene opzioni relative alla 
visualizzazione sul mirino.

Menu TC/UB:
Contiene opzioni relative al codice temporale 
e ai bit utente.

Menu Recording:
Contiene opzioni relative alla registrazione.

Menu Thumbnail:
Contiene opzioni relative alla 
visualizzazione delle miniature.

Menu Media:
Contiene opzioni relative ai supporti di 
memorizzazione.

Menu File:
Contiene opzioni relative ai file.

Menu System:
Contiene opzioni relative al sistema.

Menu visualizzati e impostazioni

Struttura del menu di configurazione

Struttura del menu di 
configurazione

User
(Impostazioni di 
fabbrica)

Country

Base Setting

Rec Format

Codec

S&Q Motion

Picture Cache Rec

Simul Rec

Output Format

Monitor LUT

Clip

VF Setting

Assignable Button

Assignable Dial

Format Media

Edit User Menu

Edit User Add Item

Customize Reset

Camera ISO/Gain/EI

Auto Exposure

Focus

Shutter

Color Bars

Noise Suppression

Flicker Reduce

SteadyShot

Handle Zoom

Auto Black Balance

AF Micro Adjustment

Video Light Set

Paint White

Offset White

Black

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Skin Detail

Aperture

Matrix 

Multi Matrix 

Maintenance
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Audio Audio Input

Audio Output

Video Output On/Off

Output Format

Output Setting

Monitor LUT

Output Display

VF VF Setting

Peaking

Zebra

Marker

Display On/Off

TC/UB Timecode

TC Display

User Bits

HDMI TC Out

Recording S&Q Motion

Picture Cache Rec

Simul Rec

SDI/HDMI Rec Control

Thumbnail Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

Media Update Media

Format Media

Clip

File All File

Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File

System Base Setting

Codec

Rec Format

Genlock 

Assignable Button

Assignable Dial

Rec Lamp

Fan Control 

HOLD Switch Setting

Lens

Language

Clock Set

Country

Hours Meter

Basic Authentication

Wi-Fi 

GPS

IR Remote

Camera Battery Alarm

Camera DC IN Alarm

Ext. Unit Battery Alarm

Ext. Unit DC IN Alarm

All Reset

APR

Camera Config

Version
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Premere il pulsante MENU per visualizzare nel 
mirino il menu di configurazione in cui 
specificare le opzioni necessarie per la ripresa, la 
registrazione e la riproduzione (il menu può 
essere visualizzato anche su un monitor esterno).

Comandi del menu

Pulsante MENU (pagina 9)
Attiva o disattiva la modalità per utilizzare il 
menu di configurazione.

Pulsante sinistro / Pulsante destro (pagina 9) e 
manopola SEL/SET (pagina 9)
Premere il pulsante sinistro o destro per spostare 
il cursore verso sinistra o destra e selezionare voci 
o impostazioni del menu.
Ruotare la manopola SEL/SET per spostare il 
cursore verso l’alto o il basso e selezionare voci o 
impostazioni del menu.
Premere la manopola SEL/SET per applicare la 
voce selezionata.

Pulsante CANCEL/BACK (pagina 9)
Annulla un’impostazione prima della sua 
applicazione e si sposta sul livello precedente 
della struttura dei menu.

Nota

Il menu di configurazione non può essere utilizzato 
quando il camcorder si trova in modalità di 
ingrandimento della messa a fuoco (pagina 39).

Impostazione delle voci dei menu
Ruotare la manopola SEL/SET per spostare il 
cursore sulla voce di menu da impostare, quindi 
premere la manopola per selezionare la voce.
• Nell’area di selezione delle voci del menu 

vengono visualizzate un massimo di otto righe. 
Se non possono essere visualizzate 
contemporaneamente tutte le opzioni 
disponibili per una determinata voce, scorrere le 
opzioni spostando il cursore verso l’alto o verso 
il basso.

• Se una voce prevede una vasta gamma di 
opzioni disponibili (esempio: da –99 a +99), 
l’area di selezione non viene visualizzata. Viene 

invece evidenziato il valore corrente per 
indicare che tale valore può essere modificato.

• Per eseguire una funzione, selezionare 
[Execute].

• Se si seleziona una voce che richiede conferma 
prima dell’esecuzione, il menu verrà 
momentaneamente nascosto e verrà 
visualizzato un messaggio di conferma. 
Controllare il messaggio e quindi scegliere se 
eseguire o annullare la funzione.

Immissione di una stringa di caratteri
Quando si seleziona una voce che richiede 
l’immissione di caratteri, viene visualizzata la 
schermata di inserimento caratteri.

1 Ruotare la manopola SEL/SET per 
selezionare il set di caratteri desiderato, 
quindi premere la manopola. 

ABC: caratteri alfabetici maiuscoli
abc: caratteri alfabetici minuscoli
123: caratteri numerici
!#$: caratteri speciali

2 Selezionare il carattere desiderato nel 
set specificato, quindi premere la 
manopola.

Il cursore si sposta sul campo successivo.
Space: inserisce uno spazio nella posizione 
del cursore
T/t : sposta la posizione del cursore.
BS: elimina il carattere alla sinistra del 
cursore

3 Al termine, selezionare [Done] e 
premere la manopola.

La stringa di caratteri viene confermata e la 
schermata di inserimento dei caratteri si 
chiude.

Utilizzo del menu di 
configurazione
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Questa sezione descrive le funzioni e le impostazioni delle voci di ogni menu.
Le impostazioni predefinite sono indicate in grassetto (ad esempio, 18dB ).

Elenco delle voci del menu di configurazione

Menu User

User

Voce Impostazione della voce 
secondaria

Descrizione

Country
Impostazioni regionali

Vedere Country nel menu System.

Base Setting
Impostazioni di base

Vedere Base Setting nel menu 
System.

Rec Format
Impostazioni del formato di 
registrazione

Vedere Rec Format nel menu 
System.

Codec
Impostazioni codec

Vedere Codec nel menu System.

S&Q Motion
Impostazioni della modalità Slow 
& Quick Motion

Vedere S&Q Motion nel menu 
Recording.

Picture Cache Rec
Impostazioni della modalità di 
registrazione cache immagine

Vedere Picture Cache Rec nel 
menu Recording.

Simul Rec
Impostazioni della registrazione 
simultanea

Vedere Simul Rec nel menu 
Recording.

Output Format
Impostazioni del formato di uscita

Vedere Output Format nel menu 
Video.

Monitor LUT
Impostazioni del LUT monitor.

Vedere Monitor LUT nel menu 
Video.

Clip
Impostazioni relative al nome dei 
clip 

Vedere Clip nel menu Media.

VF Setting
Impostazioni del mirino

Vedere VF Setting nel menu VF.

Assignable Button
Impostazioni per l’assegnazione 
di funzioni ai pulsanti 
programmabili

Vedere Assignable Button nel 
menu System.

Assignable Dial
Impostazioni per l’assegnazione 
di funzioni alle manopole 
programmabili

Vedere Assignable Dial nel menu 
System.

Format Media
Formatta (inizializza) schede di 
memoria

Vedere Format Media nel menu 
Media.
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Quando si seleziona “Edit User Menu”, il menu Edit User viene visualizzato al livello più alto.

Edit User Menu
Modifica le voci del menu User

Consente di modificare le voci del menu User.
Quando si seleziona “Edit User Menu”, il 
menu Edit User passa al livello più alto e 
vengono visualizzate tutte le voci di menu.

User

Voce Impostazione della voce 
secondaria

Descrizione

Menu Edit User

Edit User

Voce Impostazione della voce 
secondaria

Descrizione

Add Item
Aggiunge una voce al menu User

Aggiunge una voce al menu User.

Customize Reset
Ripristina le voci del menu User.

Ripristina l’impostazione predefinita delle voci 
del menu User.

Voce di menu selezionata durante 
la modifica

Delete Rimuove dal menu User la voce di menu registrata.

Move Cambia l’ordine delle voci registrate del menu 
User.

Edit Sub Item Elimina le voci secondarie registrate nel menu 
User.

Menu Camera

Camera

Voce Impostazione della voce 
secondaria

Descrizione

ISO/Gain/EI
Impostazioni di 
guadagno

Mode
ISO/dB

Seleziona la modalità di impostazione del guadagno.

ISO/Gain<H>
Quando Mode è impostato su ISO 
e la gamma dinamica è 460%.

ISO 800 / ISO 1000 / 
ISO 1250 / ISO 1600 / 
ISO 2000 / ISO 2500 / 
ISO 3200 / ISO 4000 / 
ISO 5000 / ISO 6400 

Quando Mode è impostato su ISO 
e la gamma dinamica è 800%.

ISO 1600 / ISO 2000 /
ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 /
ISO 6400 / ISO 8000 /
ISO 10000 / ISO 12500

Imposta il valore predefinito del guadagno <H>.
Quando Mode è impostato su ISO e la gamma dinamica è 
1300% (Gamma Category impostata su S-Log2 o S-Log3).

ISO 2000 / ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 / ISO 6400 /
ISO 8000 / ISO 10000 / ISO 12500 /
ISO 16000

Quando Mode è impostato su dB.
–3dB / 0dB / 3dB / 6dB /
9dB / 12dB / 18dB

La gamma dinamica è determinata dalla gamma.

Gamma Gamma dinamica
STD / HG1 / HG2 / HG3 / HG4 460%

HG7 / HG8 / User 800%

S-Log2 / S-Log3 1300%
62



ISO/Gain<M>
(Stesse impostazioni di ISO/
Gain<H>)

Imposta il valore predefinito del guadagno <M>.
Di seguito si indicano i valori predefiniti.
Quando Mode è impostato su ISO e la gamma dinamica è 460%.

ISO1600
Quando Mode è impostato su ISO e la gamma dinamica è 800%.

ISO3200
Quando Mode è impostato su ISO e la gamma dinamica è 
1300% (Gamma Category impostata su S-Log2 o S-Log3).

ISO4000
Quando Mode è impostato su dB.

6dB

ISO/Gain<L>
(Stesse impostazioni di ISO/
Gain<H>)

Imposta il valore predefinito del guadagno <L>.
Di seguito si indicano i valori predefiniti.
Quando Mode è impostato su ISO e la gamma dinamica è 460%.

ISO800
Quando Mode è impostato su ISO e la gamma dinamica è 800%.

ISO1600
Quando Mode è impostato su ISO e la gamma dinamica è 
1300% (Gamma Category impostata su S-Log2 o S-Log3).

ISO2000
Quando Mode è impostato su dB.

0dB

Exposure Index<H>
500EI / 4.0E
640EI / 4.3E
800EI / 4.7E
1000EI / 5.0E
1250EI / 5.3E
1600EI / 5.7E
2000EI / 6.0E
2500EI / 6.3E
3200EI / 6.7E
4000EI / 7.0E
5000EI / 7.3E
6400EI / 7.7E
8000EI / 8.0E

Imposta il valore predefinito dell’indice di esposizione <H>.
Disponibile solo in modalità Cine EI.

Exposure Index<M>
(Stesse impostazioni di 
Exposure Index<H>)

Imposta il valore predefinito dell’indice di esposizione <M>.
Il valore predefinito è 1600EI / 5.7E

Exposure Index<L>
(Stesse impostazioni di 
Exposure Index<H>)

Imposta il valore predefinito dell’indice di esposizione <L>.
Il valore predefinito è 800EI / 4.7E

Shockless Gain
On / Off

Attiva o disattiva la funzione di guadagno fluido.

Auto Exposure
Impostazioni per 
la correzione 
automatica 
dell’esposizione 

Level
–2.0 / –1.75 / –1.5 / –1.25 / 
–1.0 / –0.75 / –0.5 / –0.25 / 0 / 
+0.25 / +0.5 / +0.75 / +1.0 / 
+1.25 / +1.5 / +1.75 / +2.0

Imposta i livelli di luminosità per il valore di esposizione 
rilevato automaticamente.

Camera

Voce Impostazione della voce 
secondaria

Descrizione
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Mode
Backlight / Standard / 
Spotlight

Imposta la modalità di controllo.
Backlight:

Modalità controluce (i soggetti ripresi in controluce 
appaiono meno scuri)

Standard:
Modalità standard

Spotlight:
Modalità riflettore (limita il clipping dei bianchi quando il 
soggetto è illuminato da riflettori)

Speed
Da –99 a +99 (±0)

Imposta la velocità di regolazione.

AGC
On / Off

Attiva o disattiva la funzione AGC (controllo del guadagno 
automatico).

AGC Limit
Quando ISO/Gain/EI >Mode è 
impostato su dB.

3dB / 6dB / 9dB / 12dB / 
15dB / 18dB

Quando ISO/Gain/EI >Mode è 
impostato su ISO e la gamma 
dinamica è 460%.

ISO1000 / ISO1600 / ISO2000 / 
ISO3200 / ISO4000 / ISO6400

Quando ISO/Gain/EI >Mode è 
impostato su ISO e la gamma 
dinamica è 800%.

ISO2000 / ISO3200 / ISO4000 / 
ISO6400 / ISO8000 / 
ISO12500

Quando ISO/Gain/EI >Mode è 
impostato su ISO e la gamma 
dinamica è 1300%.

ISO2500 / ISO4000 / ISO5000 / 
ISO8000 / ISO10000 / 
ISO16000

Imposta il guadagno massimo della funzione AGC.

Auto Shutter
On / Off

Attiva o disattiva la funzione di otturatore automatico.

A.SHT Limit
1/100 / 1/150 / 1/200 / 
1/250 / 1/2000

Imposta la velocità massima della funzione di otturatore 
automatico.

Clip High light
On / Off

Attiva o disattiva la funzione che ignora le zone più luminose 
per dare una reazione più piatta alle luminanze elevate.

Detect Window
1 / 2 / 3 / 4 / 5 / 6

Imposta la gamma di misura della luce per la regolazione 
automatica della luce secondo la luminosità del soggetto. 
(Non disponibile quando l’esposizione viene regolata 
manualmente)

Detect Window Indication
On / Off

Attiva o disattiva la funzione Detect Window.

Camera

Voce Impostazione della voce 
secondaria

Descrizione
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Focus
Impostazioni di 
messa a fuoco

AF Assist
On / Off

Quando è impostato su On, consente di ignorare 
momentaneamente la funzione di messa a fuoco automatica ed 
eseguire la messa a fuoco manualmente.

Shutter
Impostazione delle 
condizioni di 
funzionamento 
dell’otturatore 
elettronico

Mode
Speed / Angle / ECS / Off

Seleziona la modalità operativa dell’otturatore elettronico.
Speed/Angle (modalità standard):

Consente di eseguire riprese nitide di soggetti in rapido 
movimento. Seleziona la modalità di impostazione della 
velocità dell’otturatore in secondi (Speed) o in gradi 
(Angle).

ECS (Extended Clear Scan)
Consente la ripresa senza visualizzare barre orizzontali in 
movimento nel mirino.

Shutter Speed
Da 1/3 a 1/9000

Imposta la velocità dell’otturatore quando Mode è impostato 
su Speed. I valori disponibili variano a seconda della 
frequenza fotogrammi del formato video selezionato.
59.94P/59.94i:

1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250, 
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000, 
1/4000, 1/6000, 1/9000

50P/50i:
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 1/120, 1/150, 1/215, 
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500, 
1/3500, 1/6000, 1/9000

29.97P:
1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250, 
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000, 
1/4000, 1/6000, 1/9000

25P:
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 1/120, 1/150, 1/215, 
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500, 
1/3500, 1/6000, 1/9000

23.98P:
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100, 
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200, 
1/2400, 1/4800, 1/9000

Shutter Angle
5.625° / 11.25° / 22.5° / 45° / 
90° / 120° / 144° / 150° / 
172.8° / 180° / 216° / 300°

Imposta l’angolo dell’otturatore quando Mode è impostato su 
Angle.

ECS Frequency
Da 23,99 a 8000 (60)

Imposta la frequenza ECS quando Mode è impostato su ECS. 
I valori disponibili variano a seconda della frequenza 
fotogrammi del formato video selezionato.

Color Bars
Impostazioni della 
barra colori

Setting
On / Off

Attiva o disattiva la barra colori.

Nota

Questa opzione non può essere impostata su On quando è 
configurata la registrazione di video RAW.

Type
ARIB / SMPTE / 75% / 100%

Seleziona il tipo di barra colori.

Camera

Voce Impostazione della voce 
secondaria

Descrizione
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Noise 
Suppression
Impostazioni della 
funzione di 
soppressione del 
rumore

Setting
On / Off

Attiva o disattiva la soppressione del rumore.
(Abilitato quando Base Setting >Shooting Mode nel menu 
System è impostato su Custom)

Level
Low / Mid / High

Imposta il livello di soppressione del rumore.

Flicker Reduce
Impostazioni di 
correzione dello 
sfarfallio

Mode
Auto / On / Off

Imposta la modalità di correzione dello sfarfallio.

Frequency
50Hz / 60Hz

Consente di specificare la frequenza della sorgente di 
alimentazione del dispositivo di illuminazione che causa lo 
sfarfallio.

SteadyShot
Impostazioni della 
funzione di 
stabilizzazione 
dell’immagine

Setting
Active SteadyShot / 
SteadyShot / Off

Attiva o disattiva la funzione di stabilizzazione dell’immagine.

Nota

Disponibile quando è montato un obiettivo compatibile.

Handle Zoom
Impostazioni dello 
zoom della 
maniglia

Zoom Speed Type
Fix / Variable / Off

Imposta la modalità della levetta dello zoom della maniglia.

Nota

Disabilitato se la maniglia non è montata.

Zoom Speed
Da 1 a 8 (3)

Imposta la velocità dello zoom della maniglia.
(Abilitata se Zoom Speed Type è impostato su Fix)

Nota

Disabilitato se la maniglia non è montata.

Auto Black 
Balance
Impostazioni del 
bilanciamento 
automatico del 
nero

Auto Black Balance
Execute / Cancel

Esegue la funzione di bilanciamento automatico del nero.

Note

• Eseguire la funzione di bilanciamento automatico del nero 
con il copriobiettivo montato.

• Non può essere eseguita durante la registrazione o la 
visualizzazione della barra colori.

• Non può essere eseguita nelle modalità Interval Rec, Frame 
Rec, Slow & Quick Motion o Slow Shutter.

AF Micro 
Adjustment
Regolazione micro 
della posizione di 
messa a fuoco
(Abilitata quando 
si utilizza un 
adattatore LA-
EA2/4 (opzione))

Setting
On / Off

Attiva o disattiva la funzione di regolazione micro della messa 
a fuoco.

Amount
Da -20 a 0 a +20

Imposta il livello di regolazione micro della messa a fuoco 
automatica.
Utilizzare la seguente procedura per regolare gli obiettivi con 
innesto A-mount.
1 Montare l’obiettivo desiderato servendosi di un adattatore 

LA-EA2/4 (opzione).
2 Impostare Setting su On e regolare il valore Amount. 

Valori positivi spostano la messa a fuoco dietro al soggetto 
mentre valori negativi spostano la messa a fuoco davanti al 
soggetto.
Si raccomanda di controllare i risultati utilizzando, ad 
esempio, la funzione One Push AF durante la regolazione 
della messa a fuoco.

Clear All
Execute / Cancel

Inizializza il valori di regolazione salvati.

Camera

Voce Impostazione della voce 
secondaria
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Video Light 
Set
Impostazioni della 
luce video (quando 
si utilizza una luce 
HVL-LBPC 
(opzione))

Video Light Set
Power Link / Rec Link / Rec 
Link + Stby

Imposta il metodo di controllo dell’illuminazione per la luce 
video montata sulla slitta Multi-interface.
Power Link:

Accende e spegne la luce video in sincronia con 
l’accensione o spegnimento del camcorder.

Rec Link:
Accende e spegne la luce video in sincronia con l’avvio e 
l’arresto della registrazione.

Rec Link + Stby:
Accende e spegne la luce video in sincronia con la 
registrazione e lo standby del camcorder.

Camera

Voce Impostazione della voce 
secondaria
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Menu Paint 

Paint

Voce Impostazione della voce 
secondaria

Descrizione

White
Impostazioni del 
bilanciamento del 
bianco

Preset White
Da 2100K a 10000K (3200K)

Imposta il valore predefinito del bilanciamento del bianco.

Color Temp<A>
Da 1500K a 50000K (3200K)

Visualizza la temperatura di colore di bilanciamento del 
bianco salvata nella memoria A.

Color Temp. Balance<A>
Da –99 a +99 (±0)

Imposta il valore di guadagno del bilanciamento del bianco 
salvato nella memoria A (correlato al guadagno R e al 
guadagno B).

R Gain<A>
Da –99 a +99 (±0)

Imposta il valore di guadagno R del bilanciamento del bianco 
salvato nella memoria A.

B Gain<A>
Da –99 a +99 (±0)

Imposta il valore di guadagno B del bilanciamento del bianco 
salvato nella memoria A.

Color Temp<B>
Da 1500K a 50000K (3200K)

Visualizza la temperatura di colore del bilanciamento del 
bianco salvata nella memoria B. 

Color Temp. Balance<B>
Da –99 a +99 (±0)

Imposta il valore di guadagno del bilanciamento del bianco 
salvato nella memoria B (correlato al guadagno R e al 
guadagno B). 

R Gain <B>
Da –99 a +99 (±0)

Imposta il valore del guadagno R del bilanciamento del bianco 
salvato nella memoria B.

B Gain <B>
Da –99 a +99 (±0)

Imposta il valore del guadagno B del bilanciamento del bianco 
salvato nella memoria B.

Filter White Memory
On / Off

Attiva o disattiva la funzione che imposta l’area di memoria 
del bilanciamento del bianco per ciascun filtro ND.
On: imposta una memoria del bilanciamento del bianco per 
ciascun filtro ND.
Off: imposta una memoria del bilanciamento del bianco 
comune a tutti i filtri ND.

Shockless White
Off/1/2/3

Imposta la velocità di risposta del bilanciamento del bianco 
quando si cambia la modalità di bilanciamento del bianco.
Off: istantanea
da 1 a 3: il passaggio avviene più lentamente (velocità minore 
con numero più alto)

White Switch <B>
Memory / ATW

Seleziona la modalità di regolazione del bilanciamento del 
bianco che viene selezionata quando l’interruttore WHT BAL 
è impostato su B.

ATW Speed
1 / 2 / 3 / 4 / 5

Imposta la velocità di risposta in modalità ATW.
1: più alta velocità di risposta
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Offset White
Impostazioni di 
correzione del 
bilanciamento del 
bianco

Offset White<A>
On / Off

Seleziona se aggiungere (On) o non aggiungere (Off) un 
valore di correzione al valore di bilanciamento del bianco 
della memoria A.

Warm Cool <A>
Da –99 a +99 (±0)

Imposta come temperatura di colore la correzione aggiunta al 
bilanciamento del bianco della memoria A quando Offset 
White<A> è impostato su “On”.

Warm Cool Balance<A>
Da –99 a +99 (±0)

Imposta una temperatura di colore più precisa, da utilizzare 
quando non è possibile ottenere un’immagine soddisfacente 
con l’impostazione Warm Cool <A>.

Offset White<B>
On / Off

Seleziona se aggiungere (On) o non aggiungere (Off) un 
valore di correzione al valore di bilanciamento del bianco 
della memoria B.

Warm Cool <B>
Da –99 a +99 (±0)

Imposta come temperatura di colore la correzione aggiunta al 
bilanciamento del bianco della memoria A quando Offset 
White<B> è impostato su “On”.

Warm Cool Balance<B>
Da –99 a +99 (±0)

Imposta una temperatura di colore più precisa, da utilizzare 
quando non è possibile ottenere un’immagine soddisfacente 
con l’impostazione Warm Cool <B>.

Offset White<ATW>
On / Off

Specifica se aggiungere (On) o non aggiungere (Off) un valore 
di correzione al bilanciamento del bianco ATW.

Warm Cool <ATW>
Da –99 a +99 (±0)

Imposta come temperatura di colore la correzione aggiunta al 
bilanciamento del bianco ATW quando Offset White<ATW> è 
impostato su “On”.

Warm Cool Balance<ATW>
Da –99 a +99 (±0)

Imposta una temperatura di colore più precisa, da utilizzare 
quando non è possibile ottenere un’immagine soddisfacente 
con l’impostazione Warm Cool <ATW>.

Black
Impostazioni del 
nero

Setting
On / Off

Attiva o disattiva la correzione del nero

Master Black
Da –99 a +99 (±0)

Imposta il livello del nero master.

Nota

Per la regolazione fine, ruotare la manopola SEL/SET 
lentamente. In questo caso, il valore visualizzato potrebbe non 
cambiare.

R Black
Da –99 a +99 (±0)

Imposta il livello R del nero.

B Black
Da –99 a +99 (±0)

Imposta il livello B del nero.

Paint
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Gamma
Impostazioni di 
correzione della 
gamma

Setting
On / Off

Attiva o disattiva la funzione di correzione della gamma.

Step Gamma
Da 0.35 a 0.45 a 0.90

Imposta il valore di correzione della gamma in intervalli di 
0.05.

Master Gamma
Da –99 a +99 (±0)

Imposta il livello di gamma master.

R Gamma
Da –99 a +99 (±0)

Imposta il livello di gamma R.

G Gamma
Da –99 a +99 (±0)

Imposta il livello di gamma G.

Gamma Category
STD / HG / User / S-Log2 / 
S-Log3

Seleziona l’utilizzo della gamma standard (STD), 
HyperGamma (HG), gamma utente (User), S-Log2 o S-Log3.

Gamma Select
Quando Gamma Category è 
impostato su STD:

STD1 DVW / STD2 x 4.5 / 
STD3 x 3.5 / STD4 240M / 
STD5 R709 / STD6 x 5.0

Quando Gamma Category è 
impostato su HG:

HG1 3250G36 / HG2 4600G30 
/ HG3 3259G40 / HG4 
4609G33 / HG7 8009G40 / 
HG8 8009G33

Quando Gamma Category è 
impostato su User:

User 1 / User 2 / User 3 / User 4 
/ User 5

Quando Gamma Category è 
impostato su S-Log2.

S-Log2
Quando Gamma Category è 
impostato su S-Log3.

S-Log3

Seleziona la tabella di gamma da utilizzare nella correzione 
gamma.

Black Gamma Setting
On / Off

Attiva o disattiva la correzione della gamma del nero.
(Abilitata quando Gamma >Gamma Category è impostata su 
STD)

Nota

Le funzioni Black Gamma e Knee>Knee Saturation non 
possono essere utilizzate allo stesso tempo.

Range
Low / Mid / High

Seleziona il campo effettivo della correzione di gamma del 
nero.

Master Black Gamma
Da –99 a +99 (±0)

Specifica il livello di gamma del nero master.

Paint
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Knee Setting
On / Off

Attiva o disattiva la funzione di correzione del knee
(Abilitata quando Gamma >Gamma Category è impostata su 
STD)

Auto Knee
On / Off

Attiva o disattiva la funzione di correzione del knee 
automatica.

Point
Da 75% a 109% (90%)

Imposta il punto knee

Slope
Da –99 a +99 (±0)

Imposta la pendenza del knee

Knee Saturation
On / Off

Abilita o disabilita la correzione della saturazione knee 
(corregge il colore sopra il punto di knee).

Nota

Le funzioni Black Gamma e Knee>Knee Saturation non 
possono essere utilizzate allo stesso tempo.

Knee Saturation Level
Da –99 a +99 (±0)

Imposta il livello di correzione del colore sopra il punto knee 
(saturazione knee)

White Clip
Impostazioni di 
regolazione del 
clip del bianco

Setting
On / Off

Attiva o disattiva la funzione di regolazione del clip del 
bianco.

Nota

Non può essere impostata quando Gamma >Gamma Category 
è impostata su S-Log2 or S-Log3.

Level
Quando Country non è impostato 
su PAL Area.

Da 90.0% a 109.0% (108,0%)
Quando Country è impostato su 
PAL Area.

Da 90.0% a 109.0% (105.0%)

Specifica il livello di clip del bianco.

Paint
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Detail
Impostazioni di 
regolazione dei 
dettagli

Setting
On / Off

Attiva o disattiva la funzione di regolazione dei dettagli.

Level
Da –99 a +99 (±0)

Imposta il livello del dettaglio.

H/V Ratio
Da –99 a +99 (±0)

Specifica il rapporto di combinazione tra il livello di dettaglio 
H e il livello di dettaglio V.

Crispening
Da –99 a +99 (±0)

Imposta il livello di miglioramento della nitidezza.

Level Depend
On / Off

Attiva o disattiva la funzione di regolazione della dipendenza 
del livello.

Level Depend Level
Da –99 a +99 (±0)

Imposta il livello della dipendenza del livello.

Frequency
Da –99 a +99 (±0)

Imposta la frequenza centrale del dettaglio (spessore di 
dettaglio).
Il dettaglio è tanto più sottile quanto più alta è la frequenza 
centrale e tanto più spesso quanto più bassa la frequenza 
centrale.

Knee Aperture
On / Off

Attiva o disattiva la funzione di correzione dell’apertura del 
knee.

Knee Aperture Level
Da –99 a +99 (±0)

Imposta il livello di apertura knee.

Limit
Da –99 a +99 (±0)

Imposta il valore di limitazione del dettaglio sia verso il 
bianco che verso il nero

White Limit
Da –99 a +99 (±0)

Imposta il valore di limitazione del dettaglio verso il bianco.

Black Limit
Da –99 a +99 (±0)

Imposta il valore di limitazione del dettaglio verso il nero.

V Black Limit
Da –99 a +99 (±0)

Imposta il valore di limitazione del dettaglio V verso il nero.

V Detail Creation
NAM / Y / G / G+R

Imposta la sorgente del segnale per la creazione del dettaglio 
V su NAM (G o R, qualunque sia maggiore), Y, G o G+R.

Skin Detail
Impostazioni di 
correzione del 
dettaglio pelle

Setting
On / Off

Attiva o disattiva la funzione di correzione del dettaglio pelle.

Area Detection
Execute / Cancel

Identifica il colore utilizzato per la correzione del dettaglio 
pelle.
Execute: esegue l’identificazione

Area Indication
On / Off

Attiva o disattiva la funzione che visualizza il motivo zebra 
nelle aree del colore utilizzato per la correzione del dettaglio 
pelle.

Level
Da –99 a +99 (±0)

Imposta il livello del dettaglio pelle.

Saturation
Da –99 a +99 (±0)

Imposta la saturazione del colore su cui applicare la 
correzione del dettaglio pelle.

Hue
Da 0 a 359

Imposta la tonalità (hue) del colore su cui applicare la 
correzione del dettaglio pelle.

Width
Da 0 a 90 (40)

Specifica il campo della tonalità (hue) del colore su cui 
applicare la correzione del dettaglio pelle.

Paint
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Aperture
Impostazioni di 
correzione 
dell’apertura

Setting
On / Off

Abilita o disabilita la funzione di correzione dell’apertura, un 
processo che permette di migliorare la risoluzione 
aggiungendo sul segnale video un segnale di apertura ad alta 
frequenza che corregge il degrado dovuto alle caratteristiche 
delle alte frequenze.

Level
Da –99 a +99 (±0)

Imposta il livello della correzione di apertura.

Matrix
Impostazioni di 
correzione della 
matrice

Setting
On / Off

Attiva o disattiva la funzione di correzione della matrice.

Adaptive Matrix
On / Off

Attiva o disattiva la funzione di matrice adattiva.

Preset Matrix
On / Off

Attiva o disattiva la funzione di matrice preimpostata.

Preset Select
Standard
High Saturation
FL Light
Cinema
F55 709 Like

Seleziona una matrice preimpostata.

User Matrix
On / Off

Attiva o disattiva la funzione di matrice dell’utente.

Level
Da –99 a +99 (±0)

Regola la saturazione del colore dell’intera immagine. 

Phase
Da –99 a +99 (±0)

Regola il tono di colore (la fase) dell’intera immagine.

User Matrix R-G
Da –99 a +99 (±0)

Imposta una matrice R-G definita dall’utente.

User Matrix R-B
Da –99 a +99 (±0)

Imposta una matrice R-B definita dall’utente.

User Matrix G-R
Da –99 a +99 (±0)

Imposta una matrice G-R definita dall’utente.

User Matrix G-B
Da –99 a +99 (±0)

Imposta una matrice G-B definita dall’utente.

User Matrix B-R
Da –99 a +99 (±0)

Imposta una matrice B-R definita dall’utente.

User Matrix B-G
Da –99 a +99 (±0)

Imposta una matrice B-G definita dall’utente.

Paint
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Multi Matrix
Impostazioni di 
correzione 
multimatrice

Setting
On / Off

Attiva o disattiva la correzione multimatrice

Area Indication
On / Off

Attiva o disattiva la funzione di indicazione dell’area.

Color Detection
Execute / Cancel

Identifica il colore utilizzato per la correzione multimatrice.

Axis
B / B+ / MG– / MG / MG+ / 
R / R+ / YL– / YL / YL+ / G– / 
G / G+ / CY / CY+ / B–

Seleziona l’asse.

Hue
Da –99 a +99 (±0)

Imposta la tonalità (hue) del colore per la correzione 
multimatrice.

Saturation
Da –99 a +99 (±0)

Imposta la saturazione del colore utilizzato per la correzione 
multimatrice.

Maintenance
Impostazioni di 
manutenzione

Test Saw
On / Off

Attiva o disattiva il segnale di prova.

Paint
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Menu Audio

Audio

Voce Impostazione della voce 
secondaria

Descrizione

Audio Input
Impostazioni di 
ingresso audio

CH1 Input Select
INPUT1 / Internal MIC / 
Shoe 1

Seleziona la sorgente di ingresso per la registrazione sul 
canale 1.

CH2 Input Select
INPUT1 / INPUT2 / 
Internal MIC / Shoe 2

Seleziona la sorgente di ingresso per la registrazione sul 
canale 2.

CH3 Input Select
Off / Internal MIC / Shoe 1

Seleziona la sorgente di ingresso per la registrazione sul 
canale 3.

CH4 Input Select
Off / Internal MIC / Shoe 2

Seleziona la sorgente di ingresso per la registrazione sul 
canale 4.

INPUT1 MIC Reference
–60dB / –50dB / –40dB

Imposta il livello di riferimento di registrazione dell’ingresso 
microfono XLR su INPUT1.

INPUT2 MIC Reference
–60dB / –50dB / –40dB

Imposta il livello di riferimento di registrazione dell’ingresso 
microfono XLR su INPUT2.

CH1 Wind Filter
On / Off

Abilita o disabilita il filtro di riduzione del rumore del vento 
per la registrazione del canale 1.

CH2 Wind Filter
On / Off

Abilita o disabilita il filtro di riduzione del rumore del vento 
per la registrazione del canale 2.

CH3 Wind Filter
On / Off

Abilita o disabilita il filtro di riduzione del rumore del vento 
per la registrazione del canale 3.

CH4 Wind Filter
On / Off

Abilita o disabilita il filtro di riduzione del rumore del vento 
per la registrazione del canale 4.

CH3 Level Control
Auto / Manual

Seleziona la regolazione del livello di ingresso audio 
automatica o manuale per la registrazione sul canale 3.

Nota

Se CH3 Input Select oppure CH4 Input Select sono impostati 
su “Internal MIC”, CH4 viene impostato su automatico o 
manuale in accordo con questa impostazione.

CH4 Level Control
Auto / Manual

Seleziona la regolazione del livello di ingresso audio 
automatica o manuale per la registrazione sul canale 4.

Nota

Se CH3 Input Select oppure CH4 Input Select sono impostati 
su “Internal MIC”, CH4 viene impostato su automatico o 
manuale in accordo l’impostazione di CH3 Level Control.

CH3 Input Level
Da 0 a 99 (49)

Imposta il livello di ingresso audio per la registrazione del 
canale 3.

Nota

Se CH3 Input Select oppure CH4 Input Select sono impostati 
su “Internal MIC”, l’opzione CH4 Input Level viene impostata 
in accordo con questa impostazione.
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CH4 Input Level
Da 0 a 99 (49)

Imposta il livello di ingresso audio per la registrazione del 
canale 4.

Nota

Se CH3 Input Select oppure CH4 Input Select sono impostati 
su “Internal MIC”, l’opzione CH4 Input Level viene impostata 
in accordo con l’impostazione di CH3 Input Level.

Audio Input Level
Da 0 a 99

Imposta il livello di ingresso audio.

Limiter Mode
Off / –6dB / –9dB / –12dB / 
–15dB / –17dB

Seleziona la caratteristica di limitazione per i segnali di 
ingresso di livello elevato quando il livello di ingresso audio 
viene regolato manualmente.

CH1&2 AGC Mode
Mono / Stereo

Imposta la modalità di regolazione livello automatica per la 
registrazione sui canali 1 e 2.

CH3&4 AGC Mode
Mono / Stereo

Imposta la modalità di regolazione livello automatica per la 
registrazione sui canali 3 e 4.

AGC Spec
–6dB / –9dB / –12dB / 
–15dB / –17dB

Seleziona la caratteristica AGC.

1kHz Tone on Color Bars
On / Off

Attiva o disattiva l’emissione del segnale di tono di 
riferimento a 1 kHz durante la visualizzazione delle barre 
colore.

Nota

Se impostato su On, viene impostato il segnale di tono di 
riferimento a 1 kHz per la registrazione sui canali 3 e 4, anche 
se CH3 Input Select e CH4 Input Select sono impostati su Off.

CH1 Level
Ingresso senza adattatore XLR

Audio Input Level / Side / 
Level+Side

Ingresso con adattatore XLR 
(pagina 51)

Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di 
ingresso audio abilitate per la registrazione del canale 1.

CH2 Level
Ingresso senza adattatore XLR

Audio Input Level / Side / 
Level+Side

Ingresso con adattatore XLR 
(pagina 51)

Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di 
ingresso audio abilitate per la registrazione del canale 2.

Audio
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CH3 Level
Ingresso senza adattatore XLR

Audio Input Level / CH3 Input 
Level / Level+CH3 Input 
Level

Ingresso con adattatore XLR 
(pagina 51)

Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di 
ingresso audio abilitate per la registrazione del canale 3.

CH4 Level
Ingresso senza adattatore XLR

Audio Input Level / CH4 Input 
Level / Level+CH4 Input 
Level

Ingresso con adattatore XLR 
(pagina 51)

Audio Input Level / Through

Imposta la combinazione delle regolazioni del livello di 
ingresso audio abilitate per la registrazione del canale 4.

Audio Output
Impostazioni 
uscita audio

Monitor CH
CH1/CH2 / CH3/CH4 / MIX 
ALL / CH1 / CH2 / CH3 / CH4

Seleziona l’uscita del canale audio sul connettore cuffie e 
l’altoparlante incorporato.

Nota

Se l’audio è impostato per l’uscita simultanea su più di un 
canale, il livello di uscita di ciascun canale viene ridotto per 
evitare il clipping.

Monitor Volume
Da 0 a 15 (7)

Regola il livello di uscita dell’audio di monitoraggio sul 
connettore cuffie e l’altoparlante incorporato.

Headphone Out
Mono / Stereo

Specifica se l’uscita del connettore cuffie deve essere mono o 
stereo.

Alarm Volume
Da 0 a 7 (4)

Regola il volume dell’allarme.

Output Limiter
On / Off

Attiva o disattiva il limitatore di uscita audio.

HDMI Output CH
CH1/CH2 / CH3/CH4

Imposta la combinazione dei canali audio sull’uscita HDMI.

Audio
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Menu Video

Video

Voce Impostazione della voce 
secondaria

Descrizione

Output On/Off
Impostazioni di 
uscita video

SDI
On / Off

Attiva o disattiva l’uscita SDI.

HDMI
On / Off

Attiva o disattiva l’uscita HDMI.

Output Format
Impostazioni del 
formato di uscita

SDI Imposta la risoluzione delle uscite SDI e HDMI.
Per informazioni dettagliate su queste impostazioni, vedere 
“Formati video e segnali di uscita” (pagina 104).

HDMI

Output Setting
Impostazioni della 
modalità di 
conversione in 
uscita

HDMI Target Device
Recorder / Monitor

Imposta il tipo di dispositivo di ingresso HDMI connesso 
all’uscita HDMI.
Recorder:

In modalità Cine EI, emette in uscita su HDMI lo stesso 
video di SDI1. 

Monitor:
In modalità Cine EI, emette in uscita su HDMI lo stesso 
video di SDI2.

4K/2K to HD Conv.
Edge Crop / Letter Box

Imposta la modalità di conversione video da 17:9 a 16:9.
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Monitor LUT
Impostazioni del 
LUT monitor.
Disponibile solo in 
modalità Cine EI.

Categoria
LUT / Look Profile / User 3D 
LUT

Imposta il tipo di Look applicato come LUT monitor.
LUT:

Emette in uscita video a cui è applicato il LUT 
preimpostato oppure il LUT utente.

Look Profile:
Selezionando il numero di Look opportuno, emette video 
simile alla pellicola stampata o adatto come punto di inizio 
del grading del colore.

User 3D LUT:
Emette in uscita video con applicato il 3D LUT utente.

Nota

Può non essere possibile impostare un LUT monitor 
indipendente per ciascun sistema (pagina 117).

LUT Select
P1: 709(800%)
P2: HG8009G40
P3: HG8009G33
P4: S-Log2
P5: S-Log3
U1
U2
U3
U4
U5
U6

Seleziona il tipo di LUT, quando Monitor LUT >Category è 
impostato su LUT.
709(800%):

Segnale con curva di base ITU-R709 con gamma dinamica 
estesa fino a 800%.

HG8009G40:
Segnale con HyperGamma con gamma dinamica 800%, 
limite del bianco 109% e uscita video scheda grigio 18% al 
40%.

HG8009G33:
Segnale con HyperGamma con gamma dinamica 800%, 
limite del bianco 109% e uscita video scheda grigio 18% al 
33%.

S-Log2:
Segnale di log con gamma dinamica del 1300% che tiene 
conto della visibilità su un monitor video, con sviluppo 
delle riprese in sede di post produzione.
(Abilitato quando Base Setting >Color Space nel menu 
System è impostato su S-Gamut/SLog2)

S-Log3:
Segnale di log con gamma dinamica del 1300% che imita 
le caratteristiche della pellicola, simile alla curva Cineon 
Log.
(Abilitato quando Base Setting >Color Space nel menu 
System è impostato su S-Gamut3.Cine/SLog3 o S-Gamut3/
SLog3)

Da U1 a U6:
Segnali LUT utente importati da una scheda SD.

Nota

Selezionare F55/F5 come formato di uscita quando si 
crea un LUT usando RAW Viewer.
Creare e memorizzare i file LUT nella seguente cartella 
di una scheda SD:

\PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Video

Voce Impostazione della voce 
secondaria

Descrizione
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Look Profile Select
1: LC-709
2: LC-709typeA
3: SLog2-709
4: Cine+709

Seleziona il tipo di profilo Look quando Monitor LUT 
>Category è impostato su Look Profile.

User 3D LUT Select
User 3D-1
User 3D-2
User 3D-3
User 3D-4

Seleziona il tipo di 3D LUT utente.

SDI1 & Internal Rec
MLUT On / MLUT Off

Seleziona se applicare il LUT monitor all’uscita video SDI 
OUT1 e ai video registrati su schede di memoria XQD.

SDI2
MLUT On / MLUT Off

Seleziona se applicare il LUT monitor all’uscita video SDI 
OUT2.

HDMI
MLUT On / MLUT Off

Indica se il LUT monitor è applicato all’uscita video HDMI 
(pagina 117).

Mirino
MLUT On / MLUT Off

Seleziona se applicare il LUT monitor all’uscita video sul 
mirino.

Output Display
Impostazioni del 
segnale di uscita

SDI2
On / Off

Seleziona se sovraimporre menu e stato sui segnali di uscita 
SDI e HDMI.

HDMI
On / Off

Video

Voce Impostazione della voce 
secondaria
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Menu VF

VF

Voce Impostazione della voce 
secondaria

Descrizione

VF Setting
Impostazioni del 
mirino

Brightness
Da –99 a +99 (±0)

Regola la luminosità dell’immagine del mirino.

Color Mode
Color / B&W

Seleziona la modalità di visualizzazione del mirino in 
modalità di registrazione o E-E.

Peaking
Impostazioni di 
peaking

Setting
On / Off

Attiva o disattiva la funzione Peaking.

Nota

Non può essere impostato su On quando Picture Cache Rec è 
impostato su On.

Peaking Type
Normal / Color

Seleziona il tipo di peaking.
Normal: peaking normale
Color: peaking a colori

Frequency
Normal / High

Seleziona la frequenza di peaking.

Normal Peaking Level
Da 0 a 99 (50)

Imposta il livello di peaking normale.

Color
B&W / Red / Yellow / Blue

Seleziona il colore del segnale di peaking colore.

Color Peaking Level
Da 0 a 99 (50)

Imposta il livello del peaking colore.

Zebra
Impostazioni del 
motivo zebra 

Setting
On / Off

Attiva o disattiva la funzione Zebra

Nota

Non può essere impostato su On quando Picture Cache Rec è 
impostato su On.

Zebra Select
1 / 2 / Both

Seleziona il tipo di motivo zebra (Zebra1, Zebra2, Both).

Zebra1 Level
Da 50% a 107% (70%)

Imposta il livello di visualizzazione del motivo Zebra1.

Zebra1 Aperture Level
Da 1% a 20% (10%)

Imposta il livello di apertura del motivo Zebra1.

Zebra2 Level
Da 52% a 109% (100%)

Imposta il livello di visualizzazione del motivo Zebra2.
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Marker
Impostazioni di 
visualizzazione 
degli indicatori

Setting
On / Off

Attiva o disattiva la visualizzazione di tutti gli indicatori.

Color
White / Yellow / Cyan / Green / 
Magenta / Red / Blue

Seleziona il colore del segnale dell’indicatore.

Center Maker
1 / 2 / 3 / 4 / Off

Attiva o disattiva la visualizzazione dell’indicatore centrale.

Safety Zone
On / Off

Attiva o disattiva la visualizzazione dell’indicatore della zona 
di sicurezza.

Safety Area
80% / 90% / 92.5% / 95%

Seleziona le dimensioni dell’indicatore della zona di sicurezza 
(come percentuale delle dimensioni totali dello schermo).

Aspect Marker
Line / Mask / Off

Seleziona il tipo di indicatore di aspetto.

Aspect Mask
Da 0 a 15 (12)

Imposta il livello del segnale video all’esterno dell’indicatore 
su un valore percentuale relativo al segnale all’interno 
dell’indicatore.

Aspect Safety Zone
On / Off

Attiva o disattiva la visualizzazione della zona di sicurezza di 
aspetto.

Aspect Safety Area
80% / 90% / 92.5% / 95%

Seleziona le dimensioni dell’indicatore della zona di sicurezza 
di aspetto come percentuale delle dimensioni totali dello 
schermo.

Aspect Select
4:3 / 1.66:1 / 
1.85:1 / 2.35:1 / 2.4:1

Imposta la modalità di visualizzazione dell’indicatore di 
aspetto.

User Box
On / Off

Attiva o disattiva la visualizzazione del cursore a riquadro.

User Box Width
Da 3 a 479 (240)

Specifica la larghezza del cursore a riquadro (distanza dal 
centro ai bordi destro e sinistro).

User Box Height
Da 3 a 269 (135)

Specifica l’altezza del cursore a riquadro (distanza dal centro 
al bordo superiore e inferiore).

User Box H Position
Da -476 a +476 (0)

Imposta la posizione orizzontale del centro del cursore a 
riquadro.

User Box V Position
Da -266 a +266 (0)

Specifica la posizione verticale del centro del cursore a 
riquadro.

100% Marker
On / Off

Attiva o disattiva la visualizzazione dell’indicatore 100%.

Guide Frame
On / Off

Attiva o disattiva la visualizzazione del riquadro di guida.

VF
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Display On/Off
Impostazioni della 
visualizzazione 
delle indicazioni

Setting
On / Off

Seleziona gli elementi da visualizzare nel mirino.

Shutter Setting
On / Off

ND Filter Position
On / Off

Gain Setting
On / Off

Rec/Play Status
On / Off

HXR-IFR5 Rec Control
On / Off

Color Temp.
On / Off

Frame Rate
On / Off

Battery Remain
On / Off

Timecode
On / Off

Audio Manual
On / Off

Audio Level Meter
On / Off

Media Status
On / Off

Focus Position
Meter / Feet / Off

Iris Position
On / Off

Zoom Position
Number / Bar / Off

SteadyShot
On / Off

Focus Mode
On / Off

Focus Area Indicator
On / Off

Focus Indicator
On / Off

Auto Shutter
On / Off

AGC
On / Off

Auto Iris
On / Off

AE Mode
On / Off

VF
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Auto Exposure Level
On / Off

White Balance Mode
On / Off

SDI/HDMI Rec Control
On / Off

Rec Format
On / Off

Gamma
On / Off

Timecode Lock
On / Off

Wi-Fi Condition
On / Off

Video Signal Monitor
Off / Waveform / Vector / 
Histogram

Nota

Non può essere impostato quando l’uscita SDI non è 
configurata nel menu Video. Visualizzato per uscita SDI2 solo 
nei seguenti casi:

– Quando l’uscita SDI è Edge Crop
– Quando le impostazioni On/Off di Monitor LUT sono 

diverse per ciascun sistema.
Per informazioni dettagliate, vedere (pagina 117).

Clip Name
On / Off

Focus Assist Indicator
On / Off

Focus Area Marker
On / Off

Video Level Warning
On / Off

Clip Number
On / Off

GPS
On / Off

Level Gauge
On / Off

Lens Info
Meter / Feet / Off

Notice Message
On / Off

VF

Voce Impostazione della voce 
secondaria
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Menu TC/UB

TC/UB

Voce Impostazione della voce 
secondaria

Descrizione

Timecode
Impostazioni del 
codice temporale

Mode
Preset / Regen / Clock

Imposta la modalità di avanzamento del codice temporale.
Preset:

Il codice temporale inizia da un valore preimpostato.
Regen:

Il codice temporale prosegue dall’ultimo valore del clip 
precedente.

Clock:
Utilizza l’orologio interno come codice temporale.

Run
Rec Run / Free Run

Rec Run: Avanza solo durante la registrazione.
Free Run: Avanzamento costante, indipendentemente 
dall’accensione del camcorder.

Setting Imposta il codice temporale su un valore arbitrario.
SET: Imposta il valore.

Reset
Execute / Cancel

Azzera il codice temporale (00:00:00:00)
Execute: Azzera il codice temporale

TC Format
DF / NDF

Imposta il formato del codice temporale.
DF: Drop Frame
NDF: Non-Drop Frame

TC Display
Impostazioni di 
visualizzazione dei 
dati temporali

Display Select
Timecode / Users Bit / 
Duration

Consente di scegliere quali dati temporali devono essere 
visualizzati.

User Bit
Impostazioni 
relative ai bit 
utente.

Mode
Fix / Time

Imposta la modalità del bit utente.
Fix: Utilizza per i bit utente un valore fisso arbitrario.
Time: Utilizza l’ora corrente nei bit utente.

Setting Imposta i bit utente su un valore arbitrario.

HDMI TC Out Setting
On / Off

Consente di selezionare se emettere il codice temporale ad 
altri dispositivi per altri scopi, tramite HDMI. 
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Menu Recording

Recording

Voce Impostazione della voce 
secondaria

Descrizione

S&Q Motion
Impostazioni della 
modalità Slow & 
Quick Motion 
(pagina 46)

Setting
On / Off

Attiva o disattiva la modalità Slow & Quick Motion.
Quando è impostato su On, le seguenti funzioni sono 
disabilitate:
• Auto Iris
• Auto Focus 

High Frame Rate Mode
Off / Full Scan

Consente di utilizzare una velocità di imaging superiore a 60P.
Off:

Non consente di utilizzare una velocità di imaging 
superiore a 60P.

Full Scan:
Abilita l’imaging ad alta velocità con dimensione di 
fotogramma Super 35.

Frame Rate
Fino a 240fps

Imposta la frequenza fotogrammi per le riprese in modalità 
Slow & Quick Motion.

Nota

Il valore iniziale varia a seconda delle impostazioni di Codec, 
Country, Video Format e RAW Output Format.

Picture Cache 
Rec
Impostazioni della 
modalità di 
registrazione cache 
immagine 
(pagina 47)

Setting
On / Off

Attiva o disattiva la funzione di registrazione cache immagine.

Cache Rec Time
0-2sec / 2-4sec / 4-6sec / 
6-8sec / 8-10sec / 
10-12sec / 12-14sec / 
13-15sec

Imposta il tempo di registrazione cache immagine quando 
Picture Cache Rec è impostato su On.

Simul Rec
Impostazioni della 
registrazione 
simultanea 
(pagina 37)

Setting
On / Off

Attiva o disattiva la funzione di registrazione simultanea e 
specifica il supporto di destinazione della registrazione.

Rec Button Set
“Rec Button [SlotA SlotB] 
Handle Rec Button [SlotA 
SlotB]” / “Rec Button [SlotA] 
Handle Rec Button [SlotB]” / 
“Rec Button [SlotB] Handle 
Rec Button [SlotA]”

Seleziona i pulsanti utilizzati per controllare la registrazione 
sui vari supporti di registrazione.

SDI/HDMI Rec 
Control
Impostazioni della 
registrazione SDI/
HDMI

Setting
On / Off

Attiva o disattiva l’avvio e l’arresto della registrazione, tramite 
i segnali SDI/HDMI, per un dispositivo esterno connesso. 
Quando sono assegnati pulsanti diversi con Rec Button Set, il 
segnale di controllo registrazione segue lo stato di 
registrazione dello slot A.
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Menu Thumbnail

Thumbnail

Voce Impostazione della voce 
secondaria

Descrizione

Display Clip 
Properties
Schermata di 
visualizzazione 
delle proprietà dei 
clip

Visualizza la schermata delle proprietà dei clip.

Set Index 
Picture
Impostazioni 
relative 
all’immagine 
indice

Specifica l’immagine indice del clip.

Thumbnail 
View
Impostazioni della 
schermata delle 
miniature

Essence Mark Thumbnail
All / Rec Start / Shot Mark1 / 
Shot Mark2 / Shot Mark3 / 
Shot Mark4 / Shot Mark5 / 
Shot Mark6 / Shot Mark7 / 
Shot Mark8 / Shot Mark9 / 
Shot Mark0

Visualizza le miniature di tutti i fotogrammi contenenti 
essence mark (indicatori di identificazione).

Clip Thumbnail Visualizza miniature dei clip registrati.

Set Shot Mark
Impostazioni 
relative agli Shot 
Mark (indicatori di 
ripresa)

Add Shot Mark1 Aggiunge lo Shot Mark1

Delete Shot Mark1 Elimina lo Shot Mark1

Add Shot Mark2 Aggiunge lo Shot Mark2

Delete Shot Mark2 Elimina lo Shot Mark2

Set Clip Flag
Impostazioni 
relative ai flag dei 
clip

Add OK Aggiunge un flag OK.

Add NG Aggiunge un flag NG.

Add KEEP Aggiunge un flag Keep.

Delete Clip Flag Elimina tutti i flag.

Lock/Unlock
Clip
Protezione clip

Select Clip Seleziona e blocca/sblocca un clip.

Lock All Clips Blocca tutti i clip.

Unlock All Clips Sblocca tutti i clip.

Delete Clip
Elimina clip

Select Clip Elimina il clip selezionato.

All Clips Elimina tutti i clip visualizzati.

Filter Clips
Impostazioni di 
visualizzazione 
filtrata dei clip

OK Visualizza solo i clip che contengono un flag OK.

NG Visualizza solo i clip che contengono un flag NG.

KEEP Visualizza solo i clip che contengono un flag Keep.

None Visualizza solo i clip che non contengono nessun flag.

Customize 
View
Impostazioni della 
schermata delle 
miniature

Thumbnail Caption
Date Time / Time Code / 
Duration / Sequential Number

Seleziona le informazioni visualizzate sotto le miniature.
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Menu Media

Media

Voce Impostazione della voce 
secondaria

Descrizione

Update Media
Aggiorna le 
schede di memoria

Media (A)
Execute / Cancel

Aggiorna il file di gestione della scheda di memoria XQD 
nello slot A.
Execute: Aggiorna la scheda

Media (B)
Execute / Cancel

Aggiorna il file di gestione della scheda di memoria XQD 
nello slot B.
Execute: Aggiorna la scheda

Format Media
Formatta 
(inizializza) 
schede di memoria

Media (A)
Execute / Cancel

Inizializza la scheda di memoria XQD nello slot A.
Execute: Inizializza scheda

Media (B)
Execute / Cancel

Inizializza la scheda di memoria XQD nello slot B.
Execute: Inizializza scheda

SD Card
Execute / Cancel

Inizializza la scheda SD UTILITY.
Execute: Inizializza scheda

Clip
Impostazioni del 
nome dei clip

Auto Naming
Cam ID + Reel# / Title

Imposta il metodo per l’assegnazione di nomi ai clip.
Cam ID + Reel#:

Identificativo videocamera + numero bobina + numero 
ripresa + data + stringa casuale

Title:
Stringa impostata tramite Title Prefix + numero del clip

Nota

Quando Simul Rec è impostato su On, Cam ID + Reel# non 
può essere configurato.

Camera ID
Da A a Z

Imposta l’identificativo della videocamera quando Auto 
Naming è impostato su Cam ID + Reel#.

Reel Number
Da 001 a 999

Imposta la porzione numerica del numero della bobina quando 
Auto Naming è impostato su Cam ID + Reel#.

Camera Position
C / L / R

Imposta il prefisso del numero della ripresa quando Auto 
Naming è impostato su Cam ID + Reel#.

Title Prefix Imposta la porzione del titolo del nome del clip quando Auto 
Naming è impostato su Title.
(Il valore iniziale è un identificativo basato sul modello, che 
comprende le ultime tre cifre del numero di serie).
(Il valore viene inserito utilizzando la schermata di 
inserimento caratteri (pagina 60)).

Number Set
Da 0001 a 9999

Imposta la porzione numerica del nome del clip quando Auto 
Naming è impostato su Title.
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Menu File 

File

Voce Impostazione della voce 
secondaria

Descrizione

All File
Impostazioni 
relative ai file 
ALL.

Load SD Card
Execute / Cancel

Carica un file ALL.
Execute: Carica il file

Save SD Card
Execute / Cancel

Salva un file ALL.
Execute: Salva il file

File ID Assegna un nome al file.

Scene File
Impostazioni dei 
file di scena

Recall Internal Memory
Execute / Cancel

Carica un file di scena dalla memoria interna.
Execute: Carica il file

Store Internal Memory
Execute / Cancel

Salva un file di scena nella memoria interna.
Execute: Salva il file

Load SD Card
Execute / Cancel

Carica un file di scena dalla scheda SD.
Execute: Carica il file

Save SD Card
Execute / Cancel

Salva un file di scena su una scheda SD.
Execute: Salva il file

File ID Assegna un nome al file.

Scene White Data
On / Off

Seleziona se applicare o meno i dati di bilanciamento del 
bianco quando si caricano file di scena.

User Menu 
Item
Impostazioni delle 
voci del menu 
utente

Load SD Card
Execute / Cancel

Carica le impostazioni del menu utente da una scheda SD alla 
memoria interna.
Execute: Carica le impostazioni

Save SD Card
Execute / Cancel

Salva le impostazioni del menu utente su una scheda SD.
Execute: Salva le impostazioni

File ID Visualizza il File ID specificato per il file caricato mediante 
Load SD Card. Inoltre, imposta o modifica il File ID quando si 
salva un file mediante questo menu.

User Gamma
Impostazioni file 
gamma utente

Current Settings Visualizza un elenco delle impostazioni del file gamma utente 
correnti (nome dei file).

Load SD Card
Execute / Cancel

Carica le impostazioni di gamma utente da una scheda SD alla 
memoria interna.
Execute: Carica la gamma

Reset
1 / 2 / 3 / 4 / 5 / All
Valore iniziale: 709(800%)

Ripristina i valori predefiniti dei file di gamma utente 
contenuti nella memoria interna.
Da 1 a 5: Ripristina gamme utente specifiche.
All: Ripristina tutte le gamme utente.

Monitor LUT
Impostazioni del 
file LUT monitor.

Current Settings Visualizza un elenco delle impostazioni del file LUT monitor 
correnti (nome dei file).

Load SD Card
Execute / Cancel

Carica le impostazioni di LUT monitor da una scheda SD alla 
memoria interna.
Execute: Carica le impostazioni di LUT

Reset
1 / 2 / 3 / 4 / 5 / 6 / All

Ripristina i valori predefiniti di LUT monitor contenuti nella 
memoria interna.
Da 1 a 6: Ripristina i LUT monitor specificati.
All: Ripristina tutti i LUT monitor.
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Monitor 3D 
LUT
Impostazioni del 
file LUT 3D 
monitor.

Current Settings Visualizza un elenco delle impostazioni del file LUT 3D 
monitor correnti (nome dei file).

Load SD Card
Execute / Cancel

Carica le impostazioni di LUT 3D monitor da una scheda SD 
alla memoria interna.
Execute: Carica le impostazioni di LUT 3D

Reset
1 / 2 / 3 / 4 / All

Ripristina i valori predefiniti di LUT 3D monitor contenuti 
nella memoria interna.
Da 1 a 4: Ripristina i LUT 3D monitor specificati.
All: Ripristina tutti i LUT 3D monitor.

Lens File
Impostazioni del 
file obiettivo

White Offset R
Da –99 a +99 (±0)

Imposta il valore di correzione del bilanciamento del bianco 
del canale R dell’obiettivo nel file obiettivo.

White Offset B
Da –99 a +99 (±0)

Imposta il valore di correzione del bilanciamento del bianco 
del canale B dell’obiettivo nel file obiettivo.

File
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Menu System

System

Voce Impostazione della voce 
secondaria

Descrizione

Base Setting
Impostazioni di 
base

Shooting Mode
Custom / Cine EI

Imposta la modalità di ripresa.

Color Space
S-Gamut/SLog2 / 
S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / Matrix

Imposta lo spazio colore.

Codec
Impostazioni 
codec

Select
RAW / RAW & XAVC-I / RAW 
& XAVC-L / RAW & MPEG 
HD 422 / XAVC-I / XAVC-L / 
MPEG HD 422 / ProRes 422 
HQ / ProRes 422

Imposta la modalità di registrazione/riproduzione.

Note

• Le opzioni RAW / RAW & XAVC-I / RAW & XAVC-L / 
RAW & MPEG HD 422 sono disponibili quando è collegata 
un’unità di estensione XDCA-FS7 e Base Setting >Shooting 
Mode è impostato su Cine EI.

• Le opzioni ProRes 422 HQ / ProRes 422 sono disponibili 
solo quando è collegata un’unità di estensione XDCA-FS7.
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Rec Format
Impostazioni del 
formato di 
registrazione

Video Format

• Per sistemi NTSC:
Quando Codec >Select è impostato 
su XAVC-I.

4096×2160 59.94P
4096×2160 29.97P
4096×2160 23.98P
3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P
1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Quando Codec >Select è impostato 
su XAVC-L.

3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P 50
1920×1080 59.94P 35
1920×1080 59.94i 50
1920×1080 59.94i 35
1920×1080 59.94i 25
1920×1080 29.97P 50
1920×1080 29.97P 35
1920×1080 23.98P 50
1920×1080 23.98P 35

Quando Codec >Select è impostato 
su MPEG HD422.

1920×1080 59.94i 50
1920×1080 29.97P 50
1920×1080 23.98P 50
1280×720 59.94P 50
1280×720 29.97P 50
1280×720 23.98P 50

Quando Codec >Select è impostato 
su ProRes 422 HQ o ProRes 422.

1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Imposta il formato di registrazione.

• Per sistemi PAL:
Quando Codec >Select è impostato su XAVC-I.

4096×2160 50P
4096×2160 25P
3840×2160 50P
3840×2160 25P
1920×1080 50P
1920×1080 50i
1920×1080 25P

Quando Codec >Select è impostato su XAVC-L.
3840×2160 50P
3840×2160 25P
1920×1080 50P 50
1920×1080 50P 35
1920×1080 50i 50
1920×1080 50i 35
1920×1080 50i 25
1920×1080 25P 50
1920×1080 25P 35

Quando Codec >Select è impostato su MPEG HD422.
1920×1080 50i 50
1920×1080 25P 50
1280×720 50P 50
1280×720 25P 50

Quando Codec >Select è impostato su ProRes 422 HQ o 
ProRes 422.

1920×1080 50i
1920×1080 25P

Note

• “---” non è disponibile (grigio) quando Codec >Select è 
impostato su RAW.

• I valori fissi non sono disponibili (grigi) quando Codec 
>Select è impostato su RAW & XAVC-I, RAW & XAVC-L 
o RAW & MPEG HD 422.

System
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RAW Output Format

• Per sistemi NTSC:
Quando Codec >Select è impostato 
su un’opzione che include RAW.

4096×2160 59.94P
4096×2160 29.97P
4096×2160 23.98P
2048×1080 59.94P
2048×1080 29.97P
2048×1080 23.98P

• Per sistemi PAL:
Quando Codec >Select è impostato 
su un’opzione che include RAW.

4096×2160 50P
4096×2160 25P
2048×1080 50P
2048×1080 25P

Imposta il formato di registrazione per un registratore RAW 
esterno.

Genlock
Impostazioni 
Genlock

Reference
Internal / External(HD) / 
External(SD)

Visualizza lo stato di Genlock. Se Genlock è applicato, 
visualizza il tipo di segnale.
Internal: Genlock esterno non applicato.
External(HD): Genlock su segnale HD.
External(SD): Genlock su segnale SD.

Assignable 
Button
Impostazioni dei 
pulsanti 
programmabili

Da <1> a <6>
Off / Marker / Zebra / Peaking / 
Video Signal Monitor / Focus 
Magnifier x4/x8 / Focus Magnifier 
x4 / Focus Magnifier x8 / VF 
Mode / IRIS / Push Auto Iris / 
AGC / Push AGC / SHUTTER / 
Auto Exposure Level / Spotlight / 
Backlight / ATW / ATW Hold / 
Push AF/Focus Hold / SteadyShot 
/ Color Bars / User Menu / Rec 
Lamp / S&Q Motion / Picture 
Cache Rec / Rec Review / 
Thumbnail / Shot Mark1 / Shot 
Mark2 / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / 
DURATION/TC/U-BIT / High/
Low Key

Assegna funzioni ai pulsanti programmabili.
Marker:

Attiva o disattiva la funzione Marker.
Zebra:

Attiva o disattiva la funzione Zebra
Peaking:

Attiva o disattiva la funzione Peaking.
Video Signal Monitor:

Consente di scegliere la visualizzazione sul segnale video 
(istogramma, ecc.).

Focus Magnifier x4/x8:
Focus Magnifier x4:
Focus Magnifier x8:

Attiva o disattiva la funzione di ingrandimento della messa 
a fuoco.

VF Mode:
Visualizza l’immagine del mirino a colori o in bianco e 
nero.

IRIS:
Alterna fra le modalità di diaframma automatico e 
manuale.

Push Auto Iris:
Abilita la funzione di diaframma automatico mentre si 
tiene premuto il pulsante.

AGC:
Attiva o disattiva la funzione AGC.

System
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Push AGC:
Abilita la funzione AGC mentre si tiene premuto il 
pulsante.

SHUTTER:
Alterna fra le modalità di otturatore automatico e manuale.

Auto Exposure Level:
Apre la schermata del livello di esposizione automatica.

Spotlight:
Alterna fra Spotlight e Standard.

Backlight:
Alterna fra Backlight e Standard.

ATW:
Attiva o disattiva la funzione ATW.

ATW Hold
Sospende la funzione ATW.

Push AF/Focus Hold:
Esegue la funzione di Push Auto Fcus o di Focus Hold.

SteadyShot:
Alterna fra Active SteadyShot, SteadyShot e Off.

Color Bars:
Attiva o disattiva la barra colori.

User Menu:
Apre e chiude il User Menu.

Rec Lamp:
Accende o spegne l’indicatore di registrazione.

S&Q Motion:
Attiva o disattiva la modalità Slow & Quick Motion.

Picture Cache Rec:
Attiva o disattiva la funzione di registrazione cache 
immagine.

Rec Review:
Attiva o disattiva la funzione Rec Review.

Thumbnail:
Apre o chiude la schermata delle miniature.

Shot Mark1:
Esegue la funzione Add Shot Mark1.

Shot Mark2:
Esegue la funzione Add Shot Mark2.

Clip Flag OK
Esegue la funzione Add OK.
Premere due volte per eseguire Delete Clip Flag.

Clip Flag NG
Esegue la funzione Add NG.
Premere due volte per eseguire Delete Clip Flag.

Clip Flag Keep
Esegue la funzione Add Keep.
Premere due volte per eseguire Delete Clip Flag.

DURATION/TC/U-BIT:
Alterna fra Time Code, Users Bit e Duration.

High/Low Key:
Alterna fra High Key, Low Key e Off.
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Assignable 
Dial
Impostazioni delle 
manopole 
programmabili

Assignable Dial
Off / ISO/Gain/EI / IRIS / 
Focus / Audio Input Level

Assegna funzioni alla manopola programmabile del 
telecomando dell’impugnatura.
ISO/Gain /EI: Regola guadagno o EI.
IRIS: Regola il diaframma.
Focus: Regola la messa a fuoco.
Audio Input Level: Regola il livello audio.

IRIS Dial
(Stesse impostazioni di 
Assignable Dial)

Assegna funzioni alla manopola IRIS.

Assignable Dial Direction
Normal / Opposite

Imposta la direzione di rotazione della manopola 
programmabile del telecomando dell’impugnatura.
Normal: Ruota in avanti.
Opposite: Ruota nella direzione opposta.

IRIS Dial Direction
Normal / Opposite

Imposta la direzione di rotazione delle manopola IRIS.
Normal: Ruota in avanti.
Opposite: Ruota nella direzione opposta.

Rec Lamp
Impostazioni 
dell’indicatore di 
registrazione

Rec Lamp
On / Off

Accende o spegne l’indicatore di registrazione.

Fan Control
Impostazioni della 
modalità di 
controllo della 
ventola

Fan Control Mode
Auto / Minimum / Off in Rec

Imposta la modalità di controllo della ventola del camcorder.

Nota

Anche se è selezionata l’opzione “Off in Rec”, il ventilatore si 
attiva ugualmente se la temperatura interna del camcorder 
dovesse raggiunge un determinato valore.

HOLD Switch 
Setting
Impostazioni del 
selettore HOLD

with Rec Button
On / Off

Consente di scegliere se bloccare o meno il pulsante di 
registrazione.

with Hand Grip Remote
On / Off

Consente di scegliere se bloccare il funzionamento del 
telecomando dell’impugnatura.

Lens
Impostazioni 
obiettivo

Zoom Ring Direction
Left(W)/Right(T) / Right(W)/
Left(T)

Imposta la direzione della ghiera dello zoom.

Nota

Abilitato solo quando si utilizza un obiettivo con innesto 
E-mount che consente la scelta della direzione di azionamento 
della ghiera dello zoom.

Distortion Comp.
Auto / Off

Attiva o disattiva la funzione di correzione automatica della 
distorsione.

Nota

• Non disponibile in modalità di registrazione cache 
immagine o durante la registrazione.

• La compensazione della distorsione non è applicata durante 
la registrazione in modalità 4K o QFHD.

• Quando è selezionato “Auto”, Monitor LUT presenta alcune 
limitazioni (pagina 117).

Language
Impostazioni della 
lingua

Select Imposta la lingua di visualizzazione.
SET: Imposta la lingua.
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Clock Set
Impostazioni 
dell’orologio 
interno

Time Zone
Da UTC 12:00 Kwajalein a UTC 
+14:00

Imposta la differenza rispetto all’ora UTC in passi di 30 
minuti.

Date Mode
YYMMDD / MMDDYY / 
DDMMYY

Seleziona il formato di visualizzazione della data.
YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno

12H/24H
12H / 24H

Seleziona il formato di visualizzazione dell’ora.
12H: Orologio a 12 ore
24H: Orologio a 24 ore

Date Imposta la data corrente.
SET: Imposta il valore.

Time Imposta l’ora corrente.
SET: Imposta il valore.

Country
Impostazioni 
regionali

NTSC/PAL Area
NTSC Area / PAL Area

Imposta la regione di utilizzo.

Hours Meter
Impostazioni del 
contaore

Hours (System) Visualizza le ore d’uso totali (non può essere azzerato).

Hours (Reset) Visualizza le ore d’uso totali (può essere azzerato).

Reset
Execute / Cancel

Azzera l’indicazione Hours (Reset).
Execute: Reset

Basic 
Authentication
Impostazioni di 
autenticazione di 
rete di base

User Name 
(admin)

Imposta il nome utente desiderato (da 1 a 16 caratteri 
alfanumerici).
SET: Imposta il valore.

Password
(pxw-fs7)

Imposta una password (da 1 a 16 caratteri alfanumerici).
SET: Imposta il valore.

Wi-Fi
Impostazioni della 
connessione LAN 
Wireless

Wi-Fi
Enable / Disable

Seleziona se attivare o disattivare la connessione Wi-Fi.

SSID & Password Visualizza SSID e password.

Wi-Fi Direct Connection
Execute / Cancel

Avvia una connessione di rete “Wi-Fi Direct”.
Execute: Connette

Client Visualizza informazioni sul dispositivo client connesso (nome 
del modello e indirizzo MAC).

IP Address
192.168.1.1

Visualizza l’indirizzo IP del camcorder.

Nota

Non visualizzato quando si utilizza l’adattatore CBK-WA100.

Subnet Mask
255.255.0.0

Visualizza la subnet mask.

Nota

Non visualizzato quando si utilizza l’adattatore CBK-WA100.

MAC Address Visualizza l’indirizzo MAC del modulo Wi-Fi collegato al 
camcorder.

Regenerate Password
Execute / Cancel

Crea una nuova password.
Execute: Esegui

GPS
Impostazioni GPS

GPS
On / Off

Attiva o disattiva la funzione GPS.

Nota

Il modulo GPS è incorporato nella maniglia.
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IR Remote
Impostazioni del 
telecomando

Setting
On / Off

Attiva o disattiva l’azionamento del camcorder tramite il 
telecomando a infrarossi fornito in dotazione.

Camera 
Battery Alarm
Impostazioni di 
bassa tensione 
batteria

Low BATT
5% / 10% / 15% / ··· / 45% / 
50%

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di bassa tensione batteria (in 
incrementi del 5%).

BATT Empty
Da 3% a 7%

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme batteria scarica.

Camera DC IN 
Alarm
Impostazioni 
dell’allarme della 
tensione di 
ingresso

DC Low Voltage1
Da 11.5 V a 17.0 V

Imposta la tensione alla quale visualizzare l’allarme di bassa 
tensione su ingresso DC IN.

DC Low Voltage2
Da 11.0 V a 14.0 V

Imposta la tensione alla quale visualizzare l’allarme di 
tensione su ingresso DC IN insufficiente.

Ext. Unit 
Battery Alarm
Impostazioni 
batteria unità di 
estensione XDCA-
FS7

Near End:Info Battery
Da 5% a 100%

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di bassa tensione batteria Info-
Lithium (in incrementi del 5%).

End:Info Battery
Da 0% a 5%

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di batteria Info-Lithium esausta 
ed arrestare l’accesso ai supporti di memorizzazione.

Near End:Sony Battery
Da 11.5V a 17.0V

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di bassa tensione batteria per una 
batteria non Info-Lithium.

End:Sony Battery
Da 110V a 11.5V

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di batteria esausta per batterie 
non Info-Lithium ed arrestare l’accesso ai supporti di 
memorizzazione. 

Near End:Other Battery
Da 11.5V a 17.0V (11.8V)

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di bassa tensione batteria per una 
batteria Anton/Bauer.

End:Other Battery
Da 11.0V a 14.0V

Imposta il livello di carica rimanente della batteria per la 
visualizzazione dell’allarme di batteria esausta per batterie 
Anton/Bauer ed arrestare l’accesso ai supporti di 
memorizzazione.

Detected Battery Visualizza il tipo di batteria collegata all’unità di estensione 
XDCA-FS7.
Se è connessa una batteria all’unità di estensione XDCA-FS7, 
visualizza “Info Battery”, “Sony Battery” o “Other Battery”. 
Se è collegata una sorgente di alimentazione in corrente 
continua, viene visualizzato “DC IN”.
Se l’alimentazione proviene da batteria o alimentatore a 
corrente continua connesso al camcorder, viene visualizzato “ 
--- ”.

Ext. Unit DC IN 
Alarm
Impostazioni di 
allarme tensione di 
ingresso dell’unità 
di estensione 
XDCA-FS7

DC Low Voltage1
Da 11.5V a 17.0V

Imposta la tensione alla quale visualizzare l’allarme di bassa 
tensione su ingresso DC IN.

DC Low Voltage2
Da 11.0V a 14.0V

Imposta la tensione alla quale visualizzare l’allarme di 
tensione su ingresso DC IN insufficiente.
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All Reset
Ripristina le 
impostazioni 
predefinite

Reset
Execute / Cancel

Ripristina i valori predefiniti di fabbrica di tutte le 
impostazioni.
Execute: Reset

APR
Esegue APR

APR
Execute / Cancel

Esegue la funzione APR di ricostruzione automatica pixel per 
la regolazione automatica del sensore di immagine.
Execute: Esegui

Nota

Montare sempre il coperchietto dell’obiettivo prima di 
eseguire la funzione APR.

Camera Config
Impostazioni di 
uscita in modalità 
down-converter

HD/2K Modulation
High / Low

Imposta la larghezza di banda in uscita della modalità down-
converter per la conversione in HD e 2K

Version
Visualizza la 
versione

Number
x.xx

Visualizza la versione del software del camcorder.

Version Up
Execute / Cancel

Esegue l’upgrade del camcorder.*
Execute: Esegui
* L’upgrade aggiorna il software del camcorder.

Ext. Unit Version Number
x.xx

Visualizza la versione del software dell’unità di estensione 
XDCA-FS7.

Ext. Version Up
Execute / Cancel

Esegue l’upgrade dell’unità di estensione XDCA-FS7.*
Execute: Esegui
* L’upgrade aggiorna il software dell’unità di estensione 

XDCA-FS7.

System

Voce Impostazione della voce 
secondaria

Descrizione
98



Per visualizzare le immagini di registrazione e 
riproduzione del camcorder su un monitor 
esterno, selezionare il segnale di uscita del 
camcorder e utilizzare il cavo appropriato per il 
monitor esterno da collegare.
È possibile anche collegare dispositivi di 
registrazione, ad esempio un VTR, e registrare il 
segnale in uscita dal camcorder.
È possibile visualizzare sul monitor esterno le 
stesse informazioni che sono visibili nel mirino, 
ad esempio informazioni di stato e menu. 
Impostare Output Display (pagina 80) nel menu 
Video su “On” per il tipo di segnale da inviare al 
monitor.

Connettore SDI OUT (tipo BNC)
Attivare o disattivare l’uscita e selezionare il 
formato di uscita mediante il menu Video 
(pagina 78).
Per la connessione, utilizzare un cavo coassiale da 
75 Ω disponibile in commercio.

Nota

Controllare la messa a terra della connessione fra il 
camcorder e il dispositivo esterno prima di accendere i 
dispositivi.
(Si consiglia di accendere il camcorder e il dispositivo 
esterno dopo la connessione del cavo coassiale da 75 Ω).
Se il dispositivo esterno deve essere collegato al 
camcorder mentre il camcorder è acceso, collegare il 
cavo coassiale da 75 Ω al dispositivo esterno per primo e 
successivamente collegarlo al camcorder.

Per avviare la registrazione simultaneamente 
sul camcorder e sul dispositivo esterno
Con l’uscita segnale SDI abilitata, impostare SDI/
HDMI Rec Control (pagina 86) >Setting nel 
menu Recording su “On” per abilitare 
l’emissione di un segnale di trigger REC diretto al 
dispositivo esterno connesso al connettore SDI 
OUT. Questo sincronizzerà la registrazione sul 
dispositivo esterno con il camcorder.

Nota

Se il dispositivo esterno connesso non è compatibile con 
il segnale di trigger REC, il dispositivo non può essere 
comandato.

Connettore HDMI OUT (Type A)
Attivare o disattivare l’uscita e selezionare il 
formato di uscita mediante il menu Video 
(pagina 78).
Per la connessione, utilizzare un cavo HDMI ad 
alta velocità disponibile in commercio.
Selezionare il tipo di dispositivo collegato con la 
voce HDMI Target Device (pagina 117) del 
menu Video.

Connettore RAW OUT (tipo BNC)
Se viene montata un’unità di estensione XDCA-
FS7 sul camcorder, è possibile utilizzare un 
registratore RAW esterno, ad esempio un 
registratore AXS-R5, connesso al connettore 
RAW OUT dell’unità XDCA-FS7 (pagina 33).

Connessione di un dispositivo esterno

Connessione di monitor e dispositivi di registrazione 
esterni
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Per le riprese con più camcorder, è possibile 
sincronizzare i camcorder a un segnale di 
riferimento specifico o ai codici temporali 
sincronizzati tramite il connettore Genlock delle 
unità XDCA-FS7 (pagina 12) montate sui 
camcorder.

Nota

Non è possibile utilizzare il pacco batteria del camcorder 
quando è montata un’unità di estensione XDCA-FS7. È 
necessario montare un pacco batteria sull’unità 
XDCA-FS7 oppure collegare un alimentatore esterno.

Sincronizzazione della fase dei segnali 
video (genlock)
Abilitare la funzione genlock fornendo un segnale 
di riferimento ai connettori Genlock (pagina 12) 
delle unità XDCA-FS7 montate sui camcorder.
I segnali di riferimento utilizzabili variano a 
seconda della frequenza fotogrammi del formato 
di registrazione selezionato.

Per la zona NTSC

Per la zona PAL

Note

• Se il formato di registrazione selezionato è 1280×720 
60P, è necessario fornire sia un segnale video che un 
segnale di tempo.

• Se il segnale di riferimento non è stabile, sarà 
impossibile ottenere la sincronizzazione genlock.

• La sottoportante non è sincronizzata.

Sincronizzazione del codice temporale 
con altri dispositivi
Impostare l’unità che fornisce il codice temporale 
su una modalità in cui il codice temporale 
continui ad avanzare (es. Free Run o Clock).

1 Impostare l’opzione Timecode del 
menu TC/UB come indicato di seguito.

Mode: Preset
Run: Free Run

2 Premere il pulsante programmabile 
(pagina 45) a cui è assegnata la funzione 
DURATION/TC/U-BIT per 
visualizzare il codice temporale sullo 
schermo.

3 Controllare che il selettore TC IN/OUT 
(pagina 12) dell’unità XDCA-FS7 si 
trovi nella posizione IN e fornire un 
segnale video di riferimento HD o SD e 
un codice temporale sincronizzato con il 
segnale video sui connettori Genlock e 
TC IN/OUT rispettivamente.

Il generatore del codice temporale del camcorder 
si sincronizza con il codice temporale di 
riferimento e sullo schermo appare l’indicazione 
“EXT-LK”.
Una volta trascorsi dieci secondi circa 
dall’acquisizione della sincronizzazione, lo stato 
di sincronizzazione esterno viene mantenuto 
anche se la sorgente di riferimento esterna del 
codice temporale viene scollegata.

Sincronizzazione 
esterna

Frequenza 
fotogrammi del 
formato di 
registrazione

Segnali di riferimento 
validi

59.94P 1920 × 1080 59.94i
720 × 486 59.94i
1280 × 720 59.94P

29.97P 1920 × 1080 59.94i
720 × 486 59.94i

23.98P 1920 × 1080 47.95i 
(23.98PsF)

59.94i 1920 × 1080 59.94i
720 × 486 59.94i

Frequenza 
fotogrammi del 
formato di 
registrazione

Segnali di riferimento 
validi

50P 1920 × 1080 50i
720 × 576 50i
1280 × 720 50P

25P 1920 × 1080 50i
720 × 576 50i

50i 1920 × 1080 50i
720 × 576 50i

Frequenza 
fotogrammi del 
formato di 
registrazione

Segnali di riferimento 
validi
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Note

• Controllare che il codice temporale di riferimento e il 
segnale video di riferimento siano in un rapporto di 
fase conforme agli standard SMPTE per i codici 
temporali.

• Durante il funzionamento in modalità di 
sincronizzazione esterna, il codice temporale 
acquisisce istantaneamente la sincronizzazione con il 
codice temporale esterno e nella sezione di 
visualizzazione dei dati viene visualizzato il valore del 
codice temporale esterno. Tuttavia, non avviare 
immediatamente la registrazione. Prima di avviare la 
registrazione è necessario attendere alcuni secondi la 
stabilizzazione del generatore del codice temporale.

• Se la frequenza del segnale video di riferimento e la 
frequenza fotogrammi del camcorder non sono 
identiche, non sarà possibile ottenere la 
sincronizzazione e il camcorder non potrà funzionare 
correttamente. In questo caso, il codice temporale non 
potrà sincronizzarsi correttamente con il codice 
temporale esterno.

• Se la sorgente del codice temporale esterno viene 
disconnessa, il codice temporale potrà variare di un 
fotogramma all’ora rispetto al codice temporale di 
riferimento.

Per rilasciare la sincronizzazione esterna
Cambiare l’impostazione di Timecode nel menu 
TC/UB oppure spegnere il camcorder.
La sincronizzazione esterna si disconnette anche 
se si avvia la registrazione in modalità Quick & 
Slow Motion.

Sincronizzazione del codice temporale di 
un altro dispositivo con il codice 
temporale del camcorder
Impostare l’unità che fornisce il codice temporale 
su una modalità in cui il codice temporale 
continui ad avanzare (es. Free Run o Clock).

1 Impostare il codice temporale del 
camcorder con l’opzione Timecode 
(pagina 85) del menu TC/UB.

2 Controllare che il selettore TC IN/OUT 
(pagina 12) si trovi nella posizione OUT, 
quindi collegare il connettore TC IN/
OUT e il connettore Genlock 
(pagina 12) agli ingressi del codice 
temporale e Genlock, rispettivamente, 
del dispositivo che si desidera 
sincronizzare.

Utilizzo di un lettore di schede XQD 
(opzione)
Collegare un lettore di schede MRW-E80 XQD 
(opzione) mediante un cavo USB, quindi inserire 
una scheda di memoria nello slot. La scheda di 
memoria viene riconosciuta come un’unità di 
estensione del computer.

Utilizzo della modalità di 
memorizzazione di massa
Collegare il camcorder mediante un cavo USB, 
quindi inserire una scheda di memoria nello slot. 
La scheda di memoria viene riconosciuta come 
un’unità di estensione del computer.

1 Spostare l’interruttore POWER del 
camcorder su ON.

Sullo schermo o nel mirino viene 
visualizzato un messaggio di conferma della 
connessione USB.

Il messaggio di conferma della connessione USB 
non viene visualizzato se è già visualizzato un altro 
messaggio di conferma o un indicatore di 
avanzamento, ad esempio durante la formattazione 
o il recupero di una scheda di memoria XQD. 
Il messaggio di conferma verrà visualizzato al 
termine della formattazione o del recupero. Il 
messaggio di conferma USB non è visualizzato 
neanche quando è visualizzata la schermata delle 
proprietà del clip. Il messaggio verrà visualizzato al 
termine dell’operazione o quando si ritorna alla 
schermata delle miniature.

2 Ruotare la manopola SEL/SET e 
selezionare Execute.

Gestione ed editing di 
clip con un computer

Connessione con cavo USB

Nota
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3 Su Windows, controllare che la scheda 
sia aggiunta come disco rimovibile nella 
finestra “My Computer”. 
Su Macintosh, controllare che una 
cartella con il nome “NO NAME” o 
“Untitled” (modificabile) sia stata 
creata sul Desktop.

Note

• Non eseguire le seguenti operazioni se l’indicatore di 
accesso è illuminato in rosso.
- Spegnimento
- Distacco del cavo di alimentazione
- Rimuovere la scheda di memoria XQD
- Scollegare il cavo USB

• Il funzionamento non è garantito con tutti i computer.

Utilizzo di sistemi di editing non lineare
In un sistema di editing non lineare, è necessario 
utilizzare un software di editing (opzione) che 
supporti i formati registrati dal camcorder.
Utilizzare un software applicativo dedicato per 
salvare in anticipo sul disco rigido del computer i 
clip di cui eseguire l’editing.
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La ventola è una parte di consumo e necessita di 
una sostituzione periodica.
Se l’apparecchio viene utilizzato a temperatura 
ambiente, il ciclo normale di sostituzione è di 
circa 5 anni.
Tuttavia, ciò ha un valore puramente indicativo e 
non implica alcuna garanzia sulla durata di vita 
prevista di questo componente. Per ulteriori 
informazioni sulla sostituzione dei componenti, 
rivolgersi al proprio rivenditore.

Qualora l’unità venga spostata rapidamente da un 
ambiente freddo a uno caldo, oppure se la 
temperatura ambiente dovesse aumentare 
improvvisamente, è possibile che si formi umidità 
sulle superfici esterne dell’unità e/o al suo 
interno. Questo fenomeno è denominato 
condensazione. In tal caso, spegnere l’unità ed 
attendere la scomparsa della condensazione 
prima di riavviarla. L’utilizzo dell’unità mentre è 
presente condensazione può causare danni 
all’unità stessa.

Il pannello LCD di cui è dotato l’apparecchio è 
prodotto con tecnologia ad alta precisione che 
consente di ottenere una percentuale di pixel 
funzionanti minima di ben 99,99%. È quindi 
possibile che una piccolissima percentuale dei 
pixel possa rimanere “bloccata”, sempre 
disattivata (nera), sempre attivata (rossa, verde o 
blu) oppure lampeggiante. È inoltre possibile che, 
dopo un lungo periodo d’uso, alcuni pixel si 
“blocchino” spontaneamente a causa delle 
caratteristiche fisiche del display a cristalli 
liquidi. Tali fenomeni non sono il risultato di 
guasti e non hanno alcun effetto sui dati registrati.

Il morsetto della batteria dell’apparecchio (il 
connettore per pacchi batteria e adattatori CA) è 
un prodotto di consumo.
Se i piedini del morsetto sono piegati e deformati 
a causa di urti o vibrazioni, o se vengono corrosi 
a causa di un uso prolungato all’aria aperta, 
l’alimentazione potrebbe non essere fornita 
correttamente.

Si consiglia di eseguire dei controlli periodici per 
assicurare il funzionamento corretto 
dell’apparecchio e prolungarne la vita utile.
Per ulteriori informazioni sui controlli, contattare 
il servizio tecnico o un rappresentante Sony.

Informazioni sulla batteria ricaricabile integrata
Il camcorder è dotato di una batteria ricaricabile 
interna che consente la memorizzazione di data, 
ora e altre impostazioni anche quando è spento. 
Se non è connesso un adattatore CA o il 
camcorder viene utilizzato senza pacco batteria, 
la batteria ricaricabile si scaricherà 
completamente dopo circa 3 mesi. Utilizzare il 
camcorder dopo aver ricaricato la batteria.
Tuttavia, anche se la batteria ricaricabile interna è 
scarica, il funzionamento del camcorder non 
risulta compromesso purché non si registri data e 
ora.

Appendice

Precauzioni per l’uso
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Le impostazioni predefinite sono indicate in grassetto (ad esempio, 2048×1080P (Level A)).

Nota

Se la risoluzione dell’uscita video è superiore a quella dell’immagine, non viene emessa nessuna immagine riprodotta.

Formati di uscita del connettore SDI OUT

Quando Country >NTSC/PAL Area nel menu System è impostato su NTSC Area

Quando si utilizza una configurazione di base (XAVC-I / XAVC-L / MPEG HD)

Formati di uscita e limitazioni

 Formati video e segnali di uscita

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
4096×2160 59.94P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

4096×2160 29.97P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

4096×2160 23.98P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Nessuna uscita

3840×2160 59.94P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

3840×2160 29.97P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

3840×2160 23.98P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Nessuna uscita
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1920×1080 59.94P 2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

– 720×480i Nessuna uscita

– 720×480P Nessuna uscita

1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i 

– 720×480i Nessuna uscita

– 720×480P Nessuna uscita

1920×1080 29.97P 2048×1080PsF – 2048×1080 29.97PsF

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

– 720×480i Nessuna uscita

1920×1080 23.98P 2048×1080PsF – 2048×1080 23.98PsF

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Nessuna uscita

1920×1080i (2-
3PD)

1920×1080i (2-
3PD)

1920×1080 59.94i (2-3PD)

– 720×480i (2-
3PD)

Nessuna uscita

1280×720 59.94P 1280×720P 1280×720P 1280×720 59.94P

– 720×480i Nessuna uscita

– 720×480P Nessuna uscita

1280×720 29.97P 1280×720P 1280×720P 1280×720 59.94P (2-2RP)

– 720×480i Nessuna uscita

1280×720 23.98P 1280×720P (2-
3PD)

1280×720P (2-
3PD)

1280×720 59.94P (2-3PD)

– 720×480i (2-
3PD)

Nessuna uscita

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
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Quando si utilizza un’unità di estensione (RAW)

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI

RAW Output Format
4096×2160 59.94P

Video Format (valore fisso)
1920×1080 59.94P

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
4096×2160 59.94P

Video Format (valore fisso)
1280×720 59.94P

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
2048×1080 59.94P

Video Format (valore fisso)
1920×1080 59.94P 

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
2048×1080 59.94P

Video Format (valore fisso)
1280×720 59.94P 

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
4096×2160 29.97P

Video Format (valore fisso)
1920×1080 29.97P

2048×1080PsF – 2048×1080 29.97PsF

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

RAW Output Format
2048×1080 29.97P

Video Format (valore fisso)
1920×1080 29.97P 

2048×1080PsF – 2048×1080 29.97PsF

1920×1080PsF 1920×1080i 1920×1080 29.97PsF
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Quando si utilizza un’unità di estensione (ProRes 422)

*1 Non può emettere un segnale compatibile con l’adattatore CBK-WA100.

Quando Country >NTSC/PAL Area nel menu System è impostato su PAL Area

Quando si utilizza una configurazione di base (XAVC-I / XAVC-L / MPEG HD)

RAW Output Format
4096×2160 23.98P

Video Format (valore fisso)
1920×1080 23.98P

2048×1080PsF – 2048×1080 23.98PsF

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Nessuna uscita

RAW Output Format
2048×1080 23.98P

Video Format (valore fisso)
1920×1080 23.98P

2048×1080PsF – 2048×1080 23.98PsF

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Nessuna uscita

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i

1920×1080 29.97P 1920×1080PsF 1920×1080i SDI OUT 1
1920×1080 29.97P

SDI OUT 2
1920×1080 29.97PsF

1920×1080 23.98P 1920×1080P 1920×1080P 1920×1080 23.98P*1

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
4096×2160 50P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

4096×2160 25P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
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3840×2160 50P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

3840×2160 25P – 4096×2160P Nessuna uscita

– 3840×2160P Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF

1920×1080 50P 2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

– 720×576i Nessuna uscita

– 720×576P Nessuna uscita

1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

– 720×576i Nessuna uscita

– 720×576P Nessuna uscita

1920×1080 25P 2048×1080PsF – 2048×1080 25PsF

1920×1080PsF 1920×1080i 1920×1080 25PsF

– 720×576i Nessuna uscita

1280×720 50P 1280×720P 1280×720P 1280×720 50P

– 720×576i Nessuna uscita

– 720×576P Nessuna uscita

1280×720 25P 1280×720P 1280×720P 1280×720 50P (2-2RP)

– 720×576i Nessuna uscita

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
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Quando si utilizza un’unità di estensione (RAW)

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI

RAW Output Format
4096×2160 50P

Video Format (valore fisso)
1920×1080 50P

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

RAW Output Format
4096×2160 50P

Video Format (valore fisso)
1280×720 50P 

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1280×720P 1280×720P 1280×720 50P

RAW Output Format
2048×1080 50P

Video Format (valore fisso)
1920×1080 50P

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

RAW Output Format
2048×1080 50P

Video Format (valore fisso)
1280×720 50P 

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1280×720P 1280×720P 1280×720 50P

RAW Output Format
4096×2160 25P

Video Format (valore fisso)
1920×1080 25P 

2048×1080PsF – 2048×1080 25PsF

1920×1080PsF 1920×1080i 1920×1080 25PsF

RAW Output Format
2048×1080 25P

Video Format (valore fisso)
1920×1080 25P 

2048×1080PsF – 2048×1080 25PsF

1920×1080PsF 1920×1080i 1920×1080 25PsF
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Quando si utilizza un’unità di estensione (ProRes 422)

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita SDI

SDI HDMI
1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

1920×1080 25P 1920×1080PsF 1920×1080PsF SDI OUT 1
1920×1080 25P

SDI OUT 2
1920×1080 25PsF
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Formati di uscita per il connettore HDMI OUT

Quando Country >NTSC/PAL Area nel menu System è impostato su NTSC Area

Quando si utilizza una configurazione di base (XAVC-I / XAVC-L / MPEG HD)

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
4096×2160 59.94P – 4096×2160P 4096×2160 59.94P

– 3840×2160P 3840×2160 59.94P

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i

4096×2160 29.97P – 4096×2160P 4096×2160 29.97P

– 3840×2160P 3840×2160 29.97P

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

4096×2160 23.98P – 4096×2160P 4096×2160 23.98P

– 3840×2160P 3840×2160 23.98P

1920×1080PsF – Nessuna uscita

– 1920×1080P 1920×1080 23.98P (Pure)

3840×2160 59.94P – 4096×2160P 4096×2160 59.94P

– 3840×2160P 3840×2160 59.94P

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i

3840×2160 29.97P – 4096×2160P 4096×2160 29.97P

– 3840×2160P 3840×2160 29.97P

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

3840×2160 23.98P – 4096×2160P 4096×2160 23.98P

– 3840×2160P 3840×2160 23.98P

1920×1080PsF – Nessuna uscita

– 1920×1080P 1920×1080 23.98P (Pure)

1920×1080 59.94P 2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i

– 720×480i 720×480 59.94i

– 720×480P 720×480 59.94P
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Quando si utilizza un’unità di estensione (RAW)

1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i

– 720×480i 720×480 59.94i

– 720×480P 720×480 59.94P

1920×1080 29.97P 2048×1080PsF – Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

– 720×480i 720×480 59.94i (PsF)

1920×1080 23.98P 2048×1080PsF – Nessuna uscita

1920×1080PsF – Nessuna uscita

– 1920×1080P 1920×1080 23.98P (Pure)

1920×1080i (2-
3PD)

1920×1080i (2-
3PD)

1920×1080 59.94i (2-3PD)

– 720×480i (2-
3PD)

720×480 59.94i (2-3PD)

1280×720 59.94P 1280×720P 1280×720P 1280×720 59.94P

– 720×480i 720×480 59.94i

– 720×480P 720×480 59.94P

1280×720 29.97P 1280×720P 1280×720P 1280×720 59.94P (2-2RP)

– 720×480i 720×480 59.94i (PsF)

1280×720 23.98P 1280×720P (2-
3PD)

1280×720P (2-
3PD)

1280×720 59.94P (2-3PD)

– 720×480i (2-
3PD)

720×480 59.94i

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI

RAW Output Format
4096×2160 59.94P

Video Format (valore fisso)
1920×1080 59.94P

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
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RAW Output Format
4096×2160 59.94P

Video Format (valore fisso)
1280×720 59.94P

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
2048×1080 59.94P

Video Format (valore fisso)
1920×1080 59.94P 

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
2048×1080 59.94P

Video Format (valore fisso)
1280×720 59.94P 

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Nessuna uscita

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
4096×2160 29.97P

Video Format (valore fisso)
1920×1080 29.97P 

2048×1080PsF – Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

RAW Output Format
2048×1080 29.97P

Video Format (valore fisso)
1920×1080 29.97P

2048×1080PsF – Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

RAW Output Format
4096×2160 23.98P

Video Format (valore fisso)
1920×1080 23.98P

2048×1080PsF – Nessuna uscita

1920×1080PsF – Nessuna uscita

– 1920×1080P 1920×1080 23.98P (Pure)

RAW Output Format
2048×1080 23.98P

Video Format (valore fisso)
1920×1080 23.98P

2048×1080PsF – Nessuna uscita

1920×1080PsF – Nessuna uscita

– 1920×1080P 1920×1080 23.98P (Pure)

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
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Quando si utilizza un’unità di estensione (ProRes 422)

Quando Country >NTSC/PAL Area nel menu System è impostato su PAL Area

Quando si utilizza una configurazione di base (XAVC-I / XAVC-L / MPEG HD)

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i

1920×1080 29.97P 1920×1080PsF 1920×1080i 1920×1080 29.97PsF

1920×1080 23.98P 1920×1080P 1920×1080P 1920×1080 23.98P (Pure)

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
4096×2160 50P – 4096×2160P 4096×2160 50P

– 3840×2160P 3840×2160 50P

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i

4096×2160 25P – 4096×2160P 4096×2160 25P

– 3840×2160P 3840×2160 25P

1920×1080PsF 1920×1080i 1920×1080 25PsF

3840×2160 50P – 4096×2160P 4096×2160 50P

– 3840×2160P 3840×2160 50P

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i

3840×2160 25P – 4096×2160P 4096×2160 25P

– 3840×2160P 3840×2160 25P

1920×1080PsF 1920×1080i 1920×1080 25PsF

1920×1080 50P 2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i

– 720×576i 720×576 50i

– 720×576P 720×576 50P
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Quando si utilizza un’unità di estensione (RAW)

1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

– 720×576i 720×576 50i

– 720×576P 720×576 50P

1920×1080 25P 2048×1080PsF – Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 50i (PsF)

– 720×576i 720×576 50i (PsF)

1280×720 50P 1280×720P 1280×720P 1280×720 50P

– 720×576i 720×576 50i

– 720×576P 720×576 50P

1280×720 25P 1280×720P 1280×720P 1280×720 50P (2-2RP)

– 720×576i 720×576 50i (PsF)

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI

RAW Output Format
4096×2160 50P

Video Format (valore fisso)
1920×1080 50P

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i

RAW Output Format
4096×2160 50P

Video Format (valore fisso)
1280×720 50P 

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1280×720P 1280×720P 1280×720 50P

RAW Output Format
2048×1080 50P

Video Format (valore fisso)
1920×1080 50P

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1920×1080i 1920×1080i 1920×1080 50i

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
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Quando si utilizza un’unità di estensione (ProRes 422)

RAW Output Format
2048×1080 50P

Video Format (valore fisso)
1280×720 50P 

2048×1080P 
(Level A)

– Nessuna uscita

2048×1080P 
(Level B)

– Nessuna uscita

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Nessuna uscita

1280×720P 1280×720P 1280×720 50P

RAW Output Format
4096×2160 25P

Video Format (valore fisso)
1920×1080 25P 

2048×1080PsF – Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF

RAW Output Format
2048×1080 25P

Video Format (valore fisso)
1920×1080 25P 

2048×1080PsF – Nessuna uscita

1920×1080PsF 1920×1080i 1920×1080 25PsF

Impostazioni del formato di 
registrazione
(Rec Format >Video Format nel menu 
System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

1920×1080 25P 1920×1080PsF 1920×1080i 1920×1080 50i (PsF)

Impostazioni del formato di 
registrazione
(Rec Format >RAW Output Format e 
Video Format nel menu System)

Impostazioni di uscita SDI/
HDMI
(Output Format >SDI e HDMI 
nel menu Video)

Segnale di uscita HDMI

SDI HDMI
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Impostazioni di uscita HDMI per dispositivi HDMI

Note

• Se con il cambiamento di HDMI Target Device le impostazioni correnti di Output Display diventano non più 
disponibili, tali impostazioni cambieranno come segue.
- Viene impostato automaticamente il valore predefinito.
- Se il valore predefinito non può essere selezionato, viene impostato automaticamente “SDI=On, HDMI=On.”

• HDMI Target Device non può essere impostato su Recorder se Codec è impostato su ProRes.

Stati in cui Monitor LUT non può essere configurato indipendentemente
Nei seguenti casi, Monitor LUT >SDI2, HDMI e Viewfinder nel menu Video non possono essere 
impostate individualmente. Sono sincronizzate con l’impostazione SDI1 & Internal Rec.

- Quando Output Format >HDMI nel menu Video è 4096×2160 o 3840×2160
- Quando S&Q Motion >Setting nel menu Recording è On
- Quando Lens >Distortion Comp. nel menu System è Auto

Stati in cui non può essere visualizzato Video Signal Monitor
• Per utilizzare Video Signal Monitor, è necessario abilitare l’uscita SDI. La risoluzione di uscita, inoltre, 

non può essere superiore a 2K. Verificare le seguenti impostazioni:
- Output On/Off >SDI nel menu Video
- Output Format >SDI nel menu Video

• Nei casi indicati di seguito, Video Signal Monitor non può essere visualizzato nel mirino.
- Quando il bordo dell’uscita SDI è tagliato mediante le opzioni Output Setting >4K/2K to HD Conv. 

nel menu Video
- Quando sono presenti impostazioni di MLUT On e MLUT Off diverse in Monitor LUT >SDI1 & 

Internal Rec, SDI2, HDMI e Viewfinder nel menu Video

Output Setting >HDMI Target 
Device nel menu Video

Output Display >SDI/HDMI nel 
menu Video

Uscita HDMI

OSD On/Off MLUT On/Off

Recorder (predefin.) SDI=On, HDMI=On (predefin.)
* In grigio, non selezionabile.

– Segue SDI1

SDI=On, HDMI=Off Off

SDI=Off, HDMI=Off Off

Monitor SDI=On, HDMI=On (predefin.) On Segue SDI2

SDI=On, HDMI=Off
* In grigio, non selezionabile.

–

SDI=Off, HDMI=Off Off
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Qualora si verifichino avvisi, avvertenze o condizioni che richiedono una conferma, il mirino del 
camcorder visualizza un messaggio, gli indicatori di registrazione iniziano a lampeggiare e viene emesso 
un segnale acustico.
Il segnale acustico di avvertimento viene emesso dall’altoparlante integrato e sul connettore cuffie. 

Il camcorder si arresterà nel caso abbia luogo una condizione che causa la visualizzazione di un messaggio 
del tipo seguente.

Qualora vengano visualizzati i seguenti messaggi, eseguire le procedure indicate.

Avvisi durante l’utilizzo

Messaggi di errore

Messaggio sul 
mirino

Segnale 
acustico 
di avverti-
mento

Indicatore di 
registrazione

Causa e soluzione

E + codice d’errore Continuo Lampeggia 
rapidamente

Indica un’anomalia del camcorder. La registrazione si arresta, 
anche se il mirino continua a visualizzare zREC.
Spegnere il camcorder e verificare eventuali problemi nei 
dispositivi collegati, cavi o supporti di memorizzazione. Se il 
messaggio d’errore persiste dopo aver riacceso il camcorder, 
rivolgersi al proprio rappresentante di assistenza tecnica Sony.
(Se il camcorder non si spegne spostando su OFF 
l’interruttore di alimentazione POWER, rimuovere la batteria 
o scollegare l’alimentazione dal connettore DC IN).

Messaggi di avvertimento

Messaggio sul 
mirino

Segnale 
acustico 
di avverti-
mento

Indicatore di 
registrazione

Causa e soluzione

Media Near Full Intermittente Lampeggiante La capacità rimanente sulla scheda di memoria XQD si sta 
esaurendo. 
Sostituire non appena possibile.

Media Full Continuo Lampeggia 
rapidamente

Non è possibile registrare, copiare o dividere clip perché la 
capacità rimanente sulla scheda XQD è insufficiente.
Sostituire immediatamente.

Battery Near End Intermittente Lampeggiante La carica rimanente del pacco batteria si sta esaurendo.
Ricaricare non appena possibile.

Battery End Continuo Lampeggia 
rapidamente

Il pacco batteria è scarico. La registrazione è disabilitata.
Arrestare le operazioni e sostituire il pacco batteria.

Temperature High Intermittente Lampeggiante La temperatura interna è elevata.
Spegnere il camcorder e lasciarlo raffreddare prima di 
utilizzarlo nuovamente.
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Voltage Low Intermittente Lampeggiante La tensione sul connettore DC IN è bassa (livello 1). 
Controllare la sorgente di alimentazione.

Insufficient Voltage Continuo Lampeggia 
rapidamente

La tensione sul connettore DC IN è insufficiente (livello 2). 
La registrazione è disabilitata.
Collegare un’altra sorgente di alimentazione.

Messaggio sul 
mirino

Segnale 
acustico 
di avverti-
mento

Indicatore di 
registrazione

Causa e soluzione
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Al centro dello schermo potranno essere visualizzati i seguenti messaggi di avviso e operativi. Seguire le 
istruzioni fornite per risolvere il problema.

1) Per la scheda nello slot B si visualizza “Media(B)”.

Messaggi di avviso e operativi

Messaggio sul mirino Causa e soluzione
Battery Error
Please Change Battery

È stata rilevata un’anomalia nel pacco batteria.
Sostituire con un pacco batteria normale.

Backup Battery End
Please Change

La carica della batteria di backup è insufficiente.
Caricare la batteria di backup.

Unknown Media(A)1)

Please Change

È stata inserita una scheda di memoria che è stata partizionata oppure 
una scheda di memoria contenente un numero di clip superiore al 
massimo gestibile da questo camcorder.
La scheda non può essere utilizzata nel camcorder e deve essere 
sostituita.

Cannot Use Media(A)1)

Unsupported File System

È stata inserita una scheda con un file system diverso oppure non 
formattata.
La scheda non può essere utilizzata nel camcorder e deve essere 
sostituita oppure formattata con il camcorder.

Media Error

Media(A)1) Needs to be Restored

Si è verificato un errore sulla scheda di memoria e la scheda deve essere 
ripristinata.
Ripristinare la scheda di memoria.

Media Error

Cannot Record to Media(A)1)

La scheda di memoria potrebbe essere danneggiata e non può essere 
utilizzata per la registrazione.
La riproduzione è possibile, è consigliabile quindi eseguire una copia e 
sostituire la scheda di memoria.

Media Error

Cannot Use Media(A)1)

La scheda di memoria potrebbe essere danneggiata e non può essere 
utilizzata per la registrazione o la riproduzione.
La scheda non può essere utilizzata nel camcorder e deve essere 
sostituita.

Media(A)1) Error
Recording Halted
Playback Halted

La registrazione e la riproduzione sono state arrestate a causa di un 
errore durante l’utilizzo della scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.

Media Reached Rewriting Limit

Change Media (A)1) 

La scheda di memoria ha raggiunto la fine della sua vita utile.
Eseguire un backup e sostituire la scheda immediatamente. Se si 
continua a utilizzare la scheda è possibile che la scheda non consenta più 
l’esecuzione di registrazioni o riproduzioni.

Per ulteriori informazioni, consultare le istruzioni per l’uso della 
scheda di memoria.

Fan Stopped La ventola di raffreddamento si è arrestata.
Evitare l’utilizzo a temperature elevate. Scollegare l’alimentazione e 
contattare il rappresentante di assistenza tecnica Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

Le impostazioni di formato di Clip Naming sono state ripristinate perché 
è stato caricato un file ALL non valido.
Configurare le impostazioni di formato desiderate e provare a salvare il 
file ALL di nuovo.
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QUESTO PRODOTTO È SOGGETTO A 
LICENZA AVC PATENT PORTFOLIO PER 
USO PERSONALE E NON COMMERCIALE 
DEL CLIENTE O ALTRI USI PER I QUALI 
NON SI RICEVE ALCUN COMPENSO PER

(i) CODIFICARE VIDEO IN CONFORMITÀ 
ALLO STANDARD AVC (“AVC VIDEO”) 
E/O

(ii) DECODIFICARE VIDEO AVC 
CODIFICATO DA UN CLIENTE 
IMPEGNATO IN ATTIVITÀ PERSONALE 
E/O OTTENUTO DA UN PROVIDER 
VIDEO CON LICENZA PER FORNIRE 
VIDEO AVC.

NESSUNA LICENZA È CONCESSA O È DA 
RITENERSI IMPLICITA PER ALTRO USO. 
ULTERIORI INFORMAZIONI SONO 
DISPONIBILI PRESSO MPEG LA, L.L.C. 
VISITARE IL SITO 
HTTP://WWW.MPEGLA.COM

EVENTUALI USI DEL PRODOTTO DIVERSI 
DALL’USO PERSONALE DEL 
CONSUMATORE CHE RISPETTINO LO 
STANDARD MPEG-2 PER LA CODIFICA DI 
INFORMAZIONI VIDEO PER I MEDIA 
IMPACCHETTATI SONO ESPLICITAMENTE 
VIETATI SENZA UNA LICENZA AI SENSI 
DEI BREVETTI APPLICABILI NELLA 
RACCOLTA DI BREVETTI MPEG-2, TALE 
LICENZA È DISPONIBILE DA MPEG LA, 
L.L.C., 250 STEELE STREET, SUITE 300, 
DENVER, COLORADO 80206. 
“MEDIA IMPACCHETTATI” si riferisce a 
qualsiasi dispositivo di archiviazione che 
contenga informazioni video MPEG-2 come film 
in DVD che siano venduti/distribuiti ai 
consumatori generici. I duplicatori di dischi 
oirivenditori di MEDIA IMPACCHETTATI 

devono ottenere una licenza per le loro attività da 
MPEG LA. Contattare la MPEG LA per ulteriori 
informazioni. MPEG LA. L.L.C., 250 STEELE 
STREET, SUITE 300, DENVER, COLORADO 
80206 http://www.mpegla.com

Questo prodotto utilizza software a cui si 
applicano le licenze GPL/LGPL. Questa nota ha 
lo scopo di informare l’utente del suo diritto di 
accesso, modifica e ridistribuzione del codice 
sorgente per tali programmi software secondo le 
condizioni stabilite dalle licenze GPL/LGPL.
Il codice sorgente è fornito su Internet. Per il 
download, utilizzare il seguente URL e seguire le 
istruzioni.
http://www.sony.net/Products/Linux/common/
search.html

Preferiremmo non essere contattati relativamente 
al contenuto del codice sorgente.

Per i contenuti di queste licenze, vedere 
“License1.pdf” nella cartella “License” del CD-
ROM fornito.

Per visualizzare i file PDF deve essere installato 
Adobe Reader sul computer.
Se Adobe Reader non è installato sul computer, è 
possibile scaricarlo accedendo al seguente URL.
http://get.adobe.com/reader/

Licenze

Licenza MPEG-4 AVC Patent 
Portfolio

Licenza MPEG-2 Video Patent 
Portfolio

Ottenere software sotto licenza 
GPL/LGPL
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IMPORTANT: 
BEFORE USING THE SOFTWARE 
CONTAINED IN THE SOLID STATE 
MEMORY CAMCORDER, PLEASE READ 
THIS END USER LICENSE AGREEMENT 
(“EULA”) CAREFULLY. BY USING THE 
SOFTWARE YOU ARE ACCEPTING THE 
TERMS OF THIS EULA. IF YOU DO NOT 
ACCEPT THE TERMS OF THIS EULA, YOU 
MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and 
Sony Corporation (“SONY”). This EULA 
governs your rights and obligations regarding the 
software of SONY and/or its third party licensors 
(including SONY’s affiliates) and their respective 
affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, 
together with any updates/ upgrades provided by 
SONY, any printed, on-line or other
electronic documentation for such software, and 
any data files created by operation of such 
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user 
license agreement (including, but not limited to, 
GNU General Public license and Lesser/Library 
General Public License) shall be covered by such 
applicable separate end user license agreement in 
lieu of the terms of this EULA to the extent 
required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties.

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, music, text 
and “applets” incorporated into the SOFTWARE) 
is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the 
wireless adapter and only for your individual use. 
SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual 
property rights) in and to the SOFTWARE that 
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or 
create any derivative works from or of the 
SOFTWARE unless such derivative works are 
intentionally facilitated by the SOFTWARE. You 
may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. 
You may not bypass, modify, defeat or 
circumvent any of the functions or protections of 
the SOFTWARE or any mechanisms operatively 
linked to the SOFTWARE. You may not separate 
any individual component of the SOFTWARE 
for use on more than one wireless adapter unless 
expressly authorized to do so by SONY. You may 
not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not 
share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, 
network services or other products other than 
SOFTWARE upon which the SOFTWARE’S 
performance depends might be interrupted or 
discontinued at the discretion of the suppliers 
(software suppliers, service suppliers, or SONY). 
SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other 
products will continue to be available, or will 
operate without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN 
SOURCE COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 
EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 
Components”), which means any software 
licenses approved as open source licenses by the 
Open Source Initiative or any substantially 
similar licenses, including but not limited to any 
license that, as a condition of distribution of the 

CONTRATTO DI LICENZA CON 
L’UTENTE FINALE
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software licensed under such license, requires 
that the distributor make the software available in 
source code format. If and to the extent disclosure 
is required, please visit www.sony.com/linux or 
other SONY-designated web site for a list of 
applicable OPEN SOURCE COMPONENTS 
included in the SOFTWARE from time to time, 
and the applicable terms and conditions 
governing its use. Such terms and conditions may 
be changed by the applicable third party at any 
time without liability to you. To the extent 
required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the 
extent the terms of the licenses applicable to 
EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will 
not apply to such EXCLUDED SOFTWARE. To 
the extent the terms of the licenses applicable to 
Open Source Components require SONY to make 
an offer to provide source code in connection with 
the SOFTWARE, such offer is hereby made. 

USE OF SOFTWARE WITH 
COPYRIGHTED MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
content. You acknowledge and agree that SONY 
may take appropriate measures to protect the 
copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are 
not limited to, counting the frequency of your 
backup and restoration through certain 
SOFTWARE features, refusal to accept your 
request to enable restoration of data, and 
termination of this EULA in the event of your 
illegitimate use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE 
SOFTWARE MAY BE DESIGNED TO BE 
USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF 
THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU 

DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE 
LIMITED. You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties 
over which SONY has no control. USE OF THE 
CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT 
SERVICE MAY BE DISCONTINUED AT ANY 
TIME.

INTERNET CONNECTIVITY AND THIRD 
PARTY SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible. 
Further, you are solely responsible for payment of 
any third party fees associated with your Internet 
connection, including but not limited to Internet 
service provider or airtime charges. Operation of 
the SOFTWARE may be limited or restricted 
depending on the capabilities, bandwidth or 
technical limitations of your Internet connection 
and service. The provision, quality and security of 
such Internet connectivity are the sole 
responsibility of the third party providing such 
service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of the 
area or country in which you reside, and not to 
transfer, or authorize the transfer, of the 
SOFTWARE to a prohibited country or otherwise 
in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, 
aircraft navigation or communication systems, air 
traffic control, direct life support machines, or 
weapons systems, in which the failure of the 
SOFTWARE could lead to death, personal injury, 
or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of 
the THIRD-PARTY SUPPLIERS, and each of 
their respective affiliates specifically disclaim 
any express or implied warranty, duty or 
condition of fitness for HIGH RISK 
ACTIVITIES.
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EXCLUSION OF WARRANTY ON 
SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you are 
responsible for use of the SOFTWARE. The 
SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, 
EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A 
PARTICULAR PURPOSE. SONY DOES NOT 
WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE 
SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF 
ANY OF THE SOFTWARE WILL BE 
CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT 
THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, 
NETWORK SERVICES (INCLUDING THE 
INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS 
WILL CONTINUE TO BE AVAILABLE, 
UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR 
OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN 
AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE 
THE SCOPE OF THIS WARRANTY. SHOULD 
THE SOFTWARE PROVE DEFECTIVE YOU 
ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR 

CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS 
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR BREACH OF ANY EXPRESS 
OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL 
THEORY RELATED TO THE
SOFTWARE, INCLUDING, BUT NOT 
LIMITED TO, ANY DAMAGES ARISING 
OUT OF LOSS OF PROFITS, LOSS OF 
REVENUE, LOSS OF DATA, LOSS OF USE 
OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER’ S 
TIME, EVEN IF ANY OF THEM HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. IN ANY CASE, EACH AND ALL 
OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE 
LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME 
JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION 
OR LIMITATION MAY NOT APPLY TO 
YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but 
not limited to information about (i) the 
SOFTWARE and (ii) the software applications, 
contents and peripheral devices that interact with 
your wireless adapter and the SOFTWARE 
(“Information”). Information includes, but is not 
limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) 
performance of the wireless adapter, the 
SOFTWARE and their components; (3) 
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configurations of your wireless adapter, the 
SOFTWARE and the software applications, 
contents and peripheral devices that interact with 
the wireless adapter and the SOFTWARE; (4) use 
and frequency of use of the functions of (x) the 
SOFTWARE, and (y) the software applications, 
contents and peripheral devices that interact with 
the SOFTWARE; and (5) location data, as 
indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information 
subject to applicable laws in order to improve its 
products and services or to provide products or 
services to you. Such uses include, but are not 
limited to: (a) administering the functionalities of 
the SOFTWARE; (b) to improve, service, update 
or upgrade the SOFTWARE; (c) improving, 
developing and enhancing the current and future 
products and services of SONY and other parties; 
(d) to provide you with information about the 
products and services offered by SONY and other 
parties; (e) complying with applicable laws or 
regulations; and (f) to the extent offered, 
providing you with location-based services of 
SONY and other parties, as indicated below. In 
addition, SONY retains the right to use 
Information to protect itself and third parties from 
illegal, criminal or harmful conduct.

Certain services available through the 
SOFTWARE may rely upon location 
information, including, but not limited to, the 
geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing 
such services, SONY, the THIRDPARTY 
SUPPLIERS or their partners may collect, 
archive, process and use such location data, and 
that such services are governed by the privacy 
policies of SONY or such third party. By 
reviewed the privacy policies applicable to such 
services and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally 
identify the owner or user of the SOFTWARE 
without your knowledge or consent. Any use of 
Information will be in accordance with the 
privacy policies of SONY or such third party. 

Please contact applicable contact address of each 
area or country for SONY’ s current privacy 
policy. Please contact applicable third parties for 
privacy policies relating to personally identifiable 

and other information you provide when you use 
or access third party software or services. 

Information may be processed, stored or 
transferred to SONY, its affiliates or agents which 
are located in countries outside of your country of 
residence. Data protection and information 
privacy laws in certain countries may not offer the 
same level of protection as your country of 
residence and you may have fewer legal rights in 
relation to Information processed and stored in, or 
transferred to, such countries. SONY will use 
reasonable efforts to take appropriate technical 
and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does 
not warrant it will eliminate all risk of misuse of 
such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or 
otherwise modify the SOFTWARE, including, 
but not limited to, for purposes of enhancement of 
security functions, error correction and 
improvement of functions, at such time as you 
interact with SONY’ s or third parties’ servers, or 
otherwise. Such updates or modifications may 
delete or change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities may 
occur at SONY’ s sole discretion and that SONY 
may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of 
such update or modifications. Any updates/
modifications shall be deemed to be, and shall 
constitute part of, the SOFTWARE for purposes 
of this EULA. By acceptance of this EULA, you 
consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, 
SEVERABILITY
This EULA and SONY’ s privacy policy, each as 
amended and modified from time to time, 
together constitute the entire agreement between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce any 
right or provision of this EULA shall not 
constitute a waiver of such right or provision. If 
any part of this EULA is held invalid, illegal, or 
unenforceable, that provision shall be enforced to 
the maximum extent permissible so as to maintain 
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the intent of this EULA, and the other parts will 
remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for 
the International Sale of Goods shall not apply to 
this EULA. This EULA shall be governed by the 
laws of Japan, without regards to conflict of laws
provisions. Any dispute arising out of this EULA 
shall be subject to the exclusive venue of the 
Tokyo District Court in Japan, and the parties 
hereby consent to the venue and jurisdiction of 
such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or noncompliance with 
this EULA by you will cause irreparable harm to 
SONY, for which monetary damages would be 
inadequate, and you consent to SONY obtaining 
any injunctive or equitable relief that SONY 
deems necessary or appropriate in such 
circumstances. SONY may also take any legal 
and technical remedies to prevent violation of 
and/or to enforce this EULA, including, but not 
limited to, immediate termination of your use of 
the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to 
violate this EULA. These remedies are in addition 
to any other remedies SONY may have at law, in 
equity or under contract.

TERMINATION
Without prejudice to any of its other rights, 
SONY may terminate this EULA if you fail to 
comply with any of its terms. In case of such 
termination, you must: (i) cease all use, and 
destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section 
below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE 
ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL 
ADDRESS PROVIDED BY YOU, BY 
PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN 
UPGRADES/ UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, 

you should promptly contact SONY for 
instructions. Your continued use of the 
SOFTWARE after the effective date of any such 
notice shall be deemed your agreement to be 
bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended thirdparty beneficiary of, and shall have 
the right to enforce, each provision of this EULA 
with respect to the SOFTWARE of such party. 

Should you have any questions concerning this 
EULA, you may contact SONY by writing to 
SONY at applicable contact address of each area 
or country.

Copyright © 2012 Sony Corporation.

Sulla base degli accordi di licenza fra Sony e i 
detentori dei diritti di copyright del software, 
questo prodotto utilizza software aperto.
Per soddisfare i requisiti stabiliti dai detentori dei 
diritti di copyright sul software, Sony è tenuta a 
informare gli utenti del contenuto di dette licenze.
Per i contenuti di queste licenze, vedere 
“License1.pdf” nella cartella “License” del 
CD-ROM fornito.

Licenze Open Software
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Peso Circa 2,0 kg (solo corpo)
Dimensioni

(Solo corpo: mm)1) 

1) Le dimensioni indicate sono approssimative.

Requisiti di alimentazione
12 Vcc (da 11,0 V a 17,0 V)

Consumo energetico
Circa 19 W (corpo, obiettivo 
SELP28135G, registrazione XAVC-I 
QFHD 59.94P, mirino acceso)

Temperatura di esercizio
Da 0 °C a 40 °C

Temperatura di immagazzinamento
Da −20 °C a +60 °C

Tempo di funzionamento continuato
Circa 60 minuti (con pacco batteria 
BP-U30)

Formato di registrazione video
XAVC Intra 
AVC/H.264 High 4:2:2 Intra Profile
QFHD: VBR, 600 Mbps max.
4K: VBR, 600 Mbps max.
HD: CBG, 222 Mbps

XAVC Long 
AVC/H.264 High Profile
QFHD: VBR, 150 Mbps max., 4:2:0, 
Long
HD: VBR, 50 Mbps max., 4:2:2, Long
MPEG HD422 
MPEG-2 Long GOP
Modalità HD422: CBR, 50 Mbps, 
MPEG-2 422P@HL
ProRes 422 HQ 1)

Apple ProRes 422 HQ
4:2:2, 10-bit, VBR, 220 Mbps max.
ProRes 422 1)

Apple ProRes 422
4:2:2, 10-bit, VBR, 147 Mbps max.

Formato di registrazione audio
LPCM 24-bit, 48 kHz, 4 canali

Frequenza di fotogrammi di registrazione
XAVC Intra 
4096 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
3840 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
1920 × 1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P
XAVC Long 
3840 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
1920 × 1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P
MPEG HD 422 
1920 × 1080/59.94i, 50i, 29.97P, 
23.98P, 25P
1280 × 720/59.94P, 50P, 29.97P, 
23.98P, 25P
ProRes 422 HQ 1)

1920 × 1080/59.94i, 50i, 29.97P, 25P, 
23.98P
ProRes 422 1)

1920 × 1080/59.94i, 50i, 29.97P, 25P, 
23.98P

Tempo di registrazione/riproduzione
XAVC Intra 4096 × 2160/3840 × 2160 
59.94P

Circa 22 minuti: Con QD-G128A
Circa 11 minuti: Con QD-G64A

50P
Circa 26 minuti: Con QD-G128A
Circa 13 minuti: Con QD-G64A

Specifiche tecniche

Generale

247

23
9

15
6
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29.97P
Circa 44 minuti: Con QD-G128A
Circa 22 minuti: Con QD-G64A

23.98P
Circa 55 minuti: Con QD-G128A
Circa 27 minuti: Con QD-G64A

25P
Circa 52 minuti: Con QD-G128A
Circa 26 minuti: Con QD-G64A

XAVC Intra 1920 × 1080 
59.94P

Circa 59 minuti: Con QD-G128A
Circa 30 minuti: Con QD-G64A

50P
Circa 71 minuti: Con QD-G128A
Circa 35 minuti: Con QD-G64A

59.94i
Circa 118 minuti: Con QD-G128A
Circa 59 minuti: Con QD-G64A

50i
Circa 141 minuti: Con QD-G128A
Circa 70 minuti: Con QD-G64A

29.97P
Circa 118 minuti: Con QD-G128A
Circa 59 minuti: Con QD-G64A

23.98P
Circa 147 minuti: Con QD-G128A
Circa 74 minuti: Con QD-G64A

25P
Circa 141 minuti: Con QD-G128A
Circa 70 minuti: Con QD-G64A

XAVC Long 3840 × 2160 
59.94P/50P

Circa 87 minuti: Con QD-G128A
Circa 44 minuti: Con QD-G64A

29.97P/23.98P/25P
Circa 131 minuti: Con QD-G128A
Circa 66 minuti: Con QD-G64A

XAVC Long 1920 × 1080 
Modalità 50M

Circa 262 minuti: Con QD-G128A
Circa 131 minuti: Con QD-G64A

Modalità 35M
Circa 374 minuti: Con QD-G128A
Circa 187 minuti: Con QD-G64A

Modalità 25M
Circa 524 minuti: Con QD-G128A
Circa 262 minuti: Con QD-G64A

MPEG HD 422 
Circa 262 minuti: Con QD-G128A
Circa 131 minuti: Con QD-G64A

ProRes 422 HQ 1)

59.94i/29.97P
Circa 60 minuti: Con QD-G128A
Circa 30 minuti: Con QD-G64A

50i/25P
Circa 72 minuti: Con QD-G128A
Circa 36 minuti: Con QD-G64A

23.98P
Circa 74 minuti: Con QD-G128A
Circa 37 minuti: Con QD-G64A

ProRes 422 1)

59.94i/29.97P
Circa 90 minuti: Con QD-G128A
Circa 45 minuti: Con QD-G64A

50i/25P
Circa 108 minuti: Con QD-G128A
Circa 54 minuti: Con QD-G64A

23.98P
Circa 112 minuti: Con QD-G128A
Circa 56 minuti: Con QD-G64A

1) Quando è connessa l’unità di estensione 
XDCA-FS7 (opzione)

Nota

I tempi di registrazione e riproduzione potrebbero 
variare a seconda delle condizioni di utilizzo e delle 
caratteristiche della memoria.

Dispositivo di generazione immagine (tipo)
Sensore immagine CMOS equivalente a 
Super 35

Numero di pixel
11,6 Megapixel (totali), 
8,8 Megapixel@17:9/
8,3 Megapixel@16:9 (effettivi)

Filtri ND
1: Trasparente
2: 1/4ND
3: 1/16ND
4: 1/64ND

Sensibilità
Gamma video: T14 a 24p
(2000 lx, 89,9% riflettanza, 3200K)

Sezione videocamera
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Sensibilità ISO
S-Log3 Gamma ISO2000 (sorgente 
luminosa D55)

Illuminazione minima
0,7 lx (18 dB, 23.98P, Shutter: OFF, ND 
Clear, F1.4)

Attacco obiettivo
E-mount

Latitudine
14 stop

Rapporto S/N video
57 dB (Gamma video/soppressione 
rumore: off)

Velocità otturatore
Da 1/3 a 1/9000 sec. (23.98P)

Angolo otturatore
Da 4,2° a 359,7°
Da 5,6° a 180° (23.98P)
Da 5,6° a 216° (59.94P)
Da 5,6° a 300° (50P)

Slow & Quick Motion
XAVC QFHD: Da 1 a 60P, 
XAVC HD: Da 1 a 180P

Bilanciamento del bianco
Modalità preset, modalità memoria A, B 
(da 1500K a 50000K)

Guadagno
−3, 0, 3, 6, 9, 12, 18 dB

Curva di gamma
STD1, STD2, STD3, STD4, STD5, 
STD6, HG1, HG2, HG3, HG4, HG7, 
HG8, S-Log2, S-Log3, USER1, USER2, 
USER3, USER4, USER5

Frequenza di campionamento
48 kHz

Quantizzazione
24 bit

Risposta di frequenza
Da 50 Hz a 20 kHz (±3 dB o inferiore)

Gamma dinamica
90 dB (tipico)

Distorsione
0,08% o inferiore (livello di ingresso 
−40 dBu)

Altoparlante incorporato
Mono

Microfono interno 
Mono

Ingressi
INPUT 1/2:

Tipo XLR, 3 pin, femmina
Commutabile LINE / MIC / MIC+48V 
MIC: Riferimento −40, −50, −60 dBu

Uscite
SDI OUT 1/2:

Tipo BNC, 0,8 Vp-p, non 
bilanciato(uscita 3G HD/1,5G HD)
Conforme a standard SMPTE ST424/
425 Level A/B, 292M
Audio a 4 canali

Cuffie (mini jack stereo):
−16 dBu (livello di uscita di riferimento, 
volume di monitoraggio massimo, 
carico 16Ω)

HDMI: Type A, 19 pin

Altro:
DC IN: conforme a EIAJ, da 11 Vcc a 17 Vcc
Connettore dell’unità di estensione:

Proprietario (144 pin)
Slitta Multi-interface

Proprietario (21 pin)
REMOTE:

Tipo sub mini, dia. 2,5, 3 poli 
USB: Conforme allo standard 2.0, tipo mini 

AB per l’archiviazione di massa (1)
Tipo A per la connessione W-LAN (1) 

VF: Proprietario (40 pin)

Monitor LCD
Dimensione schermo

Diagonale 8,8 cm (3,5 pollici)
Rapporto di aspetto

16:9
Numero di pixel

960 (orizz.) × 540 (vert.)

Slot schede XQD per registrazione video (2)
Slot scheda SD UTILITY (1)

Sezione audio

Sezione ingressi/uscite

Sezione display

Sezione slot supporti di memoria
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Mirino (dotato di oculare, coppa oculare, asta, 
morsetto)
Telecomando impugnatura
Modulo LAN wireless USB (IFU-WLM3)
Telecomando a infrarossi (RM-845)
Adattatore CA

MPA-AC1 (solo modelli per USA e 
Canada)

Ingresso nominale: da 100 V a 
240 V CA, 50 Hz/60 Hz, da 0,4 A a 
0,75 A
Uscita nominale: 12 V DC, 3 A

AC-NB12A (tranne modelli per USA e 
Canada)

Ingresso nominale: da 100 V a 
240 V CA, 50 Hz/60 Hz, da 0,35 A 
a 0,65 A
Uscita nominale: 12 V DC, 2,5 A

Pacco batteria (BP-U30)
Tensione massima: 16,4 V DC
Tensione nominale: 14,4 V DC
Capacità: 28 Wh

Caricabatterie (BC-U1)
Alimentazione: da 100 V a 240 V CA, 
50 Hz/60 Hz
Consumo energetico: 38 W
Uscita nominale: in carica 16,4 V, 1,9 A/
1,5 A

Cavi di alimentazione (2)
Cavo mini USB (1)
Staffa di montaggio opzione (1)
Coperchio attacco obiettivo (1)
Coperchietto di protezione del connettore della 
maniglia (incluse due viti M2) (1)
Coperchietti del connettore modulo LAN 
wireless USB (2)
Riserva coperchio del connettore W-LAN (1)
Riserva coperchio del connettore dell’unità di 
estensione (1)
Kit per attacco accessori (attacco accessori (1), 
piastra dell’attacco (1), viti (4))
Prima di usare l’apparecchio (1)
Istruzioni per l’uso (CD-ROM) (1)

Design e le specifiche tecniche passibili di 
cambiamenti senza preavviso.

Accessori forniti SONY NON SARÀ RESPONSABILE DI 
DANNI DI QUALSIASI TIPO RISULTANTI 
DALLA MANCATA IMPLEMENTAZIONE 
DI MISURE DI PROTEZIONE ADEGUATE 
SUI DISPOSITIVI DI TRASMISSIONE, DA 
INEVITABILI DIFFUSIONI DI DATI 
RISULTANTI DALLE SPECIFICHE 
TECNICHE DELLA TRASMISSIONE O DA 
PROBLEMATICHE RELATIVE ALLA 
SICUREZZA DI QUALSIASI TIPO.
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Quando l’unità viene utilizzata in collegamento 
con un PC, scaricare driver, plug-in e software 
applicativo necessari del dispositivo dai seguenti 
siti web.

Sito web per i prodotti business di Sony:

Software Sony Creative, pagina di download del 
software:
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment

Note
• Eseguire sempre una registrazione di prova, e 

verificare che il contenuto sia stato registrato 
correttamente.
LA SONY NON SARÀ RESPONSABILE DI 
DANNI DI QUALSIASI TIPO, COMPRESI, 
MA SENZA LIMITAZIONE A, 
RISARCIMENTI O RIMBORSI A CAUSA 
DI GUASTI DI QUESTO APPARECCHIO 
O DEI SUOI SUPPORTI DI 
REGISTRAZIONE, SISTEMI DI 
MEMORIZZAZIONE ESTERNA O 
QUALSIASI ALTRO SUPPORTO O 
SISTEMA DI MEMORIZZAZIONE PER 
REGISTRARE CONTENUTI DI 
QUALSIASI TIPO.

• Verificare sempre che l’apparecchio stia 
funzionando correttamente prima di usarlo. 
LA SONY NON SARÀ RESPONSABILE DI 
DANNI DI QUALSIASI TIPO, COMPRESI, 
MA SENZA LIMITAZIONE A, 
RISARCIMENTI O RIMBORSI A CAUSA 
DELLA PERDITA DI PROFITTI ATTUALI 
O PREVISTI DOVUTA A GUASTI DI 
QUESTO APPARECCHIO, SIA DURANTE 
IL PERIODO DI VALIDITÀ DELLA 
GARANZIA SIA DOPO LA SCADENZA 
DELLA GARANZIA, O PER 
QUALUNQUE ALTRA RAGIONE.

• SONY NON SARÀ RESPONSABILE PER 
RICHIESTE O RICORSI DI NESSUN TIPO 
PRESENTATI DA UTENTI DI QUESTO 
APPARATO O DA TERZI.

• SONY NON SARÀ RESPONSABILE PER 
LA PERDITA, RIPARAZIONE O 
RIPRODUZIONE DEI DATI REGISTRATI 
SUL SISTEMA DI MEMORIZZAZIONE 
INTERNO, SU SUPPORTI DI 
REGISTRAZIONE, SU SISTEMI DI 
MEMORIZZAZIONE ESTERNI, O SU 
QUALSIASI ALTRO TIPO DI SUPPORTO 
O SISTEMA DI MEMORIZZAZIONE.

• SONY NON SARÀ RESPONSABILE PER 
LA CANCELLAZIONE O LA MANCATA 
CONTINUAZIONE PER QUALSIASI 
CAUSA O CIRCOSTANZA DI SERVIZI 
CORRELATI A QUESTO APPARATO.

Download del software

Stati Uniti http://pro.sony.com

Canada http://www.sonybiz.ca

America Latina http://sonypro-latin.com

Europa http://www.pro.sony.eu/pro

Medio oriente, 
Africa

http://sony-psmea.com

Russia http://sony.ru/pro/

Brasile http://sonypro.com.br

Australia http://pro.sony.com.au

Nuova Zelanda http://pro.sony.co.nz

Giappone http://www.sonybsc.com

Asia e Pacifico http://pro.sony-asia.com

Corea http://bp.sony.co.kr

Cina http://pro.sony.com.cn

India http://pro.sony.co.in
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XDCAM è un marchio di Sony Corporation.
• XAVC e  sono marchi registrati di Sony 

Corporation.
• XQD e   sono marchi di Sony 

Corporation.
• HDMI, il logo HDMI e “High-Definition 

Multimedia Interface” sono marchi o marchi 
registrati di HDMI Licensing LLC negli Stati 
Uniti e/o in altri paesi.

Altri nomi di società o prodotto sono marchi o 
marchi registrati dei rispettivi detentori. In questo 
documento i marchi non sono contrassegnati dai 
simboli ® o ™.

Marchi di fabbrica
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